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Preface

About This Guide

This guide describes how to install RSA Certificate Manager. It is intended for 
administrators and other trusted personnel. Do not make this guide available to the 
general user population.

Administrators should be experienced in systems administration for the chosen server 
operating system and in network configuration. Administrators should also be well 
versed in the security requirements of their organization.

RSA Certificate Manager Documentation

For more information about RSA Certificate Manager, see the following 
documentation:

Readme. Provides information about what is new and changed in this release, as 
well as workarounds for known issues. The latest version of the Readme is 
available from RSA SecurCare Online: https://knowledge.rsasecurity.com.

Installation Guide. Describes detailed procedures on how to install and initially 
configure RSA Certificate Manager.

Administrator’s Guide. Provides information on how to configure certificates and 
administer RSA Certificate Manager.

Vettor’s Guide. Provides information for your Vettors about how to issue 
certificates and manage certificate status in RSA Certificate Manager.

OneStep Developer’s Guide. Provides information on using the OneStep plug-in 
to automate enrollment with RSA Certificate Manager.

Using RSA Certificate Manager with the Microsoft Windows PKI 
Administrator’s Guide. Provides instructions for using the RSA Certificate 
Manager infrastructure to utilize the security capabilities of the Microsoft 
Windows operating platform.

Using Smart Card Logon with Microsoft Windows Quick Start Guide. Provides 
basic instructions for obtaining a digital certificate to store on a smart card for 
domain logon.

Using RSA Certificate Manager with Microsoft Exchange/Microsoft Outlook 
Administrator’s Guide. Provides instructions for Administrators to configure 
RSA Certificate Manager so that end users can obtain digital certificates to 
generate secure e-mail with Microsoft Outlook 2003 and Microsoft Outlook 2007.

Using Digital Certificates with Microsoft Outlook Quick Start Guide. Provides 
instructions for obtaining and using a digital certificate for secure e-mail with 
Microsoft Outlook 2003 and Microsoft Outlook 2007.
Preface 7
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RSA Certificate Manager Help. Describes day-to-day administration tasks 
performed in the administrative interface. To view the Help, click Help in the 
administrative interface.

Related Documentation

For more information about products related to RSA Certificate Manager, see the 
following:

RSA Certificate Manager API documentation set. Provides information about 
developing custom programs using the RSA Certificate Manager application 
programming interface (API). The full documentation set for RSA Certificate 
Manager API is included in the \Documentation directory of the RSA Certificate 
Manager API CD.

RSA Registration Manager documentation set. Provides information on using 
Registration Manager in conjunction with Certificate Manager to manage 
certificate enrollment.The full documentation set for RSA Registration Manager 
is included in the \Documentation directory of the RSA Registration Manager 
CD.

RSA Key Recovery Manager documentation set. Provides information on how 
to securely archive and recover users’ encryption keys. The full documentation set 
for RSA Key Recovery Manager is included in the \Documentation directory of 
the RSA Key Recovery Manager CD.
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Getting Support and Service

RSA SecurCare Online offers a knowledgebase that contains answers to common 
questions and solutions to known problems. It also offers information on new releases, 
important technical news, and software downloads.

The RSA Solutions Gallery provides information about third-party hardware and 
software products that the Secured by RSA Certified Partner Program has certified to 
work with RSA products. The directory includes Implementation Guides with 
step-by-step instructions and other information about interoperation of RSA products 
with these third-party products.

Before You Call Customer Support

Make sure you have direct access to the computer running the RSA Certificate 
Manager software.

Please have the following information available when you call:

 Your RSA Customer/License ID. You can find this number on the license 
certificate that shipped with the product or on the label of the license CD, as 
applicable.

 RSA Certificate Manager software version and build number.

 The make and model of the machine on which the problem occurs.

 The name and version of the operating system under which the problem occurs.

RSA SecurCare Online https://knowledge.rsasecurity.com

Customer Support Information www.rsa.com/support

RSA Solutions Gallery www.securedbyrsa.com
Preface 9
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1 System Requirements for RSA Certificate 
Manager

This chapter describes the minimum system requirements for an RSA® Certificate 
Manager installation. 

Except for installation and server start and stop procedures, Certificate Manager 
behaves in the same manner on Microsoft Windows, Sun Solaris, Red Hat Enterprise 
Linux, and SUSE Linux Enterprise platforms.

Minimum System Configuration on Windows

On Windows Server 2003:

• One of the following operating systems:

– Windows Server 2003 with Service Pack 2

– Windows Server 2003 R2 with Service Pack 2

• Pentium III 650 MHz

• At least 256 MB of memory (RAM)

• Hard disk with at least 100 MB of free space for basic program installation
Additional storage space may be required as the Certificate Manager database 
grows. Each certificate requires between 256 bytes and 4 KB of disk space, 
depending on the type of cryptography and the number of extensions used.

On Windows Server 2008 32-bit:

• Windows Server 2008 32-bit with Service Pack 1

• Intel Pentium 4 CPU 2.53GHz 2.52 GHz

• At least 1.50 GB of memory (RAM)

• Hard disk with at least 150 MB of free space for basic program installation 
Additional storage space may be required as the Certificate Manager database 
grows. Each certificate requires between 256 bytes and 4 KB of disk space, 
depending on the type of cryptography and the number of extensions used.
1: System Requirements for RSA Certificate Manager 11
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On Windows Server 2008 64-bit:

• One of the following operating systems:

– Windows Server 2008 64-bit with Service Pack 1

– Windows Server 2008 R2 64-bit with Service Pack 1

• Intel Core2 Duo processor @2.80GHz 2.79 GHz

• At least 4.00 GB of memory (RAM)

• Hard disk with at least 150 MB of free space for basic program installation 
Additional storage space may be required as the Certificate Manager database 
grows. Each certificate requires between 256 bytes and 4 KB of disk space, 
depending on the type of cryptography and the number of extensions used.

Minimum System Configuration on Solaris

• Sun Solaris 10

• Sun Enterprise Ultra 10S or equivalent

• At least 300 MB of memory (RAM)

• Hard disk with at least 100 MB of free space for basic program installation
Additional storage space may be required as the Certificate Manager database 
grows. Each certificate requires between 256 bytes and 4 KB of disk space, 
depending on the type of cryptography and the number of extensions used.

Minimum System Configuration on Linux

• One of the following operating systems:

– Red Hat Enterprise Linux 4 or 5, 32-bit

– Red Hat Enterprise Linux 5.5, 32-bit or 64-bit

– SUSE Linux Enterprise Server 11 Service Pack 1, 32-bit or 64-bit 

• Intel Pentium 4 or equivalent

• At least 300 MB of memory (RAM)

• Hard disk with at least 100 MB of free space for basic program installation
Additional storage space may be required as the Certificate Manager database 
grows. Each certificate requires between 256 bytes and 4 KB of disk space, 
depending on the type of cryptography and the number of extensions used.
12 1: System Requirements for RSA Certificate Manager
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Support on VMware ESX Server 4.1

RSA Certificate Manager is supported on VMware ESX Server 4.1 on the following 
platforms:

• Windows Server 2003 with Service Pack 2

• Windows Server 2003 R2 with Service Pack 2

• Windows Server 2008 32-bit with Service Pack 1 

• Windows Server 2008 64-bit with Service Pack 1 

• Windows Server 2008 R2 64-bit with Service Pack 1

• Red Hat Enterprise Linux 5.5, 32-bit or 64-bit

• SUSE Linux Enterprise Server 11 Service Pack 1, 32-bit or 64-bit

Certificate Manager supports the following features on VMware ESX Server 4.1:

• Cloning

• Snapshots

Note: If you generate CRLs and you revert to a snapshot taken before the latest 
CRL was generated, CRL numbering will restart from the number of the latest 
CRL in the snapshot. The number of the next CRL generated will be lower than 
the latest CRL generated before reverting to the snapshot. This mis-numbering 
makes the CRL invalid. Applications or devices that use the CRL will consider all 
certificates issued by the CA invalid.

• Physical to Virtual (P2V) conversion

Certificate Manager has been tested with network-based hardware security modules 
(HSMs), such as SafeNet Luna and nCipher netHSM, with guest operating systems 
running on VMware ESX Server 4.1. Certificate Manager was not tested with 
PCI-based or SCSI-based HSMs.

Browser Support for Administration

Certificate Manager supports web-based administration with the following browsers:

• Microsoft Internet Explorer 6.0 to 9.0 with JavaScript and UTF-8 encoding 
enabled

• Mozilla Firefox 2.0 to 3.6.13 with JavaScript and UTF-8 encoding enabled

• Mozilla 1.7 with JavaScript and UTF-8 encoding enabled
1: System Requirements for RSA Certificate Manager 13
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Browser Settings

You must enable JavaScript and UTF-8 encoding for web-based administration. If you 
do not enable both, some pages of Certificate Manager may not be displayed properly.

In Internet Explorer

1. To enable JavaScript:

a. Click Tools > Internet Options, and click the Security tab.

b. Select the appropriate web content zone.
If you are not sure which zone to select, you can enable JavaScript for all of 
the following zones: Internet, Local intranet, and Trusted sites.

c. Select the Security level for the zone.
If you are using the default security level, JavaScript is enabled. (JavaScript is 
enabled at the Low, Medium-low, and Medium levels.)
If you are using a custom security level, click Custom Level. Scroll down to 
Scripting > Active Scripting, and select Enable.

2. To enable UTF-8 encoding, do one of the following:

• In Internet Explorer 6.x, click View > Encoding > Unicode (UTF-8), and 
clear Auto-Select.

• In Internet Explorer 7.0 to 9.0, click Page > Encoding > Unicode (UTF-8), 
and clear Auto-Select.

In Firefox

1. To enable JavaScript, do one of the following:

• On Windows, click Tools > Options, and, on the Content tab, select 
Enable JavaScript.

• On Linux, click Edit > Preferences, and, on the Content tab, select 
Enable JavaScript.

2. To enable UTF-8 encoding, click View > Character Encoding > 
Unicode (UTF-8). You may want to set this as your default character set.

In Mozilla

1. To enable JavaScript:

a. Click Edit > Preferences > Advanced > Scripts & Plug-ins.

b. Under Enable JavaScript for, select Navigator.

c. Under Allow scripts to, select all options except Hide the status bar.

2. To enable UTF-8 encoding, click View > Character Encoding > 
Unicode (UTF-8). You may want to set this as your default character set.
14 1: System Requirements for RSA Certificate Manager
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Entering and Displaying International Characters

On Windows

To enter and display international characters in certificates, use Input Method Editors 
(IMEs).

To enable IMEs:

• On Windows Server 2003, Windows XP, or Windows Vista, in the Control Panel, 
enable the relevant IMEs through Regional and Language Options.

• On Windows Server 2008 or Windows 7, in the Control Panel, enable the relevant 
IMEs through Clock, Language, and Region.

On Solaris

To enter and display international characters in certificates, edit or add the relevant 
LANG, LC_CTYPE, and LC_COLLATE variables in the /etc/default/init file.

On Red Hat Linux

To enter and display international characters in certificates, edit or add the relevant 
LANG, SUPPORTED, and SYSFONT variables in the /etc/sysconfig/i18n file.

On SUSE Linux

To enter and display international characters in certificates, edit or add the relevant 
LANG, LC_CTYPE, and LC_COLLATE variables in the /etc/sysconfig/language 
file.

Browser Support for Enrollment

Certificate Manager supports web-based enrollment with the following browsers:

• Microsoft Internet Explorer 4.0 to 9.0

• Mozilla Firefox 2.0 to 3.6.13

• Mozilla 1.7
1: System Requirements for RSA Certificate Manager 15
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Cryptographic Support

Strong authentication is accomplished using the Secure Sockets Layer (SSL). SSL v3 
is used for both web authentication and LDAP authentication. Certificate Manager 
components and other PKI-related applications communicate with each other via 
mutually authenticated SSL sessions.

The Certificate Manager architecture supports key lengths up to 4096. Certificate 
Manager natively supports the following public key technologies:

• CA Keys—RSA, DSA, ECDSA, RSA-PSS, GOST/GOSTR3411

• End-Entity Keys—RSA, DSA, ECDSA, GOST/GOSTR3411

• Message Digests—MD5, SHA-1, SHA-256, SHA-384, SHA-512

Note: Many applications do not support the use of long hash algorithms, that is, 
SHA-256, SHA-384, and SHA-512.

RSA Public Key Technology

Certificate Manager can use software-based RSA key pairs for signing, signature 
verification, establishing SSL communication, and for other cryptographic operations.

Certificate Manager can also use hardware-based RSA private keys stored on 
hardware tokens and smart cards. Tokens and smart cards provide a security solution 
that off-loads sensitive cryptographic processing and private key storage from the host 
computer or Certificate Manager server to the token or smart card. Administrators can 
create keys and sign digital certificates on a token or smart card without the encryption 
algorithm or private keys ever being directly accessed by the CA host server.

DSA Public Key Technology

Digital Signature Algorithm (DSA) public key technology is provided by an interface 
to RSA BSAFE.

Elliptic Curve Public Key Technology

Certificate Manager provides elliptic curve (EC) technology through BSAFE. Elliptic 
curve mathematics offer public key technology security that reduces bandwidth 
requirements to help deliver high application throughput. Certificate Manager 
supports EC type A curves of 163 and 239 bits, type B curves of 163 bits, and type P 
curves of 256, 384, and 521 bits.

Note: Microsoft Internet Explorer does not support EC CAs or certificates issued 
using EC algorithms.
16 1: System Requirements for RSA Certificate Manager



RSA Certificate Manager 6.9 Installation Guide
Hardware Security Module Support

Certificate Manager supports the use of cryptographic devices, often referred to as 
tokens or smart cards, that provide a highly secure hardware environment for the 
protection of private keys.

Certificate Manager supports nShield and netHSM from nCipher, Luna SA and the 
Luna CA line of tokens from SafeNet, and most PKCS #11 v2 compliant HSMs. For 
more information on hardware security modules (HSMs), see Appendix A, 
“Cryptographic Hardware Interoperability.”

Tokens and smart cards increase the physical security of CA and server private keys in 
public key management applications. Tokens and smart cards can be removed from 
the computer for portability and secure storage. 
1: System Requirements for RSA Certificate Manager 17





RSA Certificate Manager 6.9 Installation Guide
2 Installing RSA Certificate Manager

This chapter describes the standard RSA Certificate Manager installation process. The 
topics covered are:

• Pre-installation checklist

• Preparing to install

• Installing on Windows, Solaris, and Linux

• Browser-based phase of the installation

• Installing the license file

• Post-installation checklist

• Starting Certificate Manager

• Failover

The Certificate Manager installation process has two phases:

• Install the setup files on a Windows, Solaris, or Linux platform.

• Use your browser to complete the installation.

Important: To use tokens with Certificate Manager, install your token hardware and 
drivers before installing Certificate Manager to ensure that system key pairs are 
hardware-based. Be sure to initialize the token before beginning the Certificate 
Manager installation.

If you are upgrading from a previous version of Certificate Manager, see Chapter 3, 
“Upgrading RSA Certificate Manager” for upgrade installation instructions.

Pre-Installation Checklist

Be sure to consider the following questions before you begin your Certificate Manager 
installation.

System

• Does your system meet the minimum system requirements?
For more information, see “Minimum System Configuration on Windows,” 
“Minimum System Configuration on Solaris,” or “Minimum System 
Configuration on Linux” on page 12.
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Browser

• What browser will you use?

– Microsoft Internet Explorer 6.0 to 9.0

If you are installing on a Windows platform, use Microsoft Internet Explorer 
for local installation and administration.

– Mozilla Firefox 2 to 3.6.13 

– Mozilla 1.7

• If your browser is not local to the machine on which you are installing Certificate 
Manager, does your browser have access to that machine?

Important: You cannot use Internet Explorer on Windows Vista for remote 
installation.

For more information, see “Browser Support for Administration” on page 13.

Failover

• If you are installing on a Solaris or Linux platform, do you want to install a 
standby machine to enable failover?

– If yes, you must modify the specified files before you begin the installation 
process.

For more information, see “RSA Certificate Manager Failover” on page 42.

Cryptographic Provider

• Will you protect the system authority (System CA and Administrative CA) key 
pairs with an HSM?
If yes, which HSM will you use?

– nCipher

Only nCipher native keys are supported for the system authority key pairs. 
nCipher PKCS #11 keys are not supported.

– a PKCS #11-compliant provider

If you are using a PKCS #11-compliant provider, you will be prompted during 
installation to enter the location of the provider.

• Will you protect the server key pairs with a PKCS #11-compliant HSM?

• Have you installed and set up any HSMs that you will use?

Important: Passphrases and PINs must not exceed 35 characters.

For more information, see “Private Key Protection” on page 79.
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Passphrase Protection

• If your SSL keys are software keys, will you protect them with a passphrase?

– If yes, choose a strong passphrase 4–35 characters long.

• If your system authority keys are software keys, will you protect them with a 
passphrase?

– If yes, choose a strong passphrase 4–35 characters long.

For more information, see the Administrator’s Guide.

Configuration Information

• Have you gathered the information that is required during the installation:

– administrator’s e-mail address _____________________________________

– hostname (FQDN) ______________________________________________

– port numbers for all servers (make sure the ports are not used by other 
applications):

Administration Server (default 444) _____________

Enrollment Server (default 443) _____________

Certificate Renewal Server (default (448) _____________

SCEP Server (default 446) _____________

CRL Server (default 447) _____________

CMP Enroll Server (default 449) _____________

Secure Directory Server (default 636) _____________

Directory Server (default 389) _____________

Logging Server (default 5150) _____________

CMP Server (default 829) _____________

– active mail server:

hostname ______________________________________________________

port number _____________

• Will you specify an Installation Name? RSA recommends that you use a name 
that uniquely identifies your installation.
_________________________________________________________________

• What will be the validity period of the System CA and Administrative CA? 
(default 5 years) _____________

For more information, see “Browser-Based Phase of the Installation” on page 27.

Media Verification

• Do you want to verify that the distribution media has not been tampered with 
since it was signed by RSA?
For more information, see Appendix C, “Media Verification.”
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Preparing to Install 

Before you install Certificate Manager, complete the following tasks:

• Install the RSA BSAFE® SSL-C 2.8.5.1 library files. See “Installing RSA BSAFE 
SSL-C Library Files” on page 22.

• Enable SSL 3.0 and TLS 1.0 in your browser. See “Enabling SSL 3.0 and TLS 
1.0” on page 22.

• If you are using nCipher PKCS #11 keys, configure the nCipher PKCS #11 
provider. See “Configuring the nCipher PKCS #11 Provider” on page 23.

• If you are using Internet Explorer 8 or 9 to install Certificate Manager on 
Windows Server 2008, configure required browser settings. See “Configuring 
Internet Explorer 8 or 9 Settings” on page 24.

Installing RSA BSAFE SSL-C Library Files

You must install the RSA BSAFE SSL-C 2.8.5.1 library files, which are on the 
product CD.

To install RSA BSAFE SSL-C library files:

1. Extract the RSA BSAFE SSL-C 2.8.5.1 library files from the appropriate .zip or 
.tar file:

• On Windows, SSLC_CryptoCME_Libs-WIN32.zip

• On Solaris, SSLC_CryptoCME_Libs-sparc-sun-solaris.tar

• On Red Hat Linux, SSLC_CryptoCME_Libs-RH_Linux.tar

• On SUSE Linux, SSLC_CryptoCME_Libs-SuSE_Linux.tar

2. Copy the extracted contents to the appropriate location:

• On Windows Server 2003 32-bit or Windows Server 2008 32-bit, 
C:\Windows\system32

• On Windows Server 2008 R2 64-bit, C:\Windows\SysWOW64

• On Solaris, Red Hat Linux, or SUSE Linux, /usr/lib

Note: Make sure that you log on as the root user and give proper permissions 
to the users to access the libraries.

Enabling SSL 3.0 and TLS 1.0

To enable SSL 3.0 and TLS 1.0 in Internet Explorer:

1. Click Tools > Internet Options.

2. On the Advanced tab, from the Settings list, under Security, select Use SSL 3.0 
and Use TLS 1.0.
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To enable SSL 3.0 and TLS 1.0 in Firefox:

1. Click Tools > Options > Advanced.

2. On the Encryption tab, select Enable SSL 3.0 and Enable TLS 1.0.

To enable SSL 3.0 and TLS 1.0 in Mozilla:

1. Click Edit > Preferences.

2. In the left-hand pane, expand Privacy & Security and click SSL.

3. Select Enable SSL version 3.

4. Click OK.

Configuring the nCipher PKCS #11 Provider

To configure the nCipher PKCS #11 provider on Windows:

1. Set the environmental variable NFAST_HOME to C:\nfast.

2. Ensure the nCipher PKCS #11 library is available at C:\nfast\bin\cknfast.dll.

3. To generate SSL PKCS #11 keys, in the C:\nfast\cknfastrc file, set the following 
variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst.exe utility in 
the C:\nfast\bin directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot. Certificate Manager 
uses slot 1 for nCipher PKCS #11 key generation. The accelerator slot, which is 
slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo.exe utility.

Note: nCipher PKCS#11 SSL keys support a 1of N persistent card set.

To configure the nCipher PKCS #11 provider on Solaris or Linux:

1. Set the environmental variable NFAST_HOME to /opt/nfast.

2. Ensure the nCipher PKCS #11 library is located at 
/opt/nfast/toolkits/PKCS11/libcknfast.so.

3. To generate SSL PKCS #11 keys, in the /opt/nfast/bin/cknfastrc file, set the 
following variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.
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5. Verify nCipher PKCS #11 key generation by using the ckcheckinst utility in the 
/opt/nfast/bin/ckcheckinst directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot. Certificate Manager 
uses slot 1 for nCipher PKCS #11 key generation. The accelerator slot, which is 
slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo utility in the 
/opt/nfast/bin directory.

Note: nCipher PKCS #11 SSL keys support a 1of N persistent card set.

Configuring Internet Explorer 8 or 9 Settings

To install Certificate Manager using Internet Explorer 8 or 9 on Windows Server 2008 
or Windows 7, you must set the following browser settings to enable Certificate 
Manager to request and install the Administrative certificate during the browser-based 
phase of the installation.

To configure Internet Explorer on Windows Server 2008 or Windows 7:

1. Click Tools > Internet Options.

2. On the Security tab, click Trusted sites > Sites.

3. Add the Certificate Manager host to the list of trusted sites.

4. In Internet Explorer 9 only, on the Advanced tab, in the Settings list, under 
Security, ensure that Do not save encrypted pages to disk is cleared.

5. Click Apply, and click OK.

Important: When you are using Internet Explorer 8 or 9 on Windows Server 2008 or 
Windows 7, if the Web Access Confirmation pop-up window prompts you to allow 
digital certificate operations, click Yes.

Installing RSA Certificate Manager on Windows

The Windows version of Certificate Manager consists of both a zipped and an 
uncompressed distribution of setup files.

Prerequisites

• Perform the tasks in “Preparing to Install” on page 22.

• Ensure that you have Windows Administrator privileges

• If you are using Internet Explorer with Enhanced Security Configuration enabled 
on a Windows platform, add the Certificate Manager host to the browser Local 
intranet or Trusted sites list. If the server is not added to one of these lists, you 
cannot complete the browser-based phase of the installation.
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To begin the installation process:

1. Unzip RSACM-v6.9build551r-WIN32.zip to a temporary directory.

2. Run setup.exe, either directly from the \uncompressed directory or from a 
temporary directory to which you have unzipped the zipped files. (Your version of 
unzip or WinZip must support long filenames.) 

3. Do one of the following:

• To use your computer’s default browser for installation and administration, 
select Use Default Browser and click Next.

• To use another browser:

a. Select Use Other Browser and click Next.

b. Select the browser that you want to use.

4. Select New Install and click Next.

5. When prompted to select cryptographic providers for use with Certificate 
Manager, do one of the following:

• If the CAs created during installation will be software-based or will use an 
nCipher HSM, select Do not search and click Next.

• If you are using a PKCS #11 cryptographic provider and have already 
installed the HSM, select Search for cryptographic providers and click 
Next. When prompted:

a. Enter the path of the folder containing the cryptographic provider.

b. Enter the filename of the cryptographic provider.

c. From the list of found providers, select the cryptographic provider that 
you want to use.

6. Select the directory where you want to install Certificate Manager and click Next.
Wait while the installation wizard copies files to the installation directory, and 
then configures and starts the services that install Certificate Manager (the 
Installation Directory Server and the Installation Web Server). This process takes 
a few minutes.

7. Write down the URL displayed, and click Finish to launch your browser and 
complete the installation. 
If your browser does not automatically connect to the End User License 
Agreement page, open a browser session and enter the URL that you recorded.

8. To complete the installation, see “Browser-Based Phase of the Installation” on 
page 27.
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Installing RSA Certificate Manager on Solaris or Linux

The Solaris and Linux versions of Certificate Manager consist of a compressed tar 
distribution of setup files.

Prerequisites

• Perform the tasks in “Preparing to Install” on page 22.

• To allow operation with nCipher cryptographic hardware, Certificate Manager 
must be installed by the “root” user or a member of the nfast group. If you install 
as “root”, in step 2 of “Browser-Based Phase of the Installation,” you have to 
specify a user other than “root” to run the Web Server as. This user must also 
belong to the nfast group.

To begin the installation process:

1. Copy the Certificate Manager tar file, 
RSACM-v6.9build551r-sparc-sun-solaris.tar, 
RSACM-v6.9build551r-linux.tar, or RSACM-v6.9build551r-SuSE_linux.tar 
depending on your platform, from the CD to the directory where you want to 
install Certificate Manager.

Important: If you install in a directory where the permissions are overly 
restrictive (such as the /root directory on Linux or a locked-down directory on 
Solaris or Linux), you may not be able to complete the installation. When you 
click Next at step 10 of “Browser-Based Phase of the Installation,” you may see 
an access error message and the default ACL rules may not be applied. If this 
happens, contact RSA Customer Support.

2. Untar the file.
Where you untar the setup files is where Certificate Manager is installed. You 
cannot select a different directory path at a later step in the installation. 

3. Change directories to the /RSA_CM directory and run the INSTALL script.

4. When prompted to indicate whether this is a new installation or an upgrade, to 
create a new installation, press 1 and Enter.

5. When prompted to configure Certificate Manager to use installed cryptographic 
providers, do one of the following:

• If the CAs created during installation will either be software-based or use an 
nCipher HSM, press 2 and Enter to skip the search, and go to step 8.

• If you are using a PKCS #11-compliant HSM, press 1 and Enter to search for 
cryptographic providers. 
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6. When prompted to search for the PKCS #11 provider library, do one of the 
following:

• If you have installed the hardware, drivers, and firmware, and you want to add 
support for this installation, press 1 and Enter to search for the library. 

• If you do not want to add support, press 2 and Enter to skip the search, and go 
to step 8.

7. If the PKCS #11 provider library is not in a default directory, follow these steps:

a. Enter additional directories to search.

b. To begin searching for the library, press Enter.

c. Enter the name of the PKCS #11 provider library and press Enter. 
You can use the wildcard character * to represent any string of characters.

d. To select the library from the list of found libraries, press the corresponding 
number and press Enter.

8. If you are installing Certificate Manager in a Network File System (NFS) 
mounted directory, when prompted, enter a filename to be used for the lockfiles.

9. When the INSTALL script finishes, use your browser to connect to the URL 
indicated in the final output of the script. The URL begins with “https”.
After this phase of the installation is complete, the services that install Certificate 
Manager (the Installation Web Server and the Installation Directory Server) are 
started. 

10. To complete the installation, see the following section, “Browser-Based Phase of 
the Installation.”

Browser-Based Phase of the Installation

The browser-based phase of the installation process is identical on Windows, Solaris, 
and Linux platforms. This phase completes the installation process and configures 
Certificate Manager. Once the browser-based phase of the installation is complete, 
Certificate Manager is fully functional.

Important: When your browser is launched to complete this phase of the installation, 
you may be prompted to trust the authority that issued this secure site’s certificate. 
You must agree to trust it in order to proceed. You are not prompted if the issuing 
authority’s trusted root certificate is already installed in your browser.
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To complete the installation process:

1. Read the End User License Agreement and click Accept to accept the End User 
License Agreement.
The General Configuration Information page opens.

Note: Click the underlined blue text to open a new browser window displaying 
the installation glossary. The new browser window may cover the installer 
browser window. 

If you do not want to accept the End User License Agreement, close the browser 
window and terminate the installation.

2. Verify the defaults on the General Configuration Information page against the 
information gathered in “Configuration Information” on page 21. 
If you are installing Certificate Manager on Solaris or Linux, User and Group 
fields are displayed and the default values for these fields are filled in. If you are 
installing as “root”, there are no defaults. You must specify a user other than 
“root” and a group for the Web Server. If the installation uses nCipher 
cryptographic hardware, the user must be a member of the nfast group.
Edit the defaults as needed and click Next.

Note: If you have more than one installation of Certificate Manager or any other 
web server or LDAP directory running concurrently on the same machine, each 
installation must use different port numbers.

If you are using Internet Explorer 8 or 9 on Windows Server 2008 or Windows 7, 
when prompted to allow digital certificate operations, click Yes.
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The User Information page opens. The following figure shows the top part of the 
User Information page.

3. Enter the user information:

• The Installation Name is incorporated into the Common Name of the System 
CA, Administrative CA, and Administrative certificate. The respective 
Common Names are Installation Name System CA, Installation Name 
Administrative CA, and Installation Name CM Administrative certificate. 

• The Company, Department, and Country values are used in the DN of the 
Web Server certificates. 

These fields are optional and can be left blank, but RSA recommends that you 
enter at least an Installation Name.

4. Enter the validity period for the System CA and the Administrative CA.

5. In the bottom part of the User Information page, specify the cryptographic 
providers. Depending on your cryptographic provider, do one of the following:

• If your cryptographic provider is software-based, select the key size for each 
type of key and the cryptographic provider for the Administrative certificate 
key. Click Next.
The larger the key size, the harder it is to break the key and the greater the 
security.
2: Installing RSA Certificate Manager 29



RSA Certificate Manager 6.9 Installation Guide
• If you have installed a hardware security module, select the cryptographic 
provider and key size for each type of key. Click Next.
You see a screen similar to the following screen. The larger the key size, the 
harder it is to break the key and the greater the security.
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6. If you are using Microsoft Internet Explore, and are prompted to allow a 
certificate request to proceed, click Yes.
If you click No, the Administrative certificate is not requested, and you are unable 
to proceed with the installation.
A page opens that requests SSL Information and System Information. The 
information on this page varies depending on which cryptographic provider(s) 
you are using. Find your configuration in the table below to identify which 
screenshot on the following pages illustrates the SSL Information and System 
Information page that you will see. 

Example 1: In an installation where the SSL keys and the system authority keys 
are software-based, the following page opens. You can protect the SSL keys, the 
system authority keys, or both by entering a passphrase in the appropriate fields.

SSL Keys System Authority Keys Example

Software-based Software-based shown in Example 1

Software-based nCipher native shown in Example 2

Software-based PKCS #11-compliant shown in Example 3

PKCS #11-compliant Software-based shown in Example 4

PKCS #11-compliant nCipher native shown in Example 5

PKCS #11-compliant PKCS #11-compliant shown in Example 6
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Example 2: In an installation where the SSL keys are software-based and the 
system authority keys are protected with an nCipher smart card, the following 
page opens. You can enter a passphrase to protect the SSL keys. You must enter 
the PIN that accesses the nCipher smart card.
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Example 3: In an installation where the SSL keys are software-based and the 
system authority keys are protected with a PKCS #11 provider, the following page 
opens. You can enter a passphrase to protect the SSL keys. You must enter the PIN 
that accesses the PKCS #11 provider. After you click Next, you must enter the slot 
number of the PKCS #11 token.
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Example 4: In an installation where the SSL keys are protected by a PKCS #11 
provider and the system authority keys are software-based, the following page 
opens. You must enter the slot number of the PKCS #11 token. You can enter a 
passphrase to protect the system authority keys. After you click Next, you must 
enter the PIN that accesses the PKCS #11 token.

Example 5: In an installation where the SSL keys are protected by a PKCS #11 
provider and the system authority keys are protected by an nCipher smart card, the 
following page opens. You must enter the slot number of the PKCS #11 token and 
the PIN that accesses the nCipher smart card. After you click Next, you must enter 
the PIN that accesses the PKCS #11 token.
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Example 6: In an installation where both the SSL keys and the system authority 
keys are protected by a PKCS #11 provider, the following page opens. You must 
enter the slot number of the PKCS #11 token. After you click Next, you must 
enter the PIN that accesses the PKCS #11 token.

7. Enter the appropriate information and click Next.
You are prompted for one or both of two types of information:

• If your keys are software-based, you can enter a passphrase to 
passphrase-protect them. If you leave the passphrase fields blank, the keys are 
not passphrase protected. You can change, add, or remove a passphrase after 
the installation is completed.
For more information, see “Passphrase Protection” on page 21.

• If your keys are hardware-based, you must enter the PIN of the token that 
protects them. Enter the PIN on the PED if your HSM supports it.
For more information, see “Cryptographic Provider” on page 20.

Important: Passphrases and PINs must not exceed 35 characters.

The Configuration Information Gathered page opens.

At this point, Certificate Manager creates the System CA and Administrative CA, 
and sets up the Web Server, the Certificate Management Protocol (CMP) Server, 
the Secure Directory Server, and the Logging Server. 
The Server Setup page opens and displays the progress of the setup.

Important: This process takes a few moments. Wait until you see “Done” in the 
status bar of the Server Setup page.

For more information on the virtual web servers created during installation, see 
“Server Configuration” on page 64. For more information on the certificates 
issued during installation, see “Issued Certificates” on page 66. 
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8. When “Done” is displayed in the status bar of the Server Setup page, scroll to the 
bottom of the page and click Continue.
If you are using Internet Explorer 8 or 9 on Windows Server 2008 or Windows 7, 
when prompted to allow digital certificate operations, click Yes.
The following page opens.

9. Install the CM Administrative certificate into your browser as follows:

a. Click Install System CA Certificate to install the System CA certificate into 
your browser in the Trusted Root Certification Authorities store.

b. Click Install Administrative CA Certificate to install the Administrative 
CA certificate into your browser in the Trusted Root Certification Authorities 
store.

c. Click Install Client Certificate to install the CM Administrative certificate 
into your browser.

If prompted to allow the certificates to be added, click Yes. If you click No, the 
Administrative certificate will not be installed. If you proceed to the next page 
without installing the Administrative certificate, you will be unable to access the 
Administration Server.
Some browsers do not confirm that the CM Administrative certificate has been 
successfully downloaded. Check the browser certificate store to ensure that the 
certificate has been downloaded.
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10. Click Next.
The Congratulations page opens. Certificate Manager is now installed and ready 
for use.

11. Record the URLs for the various web server virtual hosts.
You can connect to the Administration Server or the Enrollment Server by 
clicking the link provided. You must have the CM Administrative certificate 
downloaded in step 9 to access the Administration Server.

Important: When you connect to the Administration Server or the Enrollment 
Server, you may be prompted to trust the authority that issued this secure site’s 
certificate. You must agree to trust it in order to proceed and connect to the server. 
If the issuing authority’s trusted root certificate is already installed in your 
browser, you are not prompted.

The Installation Web Server and the Installation Directory Server remain on your file 
system and can be removed at your discretion. For instructions, see Appendix B, 
“Uninstalling RSA Certificate Manager.”

Installing the License File

When first installed, Certificate Manager can issue a small number of certificates. You 
are limited to this evaluation use until you install your license file. The floppy disk 
containing the license file may have been included in your Certificate Manager 
product package or may have been sent directly from RSA. 

To install the license file:

1. Place the license.p7 file in the /installed-dir/Xudad/conf directory.

2. Restart the Secure Directory Server.

The license file contains the licensee name and user limit, stored in a PKCS #7 object 
signed by the RSA License CA. When the Secure Directory Server is restarted, it 
reads the license file, and extracts the licensee name and user limit.

Important: If the limit of licensed users is exceeded at startup, a warning is logged 
and Certificate Manager continues to operate. You will not be able to add new objects 
to the database or modify existing objects, but you can delete objects. Administrators 
and Vettors will not be able to issue new certificates or create new CAs.
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Post-Installation Checklist

You may want to consider these questions after you install Certificate Manager. Your 
considerations will differ depending on whether you are installing a pilot of Certificate 
Manager or implementing a deployment of Certificate Manager.

CAs

• What kind of encryption algorithms will your CAs use? 

– RSA, DSA, ECC, or RSA-PSS

RSA encryption algorithms provide the best interoperation with other 
applications. Use DSA, ECC, or RSA-PSS encryption algorithms if you have 
specific application requirements.

• Will you protect your CA key pairs with an HSM?

– nCipher or PKCS #11-compliant

• Will you use MofN?

– If yes, you will need to make sure that enough administrators are present to 
sign on to the token.

For more information, see Appendix A, “Cryptographic Hardware 
Interoperability.”

• What DN components will your CA certificates contain?
For more information, see “Configuring Certificate Attributes” in the 
Administrator’s Guide.

• What certificate extensions will your CAs have? 

– For example, Basic Constraints, Authority Key Identifier

For more information, see “Certificate Profiles and Extensions” in the 
Administrator’s Guide.

• What expiry date will your CAs have?

Jurisdictions

• What Jurisdictions will you set up?
For more information, see “RSA Certificate Manager and Jurisdictions” in the 
Administrator’s Guide.

Administrators, Vettors, and Auditors

• How many Administrators, Vettors, and Auditors will you have?
For more information, see “Roles and Responsibilities” in the Administrator’s 
Guide.
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Post-Installation Tasks

RSA recommends that you perform the following tasks immediately after installation:

• Create a full backup of the installation

• Configure database backups

• Configure the logging server

• Configure the PKI events to be logged

• Configure the Jurisdiction Defaults

• Create a CA hierarchy

• Configure the Administrative CA’s Jurisdiction for e-mail notification

• Create Jurisdictions

• Issue Administrator, Vettor, and Auditor certificates

• Reissue the Web Server certificates, signed by the root CA

• Enable CMP autovetting

• Configure local CRL, delta CRL, and ARL publishing

• Configure publishing to an external directory

• Configure unattended startup

• Configure the cryptographic provider for signature verification

For more information, see the Administrator’s Guide.

Starting RSA Certificate Manager on Windows Server 2003

To start RSA Certificate Manager:

Note: If you have more than one installation of Certificate Manager on the same 
machine, a number is added to the service names of subsequent installations. For 
example, [02] is added to the end of each service name for the second installation.

1. Click Start > Programs > Administrative Tools > Services.

2. From the Services list, select RSA Secure Logging Server 6.9 and click Start.
Logging Server startup is not dependent on the startup of other services.

3. From the Services list, select RSA CM 6.9 build 551 (Secure Directory) and 
click Start.
When the Secure Directory Server starts, you may be prompted to enter 
passphrases or PINs for your CA and SSL keys if you protected the keys.
The Secure Directory Server is required during the startup of the Administration 
Server and the CMP Server. If you attempt to start the Administration Server or 
the CMP Server before the Secure Directory Server, the Secure Directory Server 
automatically starts first.
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4. From the Services list, select RSA CM 6.9 build 551 (Administration) and click 
Start.

5. If needed, from the Services list, select RSA CMP Server 6.9 build 551 and 
click Start.

Starting RSA Certificate Manager on Windows Server 2008

On Windows Server 2008, for attended startup, you must start the services through the 
servicectrl utility. If you try to start the services from the Service Control Manager 
(services.msc), the service startup fails and an error message is logged in the Event 
Log. For unattended startup, you can start the service from either the Service Control 
Manager or through the servicectrl utility.

Prerequisite to Run servicectrl Utility

To run the servicectrl utility, you must have a built-in administrator account. If you 
have an administrator account that is not a built-in account, you can do one of the 
following and then run the servicectrl utility:

• Start the command prompt as Run as Administrator. You will be prompted for 
consent to get the full administrator privilege.

• Disable User Access Control (UAC) for your user account.

To disable UAC:

1. Click Start > Control Panel.

2. In the search field, type:

uac

and press Enter.
If you're prompted for an administrator password or confirmation, type the 
password or provide confirmation.

3. On Windows Server 2008 (32-bit or 64-bit), follow these steps:

a. Click Turn User Account Control (UAC) on or off.

b. Clear Use User Account Control to help protect your computer, and click 
OK.

4. On Windows Server 2008 R2, follow these steps:

a. Click Change User Account Control settings.

b. Move the slider to the Never notify position, and click OK.

5. Restart the server.
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To start RSA Certificate Manager:

1. Open a command prompt, and change directories to installed-dir\Utils.

2. Do one of the following:

• To start all services, type:

servicectrl.exe start all

• To start a specific service, type:

servicectrl.exe start service

where service is Xudad, WebServer, CmpServer, or LogServer.

Starting RSA Certificate Manager on Solaris or Linux

To start RSA Certificate Manager:

1. Change directories to the directory where you installed Certificate Manager.

2. At the command prompt, type:

./START

The Web Server, Secure Directory Server, CMP Server, and Logging Server all 
start. When the Secure Directory Server starts, you may be prompted to enter 
passphrases or PINs for your CA and SSL keys if you protected the keys. 

You can also start only the Secure Directory Server without using the START script. If 
you do, you must specify the configuration file.

To start the Secure Directory Server only:

1. Change directories to the /installed-dir/Xudad/bin directory.

2. At the command prompt, type:

./xudad -f ../conf/xudad.conf
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RSA Certificate Manager Failover

For the Solaris and Linux platforms only, Certificate Manager allows Administrators 
to bring a secondary instance of Certificate Manager into full operation without 
operator assistance while maintaining a level of security that meets FIPS 140-1 level 3 
compliance. This allows Certificate Manager to be part of a system that provides 
failover capabilities.

Note: For an alternative deployment in which multiple instances of Certificate 
Manager share a common external database, see Appendix D, “High Availability.”

You can configure Certificate Manager to allow for a standby system. The associated 
HSMs must be cloned (see Appendix A, “Cryptographic Hardware Interoperability”) 
and the servers must share a disk as well as having their own local disk for storage.

To have a fully automated system, high availability or clustering software is required 
to detect the primary failure and enable the secondary machine, including network 
issues such as switching IP addresses.

Important: Local certificate revocation list (CRL) publishing may require special 
configuration to work with Certificate Manager configured for failover. For more 
information, see “Revocation Lists” in the Administrator’s Guide.

Verification of audit logs may require special processing to work with Certificate 
Manager configured for failover. For more information, see “Managing Audit Logs” 
in the Administrator’s Guide.
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Pre-Installation Modifications

You must install a single instance of Certificate Manager on a shared disk system.

CAUTION: There are a few files used by the Certificate Manager Web Server that 
should not reside on a shared file system, but rather on a local disk. These files are 
specified via directives in /WebServer/conf/httpd.conf. The directives in question 
are: LockFile, SSLMutex, and SSLSessionCache. To ensure successful installation of 
Certificate Manager on a shared file system, RSA recommends that you make 
modifications before running the INSTALL script. For more information, see 
“Installing RSA Certificate Manager on Solaris or Linux” on page 26.

Make modifications as follows to both iws/dist/base.conf and 
WebServer/dist/base.conf, so that proper httpd.conf files are generated during the 
installation. Assuming there is a directory called /localdisk that is mounted on a local 
disk, make the following changes to both base.conf files:

#LockFile logs/accept.lock
LockFile /localdisk/accept.lock
#SSLMutex file:logs/ssl_mutex
SSLMutex file:/localdisk/ssl_mutex
#SSLSessionCache dbm:logs/ssl_scache
SSLSessionCache dbm:/localdisk/ssl_scache

Note: For testing, you can use /tmp as the local disk mounted directory. However, for 
security reasons, RSA recommends not using /tmp for production systems. For more 
information, go to 
http://httpd.apache.org/docs/2.0/mod/mpm_common.html#lockfile.

Apache uses the file named in the SSLSessionCache directive as is without appending 
a process ID (as it does for the other two directives). In the unlikely event that two 
separate installations of Certificate Manager are configured to point to the same 
directory on the same machine (for example, /localdisk), this could cause a conflict. 
The two separate Certificate Manager installations should use separate directories for 
their SSLSessionCache, that is, /localdisk/install1 for one and /localdisk/install2 for 
the other.

Startup Procedure

On the secondary machine:

1. Start Certificate Manager using the START script.
This allows you to enter any required PINs or passphrases.

2. When all servers have started, run the DISABLE script.
Running the DISABLE script puts Certificate Manager into standby mode 
allowing it to be restarted without prompting the Administrator for the ENABLE 
script.

3. Confirm that Certificate Manager is disabled by checking the system log.
You should see an entry similar to the following:
Sep 18 09:41:42 sparc-11 xudad[24624]: [ID 373491 local0.info] 
(INFORMATION) Switched to standby mode at: Wed Sep 18 09:41:34 2007
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On the primary machine:

• Start Certificate Manager using the START script.
For more information, see “Starting RSA Certificate Manager on Solaris or 
Linux” on page 41.

Failover to the Secondary Machine

Important: It is assumed that the primary Certificate Manager has failed and its server 
processes are no longer running. In the case of a partial failure, that is, some server 
processes are still running and you can access the primary machine, stop those server 
processes by running the STOP script on the primary machine.

On the secondary machine:

1. Run REMOVEPID to remove each of the server .pid files (that is, cmpserver.pid, 
xslogsrv.pid, httpd.pid, and xudad.pid).
If any of these files exist, the ENABLE script fails. This is a precaution against 
accidentally enabling the Certificate Manager when there is another fully 
operational instance of Certificate Manager.

2. Run the ENABLE script.
Running the ENABLE script brings the standby Certificate Manager into 
operation without prompting the Administrator, enabling an automated process to 
trigger startup.
It takes a few moments for the secondary to become fully operational. The system 
log indicates when Certificate Manager is fully operational, but there is no 
automated way (through a script) to determine this.

Important: To be able to sign using any CAs newly created on the primary 
instance since the dual startup, you must restart the secondary instance. This 
means that a restart of both servers should be part of the process for creating new 
CAs. For more information, see the Administrator’s Guide.

Restarting the Primary Machine

To restart the primary machine:

1. On the secondary machine, run the STOP script.

2. Repeat the startup procedure.
For more information, see “Startup Procedure” on page 43.
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3 Upgrading RSA Certificate Manager

This chapter describes how to upgrade RSA Certificate Manager. It includes 
information about upgrading customizations, troubleshooting, and converting 
software keys to hardware keys.

Upgrading RSA Certificate Manager

RSA Certificate Manager 6.9 supports upgrades from RSA Keon Certificate 
Authority/Certificate Manager 6.5.1 and later. If you are upgrading from a version of 
RSA Sentry Certificate Authority or a version of RSA Keon Certificate Authority 
earlier than 6.5.1, contact RSA Customer Support for information on how to 
successfully upgrade.

You can also use the upgrader to move an existing RSA Certificate Manager 6.9 
installation to another machine or platform.

Upgrading leaves your previous installation of Certificate Manager intact. You can 
continue to use the previous installation as a reference if necessary and uninstall it 
when you are ready. However, you must not continue to issue and manage certificates 
with the previous installation.

Preparing to Upgrade

Take the following steps before beginning an Certificate Manager upgrade:

1. Back up your entire existing installation. The upgrade process should not modify 
your original installation; however, a complete backup is a wise precaution. If you 
have customized your installation, you may need to refer to this backup to 
re-create some customizations. For more information, see “Upgrading 
Customizations” on page 56.

2. Verify that you have sufficient disk space available. You need an additional 
amount of space roughly equal to the space used by your existing installation.

3. Record the port numbers for the various virtual web servers, found in the 
httpd.conf file. You are prompted to verify these port numbers during the 
upgrade. The five virtual web servers are the Administration Server, Enrollment 
Server, SCEP Server, CRL Server, and Certificate Renewal Server.

4. Install RSA BSAFE SSL-C 2.8.5.1 library files on the host where the upgraded 
Certificate Manager will be installed. See “Installing RSA BSAFE SSL-C Library 
Files” on page 22.

5. Enable SSL 3.0 and TLS 1.0 in your browser. See “Enabling SSL 3.0 and TLS 
1.0” on page 22.

6. If you are using nCipher PKCS #11 keys, configure the nCipher PKCS #11 
provider. See “Configuring the nCipher PKCS #11 Provider” on page 23.
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7. If your existing SSL keys are nCipher native keys, regenerate the SSL keys as 
software-based keys. Whether you reissue the certificates one at a time or 
regenerate the SSL and Log Signing keys in one operation, select RSA as the 
cryptographic provider. For instructions, see “Reissuing RSA Certificate Manager 
Server Certificates” or “Generating New System Authority and SSL Keys 
Globally” in the chapter “System Maintenance” in the Administrator’s Guide.

8. If you are upgrading an Certificate Manager installation that uses tokens and you 
are installing the upgrade on a different machine, be sure to install token hardware 
and software to the new machine and move the tokens to the new machine before 
beginning the upgrade.
If your installation uses nCipher hardware, you must migrate the old security 
world to the new machine to be able to use the existing smart cards. For more 
information, see “Recovery Features” on page 90.

9. If you are upgrading an installation on Solaris SPARC, ensure that your original 
installation directory does not contain symbolic links to non-existent files.
If run from the top level of the installation directory, the following command 
identifies all such files:

find . -type l -exec test \! -e {} \; -print

Creating the Upgrade Package

You begin the upgrade process on the machine where the installation you are 
upgrading is located. The first step in upgrading Certificate Manager is the creation of 
an upgrade package. The upgrade package is an image of your existing installation, 
which can be migrated to other machines or platforms. The setup procedure for 
RSA Certificate Manager 6.9 uses this upgrade package as input to the setup process 
so that the newly installed product carries all of your previous certificates, LDAP 
ACL rules, revocation lists, and so on.

The upgrade package includes configuration files for all servers, certificate and key 
files for SSL support, an LDIF representation of the actual directory contents, and a 
new schema.conf file that represents the merged schema design. This merged schema 
design includes any additions to the schema that occurred after the setup of the 
existing installation.

After the upgrade package is created, you can continue with the upgrade and 
installation of RSA Certificate Manager 6.9 or complete the package creation and exit. 
If you exit the upgrade process, the information gathered by the upgrader is packaged 
in a file called package.tar. This file can be moved to another machine to complete 
the upgrade and installation of RSA Certificate Manager 6.9.

Note: The database backup configuration object is not copied from the older 
installation’s xudad.conf file when an upgrade is performed. The upgraded 
installation is installed with default settings. This allows any automatic backups on the 
older installation to continue and to not interfere with the upgraded installation. You 
must manually upgrade the new installation’s database backup configuration from the 
older installation.
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Important: If you use a PKCS #11 HSM, the setting for the cryptographic service 
provider is not copied to the configuration files in the upgraded installation. You must 
manually copy the directive to the following configuration files 
installed-dir/Xudad/conf/xudad.conf, installed-dir/WebServer/conf/server.conf, 
installed-dir/CmpServer/conf/icmpserver.conf, and 
installed-dir/LogServer/conf/islog.conf. For instructions, see “Adding the PKCS #11 
Library Path” on page 59.

Creating the Upgrade Package on Windows

The Windows version of RSA Certificate Manager 6.9 consists of both a zipped and 
an uncompressed distribution of setup files. 

Prerequisite

Ensure that you have Windows Administrator privileges.

To begin the upgrade process:

1. Stop all the services of the existing installation.

2. Unzip RSACM-v6.9build551r-WIN32.zip to a temporary directory.

3. Run setup.exe, either directly from the \uncompressed directory or from a 
temporary directory to which you have unzipped the zipped files. (Your version of 
unzip or WinZip must support long filenames.) 

4. Do one of the following:

• To use your computer’s default browser for installation and administration, 
select Use Default Browser and click Next.

• To use another browser:

a. Select Use Other Browser and click Next.

b. Select the browser you want to use.

5. Select Upgrade and click Next.

6. Select Create an Upgrade Package and click Next.

7. Specify the directory where the existing installation is located and click Next.

8. Specify the directory in which to create the upgrade package and click Next.
The default location is the \installed-dir\Upgrader directory. 
The upgrade package is created. This process may take a few moments.
3: Upgrading RSA Certificate Manager 47



RSA Certificate Manager 6.9 Installation Guide
9. Do one of the following:

• To upgrade Certificate Manager to a different machine or platform, click 
Finish Package Creation and Exit.
The upgrade package is collected into a file called package.tar. The upgrader 
looks for this file; do not change the filename. 
If you are upgrading Certificate Manager to another Windows machine, 
complete the installation according to the instructions in “Completing an 
Upgrade on Windows” on page 49.
If you are upgrading your operating system from Windows 2000 Server to 
Windows Server 2003 or 2008 or from Windows Server 2003 to Windows 
Server 2008, upgrade the operating system now, and then complete the 
installation according to the instructions in “Completing an Upgrade on 
Windows” on page 49.
If you are upgrading Certificate Manager from a Windows machine to a 
Solaris or Linux machine, copy the package.tar file to the Solaris or Linux 
machine and complete the installation according to the instructions in 
“Completing an Upgrade on Solaris or Linux” on page 53.

• To continue the upgrade installation on the current machine, click Continue 
Upgrade Using This Package and click Next.
Complete the installation according to the instructions in “Completing an 
Upgrade on Windows” on page 49, beginning with step 7. 

Creating the Upgrade Package on Solaris or Linux

The Solaris and Linux distribution packages contain two tar files: the main 
distribution tar file and an upgrade distribution tar file. You need both files to 
complete the upgrade.

To create an upgrade package:

1. If you are completing the upgrade on the same Solaris or Linux machine, copy the 
main distribution tar file, RSACM-v6.9build551r-sparc-sun-solaris.tar, 
RSACM-v6.9build551r-linux.tar, or RSACM-v6.9build551r-SuSE_linux.tar 
depending on your platform, to the directory where you want to install the new 
installation, for example, /usr/local/newRSA_CM/.

2. Untar the distribution.
The file is untarred to a new /RSA_CM directory within the current directory.

3. Stop all services of your existing installation.

4. Copy the upgrade distribution tar file, 
RSACM-v6.9build551r-sparc-sun-solaris.upgrade.tar, 
RSACM-v6.9build551r-linux.upgrade.tar, or 
RSACM-v6.9build551r-SuSE_linux.upgrade.tar depending on your platform, 
to the installation directory of the existing installation, for example, 
/usr/local/RSA_CM/.

5. Delete the /Upgrader directory and its contents from the existing installation.
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6. Untar the upgrade distribution tar file.
A new /Upgrader directory is created under the installation directory of the 
existing installation.

7. Change directories to the new /Upgrader directory and run the UPGRADE script.

8. When prompted to select the directory in which to create the upgrade package, do 
one of the following:

• To accept the default location, press ENTER.

• Enter the directory and press ENTER.
The UPGRADE script creates a new upgrade package.

Note: The UPGRADE script can be used for moving the installation to another 
location without actually doing an upgrade to a new version. For this scenario, use 
the default upgrader provided with the initial installation.

9. When prompted to indicate whether you want to complete the upgrade installation 
now or at another time, do one of the following:

• To install RSA Certificate Manager 6.9 to the same machine now, press 1 and 
Enter.
When prompted, enter the location of the new installation from step 1 and 
press Enter.
Complete the installation according to the instructions in “Completing an 
Upgrade on Solaris or Linux” on page 53, beginning with step 4.

• To install the upgrade to a different machine or platform, press 2 and Enter.
The upgrade package is collected into a file called package.tar. 
If you are upgrading Certificate Manager to another Solaris or Linux machine, 
complete the installation according to the instructions in “Completing an 
Upgrade on Solaris or Linux” on page 53.
If you are upgrading Certificate Manager from a Solaris or Linux machine to 
Windows machine, copy the package.tar file to the Windows machine and 
complete the installation according to the instructions in “Completing an 
Upgrade on Windows” on page 49.

Completing an Upgrade

After you have created the upgrade package, follow the instructions in this section to 
complete the Certificate Manager upgrade.

Completing an Upgrade on Windows

If you are completing the upgrade on the same machine as your previous installation 
and you selected Continue Upgrade Using This Package and clicked Next in step 9 
of “Creating the Upgrade Package on Windows” on page 47, go to step 7 to continue 
the upgrade.
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Prerequisites

• Ensure that you have Windows Administrator privileges.

• If you are completing the upgrade on a different machine or platform than the 
original installation, copy the package.tar file to the machine where you intend to 
install RSA Certificate Manager 6.9.

To complete the upgrade process:

1. If you are upgrading to the same machine and want to use the same port numbers, 
stop all services of the existing installation.

2. Run setup.exe, either directly from \uncompressed directory or from a temporary 
directory to which you have unzipped the zipped files. (Your version of unzip or 
WinZip must support long filenames.)

3. Do one of the following:

• To use your computer’s default browser for installation and administration, 
select Use Default Browser and click Next.

• To use another browser:

a. Select Use Other Browser and click Next.

b. Select the browser you want to use.

4. Select Upgrade and click Next.

5. Select Use Previously Prepared Upgrade Package and click Next.

6. Specify the location of the folder containing the package.tar file and click Next.
If you do not know the full path to the package.tar file, click Browse and locate 
the package.tar file.

Note:  Clicking Browse opens a dialog box containing the instruction “Please 
choose the installation folder.” This default InstallShield message may be 
misleading. You are only required to specify the path to the package.tar file at 
this point.

7. When prompted to configure cryptographic providers, do one of the following:

• If you are using a PKCS #11-compliant HSM with your Certificate Manager 
and have installed the HSM:

a. Select Search for cryptographic providers and click Next.

b. When prompted, enter the location to search for supported providers.

• If you are upgrading from an installation that uses an nCipher HSM or a 
software-based private keys, select Do not search and click Next.

8. Select the folder where you want to install RSA Certificate Manager 6.9 and click 
Next.
The folder is checked to ensure that it is empty, and then the upgrade package is 
copied to the folder.
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The Original Server Ports dialog box opens.

9. Verify the original port numbers from the existing installation and click OK.

10. If the Administration Server and Enrollment Server keys were encrypted in the 
existing installation, when prompted, enter the passphrase that was used and click 
OK.
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The Upgrader Port Info dialog box opens.

11. If needed, edit the port information for the new Certificate Manager installation. 
Click OK.

12. If the System CA’s private key is protected by a passphrase or hardware token, 
when prompted, enter the passphrase or PIN and click OK.

The upgrade process restarts the Secure Directory Server, the Administration 
Server, and the CMP Server.

13. If the CA keys and the SSL keys are protected by a passphrase or hardware token, 
when prompted, enter the passphrases or PINs and click OK.

Note: You may see the message described in step 14 before you have been 
prompted for the passphrases of all three servers. However, wait until you have 
responded to the three server prompts before connecting to the URL provided.
52 3: Upgrading RSA Certificate Manager



RSA Certificate Manager 6.9 Installation Guide
14. Using your browser, connect to the URL provided: 
https://host.subdomain.com:administration-port/ca/upgrade.xuda.
The LDAP ACL Rules Modification page opens.

Note: If you are unable to access the URL, you may be using a different browser 
for the upgrade than the one used for the previous installation. If this is the case, 
export the CM Administrative certificate from the browser at the previous 
installation and import the certificate into the browser at the new installation.

15. Click Continue to update the LDAP ACL rules.
The RSA Certificate Manager 6.9 upgrade is complete. You can connect to the 
Administration Server by clicking the hyperlink provided on the Upgrade 
Complete page.
RSA Certificate Manager 6.9 is now fully operational. If you upgraded to the 
same machine, both installations of Certificate Manager appear in the Services 
window in the Windows Control Panel.

Post-Upgrade Requirements

• After completing the upgrade process, you must generate a new CRL for each CA. 
For information on generating a new CRL, see the Administrator’s Guide.

• If you had customized files in your previous installation, you must manually add 
the customizations to your new installation. For more information, see 
“Upgrading Customizations” on page 56.

• As of RSA Certificate Manager 6.8, automatic generation of revocation lists is 
configured through the administrative interface. If you upgraded from a version of 
Certificate Manager earlier than 6.8, you must re-create through the 
administrative interface any revocation list timers that you had set in xudad.conf. 
For more information, see the Administrator’s Guide.

Completing an Upgrade on Solaris or Linux

If you are completing the upgrade on the same machine as your previous installation 
and you pressed 1 and Enter to continue the upgrade in step 9 of “Creating the 
Upgrade Package on Solaris or Linux” on page 48, go to step 4 to continue the 
upgrade.

Prerequisites

• If you are completing the upgrade on a different machine or platform than the 
original installation, copy the package.tar file in binary mode to the machine 
where you intend to install RSA Certificate Manager 6.9.

• To allow operation with nCipher cryptographic hardware, Certificate Manager 
must be installed by the “root” user or a member of the nfast group. If you install 
as “root”, you are required to specify a user other than “root” for the Web Server 
in step 11.
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To complete the upgrade process:

1. Copy the main distribution tar file, 
RSACM-v6.9build551r-sparc-sun-solaris.tar, 
RSACM-v6.9build551r-linux.tar, or RSACM-v6.9build551r-SuSE_linux.tar 
depending on your platform, to the directory where you want to install the new 
installation, for example, /usr/local/newRSA_CM/, and untar the distribution.
The file is untarred to a new /RSA_CM directory within the current directory.

2. Change directories to the new /RSA_CM directory and run the INSTALL script.

3. When prompted to indicate whether this is a new install or an upgrade, to select 
upgrade, press 2 and Enter.

4. When prompted to search for installed cryptographic providers, do one of the 
following:

• If you are upgrading from a Certificate Manager installation that uses a 
PKCS #11-compliant HSM, press 1 and Enter to search for cryptographic 
providers.

• If you are upgrading from a Certificate Manager installation that uses nCipher 
smart cards or software-based private keys, press 2 and Enter to skip the 
search and go to step 7.

Important: If you are upgrading from an installation that uses a 
PKCS #11-compliant HSM, you must search for and find the supporting 
cryptographic provider to be able to complete the upgrade.

If you are upgrading from an installation that uses an nCipher HSM, the upgrader 
automatically detects the cryptographic provider. You do not need to search for it.

5. When prompted to search for the PKCS #11 provider library, if you have installed 
the hardware, drivers, and firmware, press 1 and Enter. 

6. If the PKCS #11 provider library is not in a default directory, follow these steps:

a. Enter additional directories to search and press Enter.

b. Enter the name of the PKCS #11 provider library and press Enter. 

c. To select the library from the list of found libraries, press the number next to it 
and press Enter.

7. If prompted, enter the path to the package.tar file and press Enter. 
If you changed the default name of the package.tar file (created in step 9 of 
“Creating the Upgrade Package on Solaris or Linux” on page 48), enter the full 
path to the upgrade package, including the filename of the tar file.
If you used the default name of the package.tar file (created in step 9 of “Creating 
the Upgrade Package on Solaris or Linux” on page 48), enter the path to the 
directory containing the package.tar file.
If you pressed 1 and Enter in step 9 of “Creating the Upgrade Package on Solaris 
or Linux” on page 48, you are not be prompted for the path to the package.tar 
file.
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8. Verify the original port numbers from the existing installation.
Press Enter to accept the default port numbers. To change a port number value, 
enter the correct port number and press Enter. 

9. To confirm the port numbers, press y and Enter.

10. If the Administration and Enrollment Server keys were encrypted in the existing 
installation, enter the passphrase.

11. Enter the configuration information for the new Certificate Manager installation.
If you are installing as “root”, you must specify a user other than “root” for the 
Web Server.

12. To confirm the configuration information for the new Certificate Manager 
installation, press y and Enter.

13. If the System CA key is protected by a passphrase or hardware token, when 
prompted, enter the passphrase or PIN and press Enter.
The upgrade process restarts the Secure Directory Server, the Administration 
Server, and the CMP Server. 

14. If the private keys of these servers or any CAs are protected by a passphrase or 
hardware token, when prompted, enter the passphrase or PIN and press Enter. 

15. Using your browser, connect to the URL provided: 
https://host.subdomain.com:administration-port/ca/upgrade.xuda.
The LDAP ACL Rules Modification page opens.

Note: If you are unable to access the URL, you may be using a different browser 
for the upgrade than you used for the previous installation. If this is the case, 
export the CM Administrative certificate from the browser at the previous 
installation and import the certificate into the browser at the new installation.

16. Click Continue to update the LDAP ACL rules.
The RSA Certificate Manager 6.9 upgrade is complete. You can connect to the 
Administration Server by clicking the hyperlink provided on the Upgrade 
Complete page. RSA Certificate Manager 6.9 is now fully operational.

Post-Upgrade Requirements

• After completing the upgrade process, you must generate a new CRL for each CA. 
For information on generating a new CRL, see the Administrator’s Guide.

• If you had customized files in your previous installation, you must manually add 
the customizations to your new installation. For more information, see the 
following section, “Upgrading Customizations.”

• As of RSA Certificate Manager 6.8, automatic generation of revocation lists is 
configured through the administrative interface. If you upgraded from a version of 
Certificate Manager earlier than 6.8, you must re-create through the 
administrative interface any revocation list timers that you had set in xudad.conf. 
For more information, see the Administrator’s Guide.
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Upgrading Customizations

If you customized your previous Certificate Manager installation, you must re-create 
some of your customizations in your new RSA Certificate Manager 6.9 installation.

Interface Customizations

If you edited the .xuda and .html files for the Administration Server or the Enrollment 
Server, or if you added new files to these servers, manually make the changes to your 
new installation.

xudad.conf Customizations

Any changes you made to xudad.conf must be applied to the xudad.conf file in the 
new installation. RSA recommends that you use a diff utility to view the differences 
between the new and old configuration files and visually inspect the diff output to 
determine the changes that must be made to the new file. The standard files are similar 
enough that most differences will be limited to configuration changes (such as 
hostnames and ports) and customizations that must be migrated to the new 
configuration file.

The most common changes to xudad.conf are:

• Index directives (If you add custom index directives, you must manually re-index 
the database. If the field you are adding was mapped to a new name during 
package creation, ensure that the mapped name is used.)

• Setpin and revocation list generation directives for the signing engine.
As of RSA Certificate Manager 6.8, automatic generation of revocation lists is 
configured through the administrative interface. If you upgraded from a version of 
Certificate Manager earlier than 6.8, you must re-create through the 
administrative interface any revocation list generation directives that you had set 
in xudad.conf. For more information, see the Administrator’s Guide.

• Syslog parameters (Solaris and Linux only).

httpd.conf Customizations

Any changes you made to httpd.conf must be applied to the httpd.conf file in the 
new installation. RSA recommends that you use a diff utility to view the differences 
between the new and old configuration files and visually inspect the diff output to 
determine the changes that must be made to the new file. The standard files are similar 
enough that most differences will be limited to configuration changes (such as 
hostnames and ports) and customizations that must be migrated to the new 
configuration file.

The most common changes to httpd.conf include:

• Client authentication settings 

• Custom virtual hosts 

• Filenames for certificates and keys
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xslogconf.xml Customizations

Any changes you made to xslogconf.xml must be applied to the xslogconf.xml file in 
the new installation. It may be helpful to use a diff utility to view the differences 
between the new and old configuration files and visually inspect the diff output to 
determine that changes that must be made to the new file.

Web Server ACL Customizations

Changes you made to the default Web Server ACL rules may have to be re-created in 
the new installation. New ACL rules that you created must be re-created in the new 
installation.

If you have Web Server ACL rules that apply to virtual hosts other than the 
Administration and Enrollment Servers, and if the hostname or port number has 
changed in the new installation, manually add the hosts to the new installation, and 
manually move the ACL rules that apply to the additional hosts. This involves 
creating new xuda_host nodes for the relocated virtual hosts (both the DN and the 
content of the original nodes must be changed), and moving all of the existing 
xuda_acl rule objects by changing their DNs.

Certificate Profile Customizations

The Authority Key Identifier extension has been modified. If you upgrade to 
RSA Certificate Manager 6.9 from RSA Certificate Manager 6.5 and had created any 
new certificate profiles that contain the Authority Key Identifier extension, you must 
manually update the extension scripts. For information about this change and 
instructions for updating the extension script, see the Administrator’s Guide. 

Troubleshooting an Upgrade

The upgrade process generates several log files that may be useful if an error occurs 
during the upgrade. The upgrader launches external programs for each step in the 
process. The information below summarizes the steps that can occur during the 
upgrade process and lists the log files that are relevant for each step.

In most cases, log files have the name of the executable whose output they are 
capturing. Log files with an .out extension capture the standard output stream of a 
process, and files with an .err extension capture the standard error stream.

Overall

/installed-dir/Upgrader/bin/upgrader.log

This file captures the output that is displayed on the screen as the upgrader is 
executing. You can use it to determine which step was being performed when an error 
occurred.

Database Dump and Translation

/installed-dir/Upgrader/bin/ldbmcat.tdbm.out

An LDIF representation of the original database. This file may be extremely large.
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/installed-dir/Upgrader/bin/ldbmcat.tdbm.err

Any errors encountered attempting to dump the database to the LDIF file.

/installed-dir/Upgrader/bin/xu_ldbmcat.out
/installed-dir/Upgrader/bin/xu_ldbmcat.err

Output and errors from the process that performs minor adjustments to the database to 
prepare it for use with RSA Certificate Manager 6.9.

/installed-dir/Upgrader/bin/deletefile.out

A list of all the objects that were automatically deleted from the database in 
preparation for RSA Certificate Manager 6.9. In most cases, the objects listed here are 
re-created when the new version is installed.

Secure Directory Server Installation

/installed-dir/Xudad/bin/iXudad.log

A transcript of the Secure Directory Server installation process.

/installed-dir/Xudad/bin/xudad.out
/installed-dir/Xudad/bin/xudad.err

Output and errors resulting from Secure Directory Server installation. This file 
contains the results of attempting to set up the server on any platform. On Windows, it 
may also contain the results of attempting to register the server as a Windows service 
and to register the uninstall program for the server.

Directory Database Indexing

/installed-dir/Xudad/bin/ldif2ldbm.out
/installed-dir/Xudad/bin/ldif2ldbm.err

Output and errors resulting from the final re-indexing of the database.

Web Server Installation

/installed-dir/WebServer/bin/iHttpd.log

A transcript of the Web Server installation process.

/installed-dir/WebServer/bin/httpsd.out
/installed-dir/WebServer/bin/httpsd.err

Output and errors resulting from the Web Server installation process. These files 
contain the results of attempting to set up the server on Solaris or Linux.

/installed-dir/WebServer/bin/strong.out
/installed-dir/WebServer/bin/strong.err

Output and errors resulting from the Web Server installation process. These files 
contain the results of attempting to set up the server on Windows. These files may also 
contain the results of attempting to register the server as a Windows service and to 
register the uninstall program for the server. 
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Converting from Software to Hardware Keys

After upgrading to RSA Certificate Manager 6.9, you may want to convert the server 
keys from software keys to hardware keys. The conversion process does not migrate 
an existing software key to a hardware security module (HSM). Instead, it generates a 
new key and certificate, modifying LDAP ACL rules as necessary to give the new 
key-certificate pair the same privileges as the old one.

You must apply the server certificate re-signing operation for each software key in the 
installation. When performing this operation, select the option to generate a new key 
and then select the cryptographic provider. After this procedure is complete, the new 
installation is fully configured to work with all SSL and additional signing keys in 
hardware.

Note: If keys are software-based and hardware-based, the passphrase and PIN must 
match for unattended startup. For information on unattended startup, see the 
Administrator’s Guide.

To re-sign server keys with a CA other than the issuing System CA, set up and 
configure that CA before you reissue the server keys.

Adding the PKCS #11 Library Path

Before you can convert the software keys to hardware keys, you must add the 
PKCS #11 provider library path in the configuration files.

To add the PKCS #11 provider library path on Windows:

1. In installed-dir\Xudad\conf\xudad.conf, search for crypto_providers and add the 
following value:

crypto_providers “pkcs11v2,PKCS #11 provider path”

For example, if the cryptographic provider is nCipher PKCS #11, add:
crypto_providers “pkcs11v2,c:\nfast\bin\cknfast.dll”

2. In each of installed-dir\LogServer\conf\islog.conf, 
installed-dir\CmpServer\conf\icmpserver.conf, and 
installed-dir\WebServer\conf\server.conf, search for crypto_providers and add 
the following value:

crypto_providers = “pkcs11v2,PKCS #11 provider path”

For example, if the cryptographic provider is nCipher PKCS #11, add:
crypto_providers = “pkcs11v2,c:\nfast\bin\cknfast.dll”

3. Restart the Certificate Manager services.

4. When prompted during startup, enter the PKCS #11 provider passphrase. 
For an nCipher PKCS #11 provider, enter the nCipher persistent 1of N cardset 
PIN. The configured nCipher slot is 1.
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To add the PKCS #11 provider library path on Solaris or Linux:

1. In installed-dir/Xudad/conf/xudad.conf, search for crypto_providers and add the 
following value:

crypto_providers “pkcs11v2,PKCS #11 provider path”

For example, if the cryptographic provider is nCipher PKCS #11, add:
crypto_providers “pkcs11v2,/opt/nfast/toolkits/pkcs11/libcknfast.so”

2. In each of installed-dir/LogServer/conf/islog.conf, 
installed-dir/CmpServer/conf/icmpserver.conf, and 
installed-dir/WebServer/conf/server.conf, search for crypto_providers and add 
the following value:

crypto_providers = “pkcs11v2,PKCS #11 provider path”

For example, if the cryptographic provider is nCipher PKCS #11, add:
crypto_providers = “pkcs11v2,/opt/nfast/toolkits/pkcs11/libcknfast.so”

3. Restart the Certificate Manager services.

4. When prompted during startup, enter the PKCS #11 provider passphrase. 
For an nCipher PKCS #11 provider, enter the nCipher persistent 1of N cardset 
PIN. The configured nCipher slot is 1.

Converting the SSL Keys

To convert SSL keys from software to hardware:

1. Click Administrator Operations.

2. Under Server Certificates, click Re-issue.

3. Select an Issuer and a Jurisdiction to sign the SSL keys.

4. Select Internal Certificate and, from the drop-down list, select the filename of 
the server certificate. 

5. Click Next.

6. (Optional) Edit the certificate information.

7. Select Generate New Keypair. 

8. Select the PKCS #11 provider, the algorithm, and the key size.

9. Click Next.

10. If the existing key is protected by a passphrase, enter the passphrase, and click 
Next.

11. Enter the slot number of the PKCS #11 provider, and click Next.

12. Enter the PIN and click Next.

13. Enter the PIN or passphrase that protects the issuing CA’s key, and click Next.
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14. Click Re-Issue.
A new key is generated, the LDAP ACL rules are adjusted to recognize the new 
certificate, and you are notified that the new certificate has been added to your 
installation.

15. Repeat step 2 through step 14 for each server certificate in your installation.
If you configured the Secure Directory Server for unattended startup by recording 
the key encryption passphrase for the installation in a startup file, you must place 
the hardware PIN in this file or remove the file entirely before the new installation 
will start up correctly.
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4 Post-Installation

This chapter describes how RSA Certificate Manager is configured during the 
installation process, including:

• The four servers that are configured

• The six virtual web servers that are configured

• The CAs that are created

• The certificates that are issued

• The file directory structure
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Server Configuration

When you install Certificate Manager, the installation process installs four servers: the 
Web Server, the Certificate Management Protocol (CMP) Server, the Secure Directory 
Server, and the Logging Server. On Windows, the process names are apache.exe, 
cmpserver.exe, xudad.exe, and xslogsrv.exe respectively. On Solaris and Linux 
systems, the process names are httpsd, cmpserver, xudad, and xslogsrv respectively.

The Web Server component is split into five virtual web servers:

Administration Server. The server through which you perform all administrative 
functions. It requires client authentication, and communication is tightly secured 
between the web server and the web client. Web ACLs are used to further control 
access.

Enrollment Server. Offers a server-authenticated site that your public users 
(clients) can use to make certificate requests and retrieve issued certificates.

SCEP Server. Used for Simple Certificate Enrollment Protocol (SCEP) and 
Certificate Request Syntax (CRS) certificate requests for network devices. The 
SCEP Server does not require client authentication.
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CRL Server. Used for Certificate Revocation List (CRL) and Authority 
Revocation List (ARL) publishing. The CRL Server is not SSL-enabled. In other 
words, the CRL Server does not require client or server authentication.

Certificate Renewal Server. Used to re-sign expired end-entity certificates.

CMP Enroll Server. Uses the HTTP protocol for conveying CMP messages. The 
CMP Enroll Server does not require client authentication.

The CMP Server is used for certificate enrollment and related tasks by individual 
end-entities or registration authority (RA) applications. The CMP Server is a 
standalone server that has been implemented in Certificate Manager as a gateway to 
the back-end CA services. 

The Secure Directory Server stores all of the PKI information in an LDAP database. 
The Secure Directory Server is also used as a read-only repository for public users. 
Like the Web Server, the Secure Directory Server uses client authentication to allow 
administration. It also uses the LDAP ACLs to determine what access should be 
granted to authenticated end-entities.

The web servers communicate securely with the Secure Directory Server. The 
Administration Server has almost full access to the directory. The Enrollment Server 
and SCEP Server have limited access to the Secure Directory Server. The CRL Server 
has no access to the Secure Directory Server.

The Logging Server securely logs PKI and system events. Log data is stored in local 
files. The log files are signed by the Logging Server. You can export the log files in 
XML or comma-separated value format to process the logs for auditing purposes.

Installed CAs

When you install Certificate Manager, two CAs are created: the System CA and the 
Administrative CA. These CAs issue several certificates during the installation 
process.

The System CA and Administrative CA certificates are V3 certificates. These 
certificates are created with the Subject Key Identifier, Authority Key Identifier, and 
Basic Constraints extensions. These extensions are created with default values and are 
marked as non-critical.

System CA The System CA is a self-signed CA. The System CA signs all server 
certificates created during the installation. It also signs the 
Administrative CA’s certificate.

This CA should not be used after installation, except to re-sign the 
certificates it issued during installation. 

Administrative CA The Administrative CA certificate is signed by the System CA. 
During the installation process, the Administrative CA issues the 
Administrative Client certificate to the person who installs 
Certificate Manager.

The Administrative CA signs certificates used by Administrators, 
Vettors, and Auditors to connect to the Certificate Manager 
administration interface.
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Issued Certificates

The System CA and the Administrative CA issue several certificates during the 
installation process.

CM Administrative 
Certificate

This certificate allows the person who installed Certificate 
Manager to connect to the administration interface and use all of 
the Certificate Manager functions. It is signed by the 
Administrative CA.

This certificate is stored in the Administrator’s browser.

Administration Server 
SSL-LDAP Certificate

This certificate is used by the Administration Server to 
communicate with the Secure Directory Server. It is signed by the 
System CA.

This certificate is stored as admin.cert in 
/installed-dir/WebServer/ssl/certs/.

Administration Server 
HTTPS Certificate

This certificate is used by the Administration Server for server 
authentication to clients who attempt to connect to it securely 
through a web browser. It is signed by the System CA.

This certificate is stored as adminServer.cert in 
/installed-dir/WebServer/ssl/certs/.

Enrollment Server 
SSL-LDAP Certificate

This certificate is used by the Enrollment Server to communicate 
with the Secure Directory Server. It is signed by the System CA.

This certificate is stored as enroll.cert in 
/installed-dir/WebServer/ssl/certs/.

Enrollment Server 
HTTPS Certificate

This certificate is used by the Enrollment Server for server 
authentication to clients who attempt to connect to it securely 
through a web browser. It is signed by the System CA.

This certificate is stored as enrollServer.cert in 
/installed-dir/WebServer/ssl/certs/.

Logging Server SSL 
Certificate

This certificate is used by the Logging Server to establish SSL 
connections to clients sending log messages to the Logging Server. 
It is signed by the System CA.

This certificate is stored as server_ssl.cert in 
/installed-dir/LogServer/ssl/certs/.

Log Signing Certificate This certificate is used by the Logging Server to sign logs so they 
are secure. It is signed by the System CA.

This certificate is stored as signing.cert in 
/installed-dir/LogServer/sign/certs/.
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Note: Certificates are also issued for the CRL Server and are saved to 
/installed-dir/WebServer/ssl/certs/. The CRL Server is not SSL-enabled and does not 
use these certificates, even though they are present.

XUDAD Root Access 
Certificate

This certificate is used during Certificate Manager installation. It 
provides root access to the Certificate Manager Secure Directory 
Server. The certificate is signed by the System CA.

After the installation process is completed, only the CA copy tool 
needs the XUDAD Root Access certificate. After installing 
Certificate Manager, move this certificate to a more secure 
location. 

This certificate is stored as root.cert in 
/installed-dir/Xudad/ssl/certs/.

XUDAD Server 
Certificate

This certificate is used internally by the Certificate Manager 
Secure Directory Server for secure communications with the 
Certificate Manager Web Server. It is signed by the System CA.

This certificate is stored as ssl.cert in 
/installed-dir/Xudad/ssl/certs/.

SCEP Server 
SSL-LDAP Certificate

This certificate is used by the SCEP Server to communicate with 
the Secure Directory Server. It is signed by the System CA.

This certificate is stored as scep.cert in 
/installed-dir/WebServer/ssl/certs/.

SCEP Server HTTPS 
Certificate

This certificate is used by the SCEP Server for server 
authentication to clients who attempt to connect to it securely 
through a web browser. It is signed by the System CA.

This certificate is stored as scepServer.cert in 
/installed-dir/WebServer/ssl/certs/.

CRS Signing 
Certificate

This certificate is used by the SCEP Server to sign CRS response 
messages. It is self-signed.

This certificate is stored as crsSigner.cert in 
/installed-dir/WebServer/ssl/certs/.

CMP Server 
SSL-LDAP Certificate

This certificate is used by the CMP Server to communicate with 
the Secure Directory Server. It is signed by the System CA.

This certificate is stored as cmp.cert in 
/installed-dir/CmpServer/ssl/certs/.
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File Directory Structure

This section identifies important directories in your Certificate Manager installation. 
This section does not provide a complete listing of the directories and files that appear 
in a standard Certificate Manager installation.

 audit-logs

Default audit log archive directory

 CmpServer

CMP Server root directory

 conf

CMP Server configuration directory

 osa

OneStep API-compliant plug-in directory

 conf

Unattended startup directory

 LogServer

Logging Server root directory

 conf

Logging Server configuration directory

 logs

Certificate Manager log files directory

 Utils

Utilities directory

 WebServer

Web Server root directory

 admin-server

Administration Server document root directory

 ca

 admin-ops

Administrator Operations Workbench directory
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 auditor-ops

Auditor Operations Workbench directory

 ca-ops

CA Operations Workbench directory

 cert-ops

Certificate Operations Workbench directory

 config

System Configuration Workbench directory

 help

Administrative Operations help directory

 conf

Web Server configuration directory

 crl-server

CRL Server document root directory

 enroll-server

Enrollment Server document root directory

 extensions

Certificate Manager x-templates for v3 certificate extensions directory

 logs

Web Server error/message logs directory

 modules

Apache web server modules

 scep-server

SCEP Server document root directory

 scripts

JavaScript directory

 ssl

Web Server SSL certificate and key directory
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 x-templates

Certificate Manager x-templates (macros) directory

 Xudad

Secure Directory Server root directory

 conf

Secure Directory Server configuration directory

 db

Secure Directory Server database directory
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5 Configuring RSA Certificate Manager

This chapter describes the server configuration files found in RSA Certificate 
Manager.

Configuration Files

Whenever you modify a configuration file, you should restart the server that it 
configures.

Global PKI Configuration Settings

The server.conf configuration file defines global settings such as your mail server and 
return e-mail address for the Administrator. The file is located at 
/installed-dir/WebServer/conf/server.conf.

Web Server Configuration Settings

The Web Server configuration file defines aspects of the Certificate Manager Web 
Server. This file is located at /installed-dir/WebServer/conf/httpd.conf.

Many of the settings in this configuration file are self-explanatory or are explained in 
the documentation for Apache. These settings, such as the document root, are generic 
to any web server. A number of other settings represent Certificate Manager variables. 
Specifically, the settings under each of the five default virtual hosts (Administration 
Server, Enrollment Server, SCEP Server, CRL Server, and Certificate Renewal 
Server) affect the operational capabilities of Certificate Manager. You should not 
modify the SSL directives unless you are following the directions from a solution 
found in the RSA SecurCare Online knowledge database. 

Secure Directory Server Configuration Settings

The Xudad configuration file defines configurable aspects of the Secure Directory 
Server. Do not edit or change this file in any way unless you are following instructions 
in the Certificate Manager documentation or from RSA Customer Support. On a 
Solaris or Linux platform, if you are starting the Secure Directory Server manually 
(without using a supplied script), you must specify the location of this configuration 
file. The file is located at /installed-dir/WebServer/conf/xudad.conf.

CMP Server Configuration Settings

The CMP Server configuration file defines aspects of the CMP Server, in the format 
tag=value. This file is located at /installed-dir/CmpServer/conf/cmp.conf.
5: Configuring RSA Certificate Manager 71



RSA Certificate Manager 6.9 Installation Guide
Logging Configuration Settings

The Web Server and Secure Directory Server each has its own logging configuration 
file. This file specifies the host and port of the Logging Server and the end-entity 
certificate used to connect to the Logging Server via SSL. The Web Server logging 
configuration file is located at /installed-dir/WebServer/conf/xslogclient.conf.

The Secure Directory Server logging configuration file is located at 
/installed-dir/Xudad/conf/xslogclient.conf.

Logging Server Configuration Settings

The Logging Server configuration file specifies the port number, service names, the 
certificate used to sign log files, and several logging options, including the log period 
and the maximum number of log entries. This configuration file is in XML format. 
The file is located at /installed-dir/LogServer/conf/xslogconf.xml.

Unattended Startup Configuration Settings

You can configure unattended startup by creating a startup.conf file in the 
/installed-dir/conf directory and supplying a setpin directive in the xudad.conf file in 
the /installed-dir/Xudad/conf directory. 

For more information, see the Administrator’s Guide.

Web Server Configuration

If you have installed Certificate Manager on a UNIX machine in a Network File 
System (NFS) mounted directory, you should modify the LockFile directive in the 
httpd.conf file to place the lockfile on a local disk.

The syntax of this directive is:

LockFile <file path>

CAUTION: Avoid putting the lockfile in a world writable directory. Someone could 
create a denial-of-service attack by creating lockfiles in such a directory. More 
information is available at the Apache web site at 
http://httpd.apache.org/docs/2.0/mod/mpm_common.html#lockfile.

Secure Directory Server Configuration

Back End Configuration

The Secure Directory Server operates by mapping LDAP requests to different 
back-end services. A back end is a collection of functions within the Secure Directory 
Server that are invoked when a request is made to a particular part of the LDAP 
directory information tree.

The xudad.conf file specifies the parameters for the various back ends in the Secure 
Directory Server. Each back end is specified by a configuration block that begins with 
a database directive and ends at the next database directive (or at the end of the file). 
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Here is an example from the standard xudad.conf file as it appears just after an 
installation:

database caoperations
suffix "o=ca,o=services"
sslonly 1

database services
suffix o=services

This example specifies two back ends: caoperations and services. Each back end has a 
suffix directive that determines which part of the LDAP directory tree the back end 
serves. The caoperations back end serves all requests involving objects at or below the 
o=ca,o=services branch of the tree. In other words, any request that involves an object 
whose DN ends with o=ca,o=services is served by the caoperations back end.

The services back end serves requests under the o=services branch. It provides 
functions such as unique identifiers and timestamps. It does not understand any 
configuration directives other than suffix.

Other back ends that you may see in your xudad.conf file are the acl and ldbm back 
ends. The acl back end deals with the Secure Directory Server access control rules and 
the ldbm back end is the primary database for the Secure Directory Server LDAP 
services. (The ldbm back end suffix directive is an empty string, indicating that it is 
the default back end for all operations.) Tampering with the configuration of either of 
these back ends can cripple or disable the Secure Directory Server.

Important: Always make a backup of your xudad.conf file before changing it in any 
way.

The caoperations Back End

The caoperations back end is known as the signing engine because it controls how CA 
private keys are used. The signing engine performs all CA operations. Configuring 
this back end determines how PKI objects (for example, certificates and CRLs) are 
published and how control over a CA key is granted (by defining when a CA’s 
passphrase or PIN is required).

CAUTION: Do not change the suffix directive for the caoperations back end. At best, 
changing the suffix disables all CAs. At worst, it can cause unpredictable and 
potentially disastrous behavior in the Secure Directory Server.

The caoperations back end contains an sslonly directive. This directive can be set to 
either 1 or 0. It controls whether an SSL-LDAP connection is required to access the 
signing engine. RSA strongly recommends that this directive always be set to 1, 
because disabling SSL protection can leave the Secure Directory Server’s CAs 
vulnerable.
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Secure Directory Server Security Configuration

The client authentication settings in the xudad.conf file control access to the Secure 
Directory Server by the Administration and Enrollment Servers and other applications 
that may communicate with the Secure Directory Server. Default settings should be 
sufficient for most installations. Values are set to 1, the highest security setting.

The four security values in the xudad.conf file are: 

• clientauthlevel

• verifystatus

• ldbmverify

• secureroot

clientauthlevel

clientauthlevel specifies what level of authentication the client certificate must have to 
connect to the Secure Directory Server via SSL-LDAP.

Value Value Meaning

0 Client authentication is turned off. The client's certificate is not used by SSL. This 
setting allows a user to connect via SSL-LDAP without a certificate. However, 
because the Administration and Enrollment Servers present their certificates 
when connecting via SSL-LDAP, setting this value to 0 (zero) effectively breaks 
the product because the web servers will not have any permissions to read/write 
the objects that they need to. Normally, ACL rules on the objects in the directory 
allow the Administration and Enrollment Servers to do the work they require. In 
this case, no certificates are presented, thus no X.509 binding is done and the 
product does not work.

1 Client authentication is optional. Clients may present a certificate but are not 
required to. This allows clients with certificates to have their certificates checked 
to make sure a trusted CA signed them, and allows the Administration and 
Enrollment Servers to do X.509 binding. It is still possible to use SSL-LDAP 
without presenting a certificate. In such a case, the client is bound as “nobody”. If 
a client does present a certificate, it must be signed by a trusted CA. 

3 Client authentication is turned on. Clients must present a certificate signed by a 
known CA. If they do not, access is denied. This is the default setting.
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ldbmverify

ldbmverify instructs the Secure Directory Server whether or not to check certificates 
against the local database. If the certificate is invalid (or not present), the connection is 
refused. This only applies if clientauthlevel and verifystatus are also turned on (set to 
1).

verifystatus

verifystatus instructs the Secure Directory Server whether or not to verify certificates. 
Verification may only be turned on if clientauthlevel and ldbmverify are also turned on 
(set to 1). 

Value Value Meaning

0 Verification is turned off. Certificates are not verified against the local database. 

1 Verification is turned on. This is the default setting.

The status of all presented certificates is checked against the xuda_certificate 
object in the database. Only clients with certificates that can be validated can 
connect to the Secure Directory Server using SSL-LDAP. 

Setting ldbmverify to 1 disables cross-authentication. The Secure Directory 
Server will not allow remote connections to check certificate status as the client 
certificate is not stored locally (even if the certificate's signer is trusted). To 
enable cross-authentication set ldbmverify to 0, clientauthlevel to 1, and 
verifystatus to 1.

Value Value Meaning

0 Verification is turned off. Certificates are not verified on SSL connect. 

1 Verification is turned on. This is the default setting.

The client certificate is verified when the SSL connection is made.

Setting verifystatus to 1 disables cross-authentication. The Secure Directory 
Server will not allow remote connections to check certificate status as the client 
certificate is not stored locally (even if your certificate's signer is trusted). To 
enable cross-authentication set verifystatus to 0.

This flag has no function unless clientauthlevel and ldbmverify are set to 1.
5: Configuring RSA Certificate Manager 75



RSA Certificate Manager 6.9 Installation Guide
secureroot

secureroot instructs the Secure Directory Server whether or not root binds must be 
done via SSL.

The following table illustrates the level of access granted to the Secure Directory 
Server in various situations, depending on the clientauthlevel, ldbmverify, and 
verifystatus settings.

Value Value Meaning

0 Root binds allowed via non-secure port. 

1 Root binds must be done via SSL. You cannot connect to the non-secure port and 
pass in the root bind DN to get root access. This is the default setting.

Option Setting 

clientauthlevel 0 0 0 0 1 1 1 1 3 3 3 3

ldbmverify 0 0 1 1 0 0 1 1 0 0 1 1

verifystatus 0 1 0 1 0 1 0 1 0 1 0 1

Certificate Presented Access Granted?

No certificate presented Y   Y Y Y Y Y Y Y N N N N

Certificate issued by local 
CA in database 

Y Y Y Y Y Y Y Y Y Y Y Y

Certificate issued by 
trusted CA 

Y Y Y Y Y Y Y N Y Y Y N

Certificate issued by 
unknown CA

Y Y Y Y N N N N N N N N

Certificate issued by local 
CA not in database   

Y Y Y Y Y Y Y N Y Y Y N

Revoked certificate Y Y Y Y Y Y Y N Y Y Y N
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CMP Server Configuration

Following are the default values for settings in the CMP Server configuration file, 
cmp.conf. 

Tag Default Value Description

cahost localhost Indicates the host running Certificate 
Manager.

caport 636 Indicates the SSL-LDAP port of the 
Certificate Manager installation.

cmpport 829 Indicates the CMP port of the 
Certificate Manager installation.

ssl_keyfile c:\program files\rsa security\
rsa_cm\CmpServer\ssl\private\
cmp.key

Indicates the path to the SSL private 
key file, used to contact the Secure 
Directory Server. 

ssl_certfile c:\program files\rsa security\
rsa_cm\CmpServer\ssl\certs\
cmp.cert

Indicates the path to the SSL certificate 
file, used to contact the Secure 
Directory Server. 

plugin onestep Indicates the CMP plug-in to use. This 
plug-in file must reside in the /osa 
directory. The plug-in name must not 
include the .osa extension. For 
example, if onestep.osa is to be used, 
the line must read:

plugin=onestep

loglevel 1 Indicates the amount of logging the 
CMP Server performs:
0 = does not log
1 = logs only Errors
2 = logs both Errors and Warnings

timeout 86400 Indicates the time in seconds for the 
polling period returned to the CMP 
client if the certificate request is 
manually vetted.
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A Cryptographic Hardware Interoperability

This appendix provides information on how RSA Certificate Manager and 
cryptographic products work together.

Note: The RSA Interoperability Lab tests products on an ongoing basis. For additional 
interoperability information, visit the RSA Customer Support web site.

Secured by RSA Products

As part of the Secured by RSA Certified Partner Program, we work to assure 
customers that stringent interoperability criteria have been met by providing our 
technology partners with the Secured by RSA seal of approval. This designation 
applies to any product that has been tested in the RSA Interoperability Lab and has 
been proven to meet the rigorous integration requirements of large-scale PKI 
deployments. 

RSA Certificate Manager is interoperable with the following specific cryptographic 
hardware products:

• nCipher nShield and netHSM

• SafeNet Luna CA3 and Luna SA

Certificate Manager is interoperable with hardware devices compatible with versions 
1 and 2 of PKCS #11.

For more information about Secured by RSA products, visit the RSA Solutions 
Gallery at www.securedbyrsa.com for the RSA Secured Implementation Guides.

Private Key Protection

With Certificate Manager, all private keys can be protected in hardware. The 
following table shows which type of token or smart card is recommended for each 
type of key. The options marked * are possible, but not recommended as MofN 
sign-on would be required at startup (which negates many of the security benefits 
MofN offers).

MofN describes the security mechanism whereby some number M out of a pool of N 
(where M is less than or equal to N) users must authenticate to perform some action 
(for example, start a service).
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Note: Where MofN is used in this appendix, M is assumed to be greater than one. M 
equal to one is a valid setting, however it is discussed separately as the security 
considerations are different.

Protection Levels

Software

Private keys that are stored in software are stored on the hard drive of the 
Certificate Manager installation machine, either as a file or in the Secure Directory. 
These can be protected by a passphrase that is required to read the keys. These keys 
can be backed up and restored easily.

Standard nCipher Operator Card Set

Private keys are generated by the nCipher hardware, encrypted, and then stored on a 
hard drive. The hard drive can be on the Certificate Manager installation machine or, 
if using netHSM, can be on a separate machine. The private keys are never visible in 
an unencrypted form outside the nCipher Security World. (A Security World consists 
of one or more hardware modules, a set of smart cards, and some encrypted data 
stored on computer.) To access the keys, a smart card, PIN, and the original Security 
World are required. The original Security World can be re-created with a backup of the 
Security World and the Administrative Card Set (see “nCipher Security World” on 
page 85 and “Card Sets in the Security World” on page 85).

nCipher MofN

Private keys are created with an MofN-protected Operator Card Set (OCS). To access 
the key, M smart cards and PINs and the original Security World are required. The 
Security World (including the keys and smart cards) can be recovered with the 
Administrative Card Set and the nCipher hardware.

Private Key Type nCipher
MofN 
nCipher

SafeNet 

Luna CA3

MofN 
SafeNet 

Luna CA3

SafeNet 
Luna SA

Certificate Manager 
Server keys

         Y          Y1          N  N Y

CA  Y2          Y3          Y          Y Y

Revocation list signer          Y          Y*          Y          Y* Y

1   Only supported when M=1 for PKCS #11 keys.
2   Only supported for nCipher native keys.
3   Only supported for nCipher native keys. Only supported when M=1 for the System and Administrative
CAs.
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Standard Luna CA3 Token

Private keys are stored on a token protected by a PIN. To access the keys, it is 
necessary to have the token, the black key (see “Description of Datakeys” on page 95) 
and PIN, and a SafeNet token reader. PINs are difficult to crack as the token data 
becomes unreadable after ten (10) login failures. Tokens and user keys can be cloned 
for backup purposes in the event the originals are lost or destroyed.

SafeNet Luna CA3 MofN

Private keys are created on a smart card with MofN protection. To access the keys, an 
MofN logon is required (needs M green keys), the black key and PIN, and a SafeNet 
token reader. The token and the black key can be cloned for recovery. The green MofN 
keys cannot be cloned. If more than N minus M keys are lost, the keys on the tokens 
cannot be recovered.

SafeNet Luna SA

Private keys are stored on a partition protected by a PIN. To access the keys, it is 
necessary to have the partition PIN. The partition must be configured with Hardware 
Security Modules (HSMs) to provide provisioning for encryption, decryption, 
authentication, and signing services. SafeNet LunaSA PKCS #11 SSL keys are 
generated on the first available slot.

nCipher 1 of N

1 of N where N is greater than one is a special case of MofN. This configuration gives 
no greater security than a standard configuration. Instead, it allows multiple operators 
to have the ability to access the private keys.

FIPS 140-1 Level 2 or Level 3

Federal Information Processing Standards (FIPS) 140-1 Level 2 or Level 3 is provided 
by the nCipher Security Worlds that use the nShield module. SafeNet Luna CA3 
supports Level 3. For more information on FIPS requirements for cryptographic 
modules, go to www.itl.nist.gov/fipspubs/index.htm.

FIPS 140-2 Level 2 or Level 3

FIPS 140-2 Level 2 or Level 3 is provided by the nCipher Security Worlds that use the 
nCipher nShield or netHSM modules, or by the Safenet Luna SA HSM and Luna CA3 
tokens.
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Recommendations

In almost all cases, production PKIs require the added security of using hardware to 
protect private keys generated and used by the installation. This is particularly true for 
the private keys of CAs. The server and revocation list signer keys benefit to a lesser 
extent, as the cost associated with one of these keys being compromised is less than 
that of a CA private key. 

Before deciding to use MofN to protect a key, consider how the private key will be 
used. MofN was primarily designed for infrequent signing operations where all M key 
holders would be present when the signing took place. Normally, this does not apply 
to the signing of general end-entity certificates. MofN is more appropriate for use with 
root CA keys. The private key would only be needed for generating the small set of 
subordinate CAs. At all other times, the token or smart card can be locked away for 
proof against tampering. If MofN is used for keys that have to perform regular signing 
operations, either the overhead associated with using MofN becomes too heavy or the 
security it provides is compromised. If MofN login is standard when 
Certificate Manager is started, the security gains it provides are minimal. If 
unattended startup is required, it is impossible to establish an MofN session where M 
is greater than one.

High Security Example

The following Certificate Manager setup would provide a high security installation 
while maximizing the utility factor (that is, a practical implementation):

• FIPS 140-1 Level 3 (nCipher nShield, nCipher netHSM, SafeNet Luna CA3, or 
SafeNet Luna SA) or FIPS 140-2 Level 3 HSM (nCipher nShield or 
nCipher netHSM)

• Keys created at installation (System CA, Administrative CA, CMP, SCEP, and 
SSL) protected by standard tokens or smart cards

• Root CA and other created high security CAs that have infrequent signing 
requirements protected by MofN tokens or smart cards (RSA has not tested MofN 
with SafeNet Luna SA)

• Subordinate CAs used for day-to-day operations and target CAs for RAs protected 
by a standard token or smart card

• At startup, establish a session with keys created at installation and the subordinate 
CAs protected by the standard token or smart card

• Store the tokens or smart cards for MofN in a secure location, away from the 
installation (when signings are required, provide PINs for each signing, and 
secure the tokens or smart cards after the signing operations are completed)
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nCipher nShield and netHSM

Introduction

nCipher nShield and netHSM are devices that generate and protect private keys, and 
provide high performance and secure hardware key management for the RSA Digital 
Certificate Solution. Using nShield and netHSM, Certificate Manager deployments 
can be optimized for highly scaled e-commerce applications. nShield and netHSM are 
based on nCipher’s powerful encryption acceleration technology and provide a high 
level of performance for Certificate Manager key generation, signing, verification, 
and authentication operations.

When using nCipher hardware (nShield and netHSM), keys are never revealed to the 
outside world or even to the main memory of the Certificate Manager installation in 
an unencrypted format, vastly increasing the security of key data. 

Certificate Manager uses nCipher hardware to generate keys using true 
hardware-based random number generation, encrypt keys for secure storage, and 
maintain key security in highly sensitive applications where federal standards level 
security is critical. Depending on how they are used, nCipher hardware devices are 
FIPS 140-1 or 140-2 Level 3 compliant.

Certificate Manager supports nCipher cryptographic operations both from within 
Certificate Manager software and the RSA Certificate Manager API. 
RSA Certificate Manager 6.9 supports the nCipher nShield and netHSM hardware 
modules with version 11.30 and earlier software packages.

Functionality

Note: Users must ensure that the required nCipher smart card is inserted into the 
nCipher card reader before any Certificate Manager operations if the card set is 
non-persistent. The smart card can be removed from the card reader if the card set is 
persistent.

Key Pair Generation 

Certificate Manager and RSA Certificate Manager API can create keys using nCipher 
smart cards. These smart cards support key generation for key pairs based on both 
RSA algorithms and DSA algorithms.

RSA: 1024 bits, 2048 bits, 4096 bits 

DSA: 512 bits, 1024 bits, 2048 bits

Note: The smart card is required for key pair generation whether or not it was set to 
persistent during initialization.

Manufacturer: Thales ISS

Web site: www.thales-esecurity.com
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Key Storage

Certificate Manager and Certificate Manager API support the storage of 
cryptographic keys using nCipher smart cards.

Signature Verification

Certificate Manager and Certificate Manager API support signature verification using 
nCipher smart cards. 

Signing with Keys

Certificate Manager and Certificate Manager API support the usage of keys stored in 
the nCipher key storage for signing operations. 

MofN Signing with Keys

Certificate Manager and Certificate Manager API support the usage of keys stored in 
the nCipher key storage for MofN signing operations.

Note: In the nCipher documentation, the term MofN is referred to as KofM.

Certificate Signing

Certificate Manager and Certificate Manager API support certificate signing for CA 
and end-entity certificates using keys stored in the nCipher key storage.

Revocation List Signing

Certificate Manager and Certificate Manager API support the signing of revocation 
lists using CA keys stored in the nCipher key storage.

Certificate Authority Creation

Certificate Manager and Certificate Manager API support the generation of certificate 
authorities with private keys stored in the nCipher key storage.

Configuration

To use the KeySafe application, you must install Java before you install the nCipher 
hardware and software. For the required version of Java, see the appropriate nCipher 
administrator guide.

• On Windows, install the nCipher software before you install the nCipher 
hardware. Windows uses plug and play, so the nCipher driver must already be 
installed to detect the hardware.

• On Solaris or Linux, install the nCipher hardware before you install the nCipher 
software.
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Installing nCipher Hardware

Full installation instructions are available in the nCipher Hardware Installation Guide 
found on the nCipher installation CD. Instructions for upgrading the module firmware 
are available in the nCipher nShield/payShield Administrator Guide or 
netHSM/payShield net Administrator Guide.

Installing the nCipher Server Software

Installation instructions are available in the appropriate nCipher user guide on the 
nCipher installation CD. If you use netHSM, ensure that you set up the remote file 
server.

Note: On some older versions of the nCipher hardware, the server software cannot be 
upgraded to 6.14 or later because they are no longer supported by nCipher.

If the module type code is ‘2’ or ‘4’ (obtained by running the enquiry command), the 
nCipher software cannot be upgraded beyond v5.x.

nCipher Security World

Before you can use the nCipher HSM, you must create a Security World. A Security 
World consists of one or more hardware modules, a set of smart cards, and some 
encrypted data stored on a computer.

To create a Security World using nShield or netHSM, you must set the hardware 
module in pre-initialization mode, create a Security World using the KeySafe 
application or the new-world command, and finally set the hardware module in 
operational state. If you use netHSM, you have the option to configure the security 
world from the front panel of the module. Detailed information on the Security World 
can be found in the appropriate nCipher administrator guide. 

Important: For use with Certificate Manager, you can select 3DES or AES keys when 
you set up the security world.

Card Sets in the Security World

A Security World is designed to ensure all keys remain secure throughout their life 
cycle. Within a given security world, there are two different types of card sets; an 
Administrator Card Set and some Operator Card Sets. The Administrator Card Set is 
used to control access to recovery functions, and is created during Security World 
initialization. There is only one per Security World.

Operator Card Sets control access to application keys. Each user can access the keys 
protected by the Security World and protected by their Operator Card Set only. When 
you initialize a smart card, you must provide new Operator Card Set passphrases.

Certificate Manager uses Operator Card Sets for key generation and signing 
operations.
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Important: If you have nCipher-based server keys and want to have a separate 
non-persistent card set for use by a CA, and if you do not want to be prompted for the 
PIN of the non-persistent card set during signing operations, you must perform these 
extra steps. Start Certificate Manager services and log in to the non-persistent card set, 
and then remove the last card to continue startup with the server keys' card set 
inserted. After services have started, you must perform an operation via the 
Certificate Manager UI that requires a login to the non-persistent card set, such as 
generating a revocation list. After this initial login from the UI, you will not be 
prompted for the PIN for subsequent operations using that card set.

Important: Erase the smart cards used as Operator Cards before reinitializing the 
nCipher module. Otherwise, these cards must be discarded because they cannot be 
used, erased, or reformatted without the original Security World key.

nCipher Smart Card Labels

Smart card labels are defined when the smart card is initialized. They are simply a 
name that you attach to the smart card to help you organize your smart cards and keep 
track of what each one is used for. Labels can only be changed by reinitializing the 
smart card. 

Initializing nCipher Smart Cards

Initialize nCipher smart cards before you use them with Certificate Manager. Use one 
of the following methods to initialize a new smart card: 

Note: If you want to enable MofN encryption, you must create the MofN card set 
using the KeySafe or createocs utility. If you use netHSM, you can alternatively use 
the module front panel to create the card set.

• Use the nCipher KeySafe utility
Initialize nCipher smart cards using the nCipher KeySafe utility. For instructions, 
see “Creating an Operator Card Set with Keysafe” in the nCipher 
nShield/payShield or netHSM/payShield net Operator Guide.

• Use createocs
For instructions, see “Creating Operator Card Sets” in the appropriate nCipher 
operator guide.

• Use createoc-simple

path/createoc-simple  [--fips authslot] [--force] module 
slot label persist timeout password

where:

--fips authslot Must be 0 if you have created a FIPS 140-1 Level 3 security 
world

--force Allows for the overwriting of non-blank cards
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For example:

createoc-simple 1 0 token1 no 0 1234

For instructions, see “Creating Operator Card Sets” in the appropriate nCipher 
operator guide.

Installing the nCipher PKCS #11 Library

For instructions on installing the nCipher PKCS #11 library, see “nCipher application 
interfaces” in the netHSM operator guide.

Checking the Installation of the nCipher PKCS #11 Library

After you have created a security world, ensure that the nCipher PKCS #11 library has 
been successfully installed by using the ckcheckinst command-line utility. In a 
FIPS 140-2 level 3 compliant security world, you need an Operator Card from the 
security world to run this utility. If you did not install your security world in 
FIPS140-2 level 3 mode, you can run the utility by using either an Operator Card or a 
fixed token.

If any tests fail, ckcheckinst displays a message indicating the failure and quits. It does 
not run any subsequent tests.

If ckcheckinst fails:

• Ensure that the nCipher server is running.

• Run the enquiry and nfkminfo commands.

If all seems in order, reinstall the nCipher library.

Configuring the nCipher PKCS #11 Provider Environment Variable

To configure the nCipher PKCS #11 provider on Windows:

1. Set the environmental variable NFAST_HOME to C:\nfast.

2. Ensure the nCipher PKCS #11 library is available at C:\nfast\bin\cknfast.dll.

3. To generate SSL PKCS #11 keys, in the C:\nfast\cknfastrc file, set the following 
variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

module Module number of the HSM, usually 1

slot Usually 0

label Name of token

persist Should be yes or no

timeout Must be 0

password mandatory, undocumented
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4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst.exe utility in 
the C:\nfast\bin directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot and is used by 
Certificate Manager for nCipher PKCS #11 key generation. The accelerator slot, 
which is slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo.exe utility.

Note: nCipher PKCS#11 SSL keys support only a 1of N persistent card set.

To configure the nCipher PKCS #11 provider on Solaris or Linux:

1. Set the environmental variable NFAST_HOME to /opt/nfast.

2. Ensure the nCipher PKCS #11 library is located at 
/opt/nfast/toolkits/PKCS11/libcknfast.so.

3. To generate SSL PKCS #11 keys, in the /opt/nfast/bin/cknfastrc file, set the 
following variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst utility in the 
/opt/nfast/bin/ckcheckinst directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot and is used by 
Certificate Manager for nCipher PKCS #11 key generation. The accelerator slot, 
which is slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo utility in the 
/opt/nfast/bin directory.

Note: nCipher PKCS #11 SSL keys support only a 1of N persistent card set.

Setting the nCipher PKCS #11 Provider in RSA Certificate Manager

To set the PKCS #11 provider:

1. Modify the existing line in the installed-dir/Xudad/conf/xudad.conf file to 
specify the location of the PKCS #11 library.
For example, on Windows:
crypto_providers “pkcs11v2,c:\nfast\bin\cknfast.dll”

or on Solaris or Linux:
crypto_providers 
“pkcs11v2,/opt/nfast/toolkits/pkcs11/libcknfast.so”
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2. Modify the existing line in each of installed-dir/LogServer/conf/islog.conf, 
installed-dir/CmpServer/conf/icmpserver.conf, and 
installed-dir/WebServer/conf/server.conf, to specify the location of the 
PKCS #11 library.
For example, on Windows:
crypto_providers=“pkcs11v2,c:\nfast\bin\cknfast.dll”

or on Solaris or Linux:
crypto_providers=
“pkcs11v2,/opt/nfast/toolkits/pkcs11/libcknfast.so”

3. Stop and restart Certificate Manager services.

RSA Certificate Manager Installation

If nCipher hardware and server software are installed before Certificate Manager, the 
fact that nCipher support is available is determined during installation. You must 
initialize the smart card before you begin the Certificate Manager installation. See 
“Initializing nCipher Smart Cards” on page 86.

Important: Initialize the nCipher smart card with a passphrase.

For Solaris or Linux platforms, you must install Certificate Manager by the “root” 
user or by a user belonging to the nfast user group to allow operation with nCipher 
hardware.

Adding nShield or netHSM Support to an Existing 
RSA Certificate Manager Installation

To add smart card support to an existing Certificate Manager installation that does not 
currently use smart cards, you do not need to reinstall Certificate Manager.

To add nCipher smart card support to an existing installation:

1. Install the nCipher hardware and server software as described in previous 
sections. Make sure the nFast server is running.

2. Initialize a smart card and insert it into the reader.

3. Stop and restart the Certificate Manager services.

nCipher Failover

The failover feature of nCipher HSMs is supported with the following constraints:

• The Operator Card Set (OCS) used by Certificate Manager must be created as an 
MofN card set with N greater than or equal to the number of modules taking part 
in the failover configuration. For example, if your configuration has two HSMs, 
you must use a card set of two or more cards since you must log in to both HSMs 
at the same time.

• If cards must be inserted at the same time, all cards in the card set must have the 
same passphrase.
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• All Certificate Manager server keys must be software-based. If server keys are not 
software-based, you will not be able to access the Certificate Manager Web 
Servers (that is, the Certificate Manager Administration Server and the 
Enrollment Server). (This is due the manner in which the server keys are loaded 
by SSL-C at startup.)

• During Certificate Manager startup (when prompted to log in by entering the 
nCipher PIN), ensure that a card from the cardset is inserted in each module that is 
part of the failover configuration.

• After an nCipher HSM has failed over, you must restart Certificate Manager 
services and log into the card set after the failed nCipher HSM becomes 
operational again.

For more information on the nCipher HSM failover feature, see the appropriate 
nCipher user guide.

Recovery Features

All of the following recovery options require that the recovery option must have been 
enabled when creating the Security World:

Loss of smart card. To recover from the loss of an nCipher smart card, you can 
use KeySafe or the roc or rac command to replace any lost smart card. If you use 
netHSM, you can alternatively use the netHSM front panel. For instructions, see 
“Replacing Operator Card Sets” or “Replacing the Administrator Card Set” in the 
appropriate nCipher administrator guide. For the replacement card to work with 
the existing CAs or servers that use the original smart cards:

• Name the replacement card set the same name as the original
• Clear and remove the old card set from the Security World

Note: If you initialized the token using ckinittoken from the nCipher PKCS #11 
library version 1.5 or earlier, see “Replacing Operator Card Sets” in the nCipher 
administrator guide.

Loss of hardware. You must replace the actual hardware module (nShield or 
netHSM). After replacing the nCipher hardware, you must recreate the Security 
World using the new-world command, as documented in “Adding a Module to 
the Security World” in the appropriate nCipher user guide. If the replacement 
module had been used with another Security World, then you must initialize that 
module using the initunit command before using new-world.

Use this procedure to move the Security World from one machine to another, 
including across platforms.

Loss of hard drive data. If files containing the Security World data are lost (for 
example, /kmdata/ directory), restore the files from backup. Any data created 
since the last backup will be lost. If the complete nCipher software installation is 
damaged or lost, follow the procedure referred to for loss of hardware, provided a 
backup of the Security World data exists.
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Useful nCipher Commands

• enquiry—confirms versions of server software and module firmware

• ckcheckinst—confirms the nCipher PKCS #11 library version and determines the 
label of any cards inserted in the reader

• nfkminfo—obtain information about the Security World, that is, whether 
recovery option is enabled

Using nCipher Smart Cards with RSA Certificate Manager API

When using nCipher smart cards with Certificate Manager API sample programs, you 
must define the smart card PROVIDER_NAME. The definition is as follows:

PROVIDER_NAME “XCSP nCipher Native”
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SafeNet Luna CA3 and Luna SA

Introduction

Luna CA3 and Luna SA are Public-Key Cryptographic Standard #11 (PKCS #11) 
compliant hardware-based security products that safeguard digital key management 
by protecting Certificate Manager keys in a hardware device rather than in software 
on the host computer. Luna CA3 and Luna SA provide the RSA Digital Certificate 
Solution with the highest level of security for CA key management and provide 
assurance that CA keys will not be compromised by outside intruders, viruses, 
inadvertent erasure, or system-failure complications. 

Luna CA3 and Luna SA offload sensitive cryptographic processing, key generation, 
storage, signing, and verification from Certificate Manager using a standardized 
interface called “Cryptoki.” Certificate Manager and Certificate Manager API utilize 
the secure storage and functionality of the libraries provided in the “Chrystoki” API to 
keep private and sensitive CA keys safe from compromise. Luna CA3 and Luna SA 
offer added protection for Certificate Manager keys with Luna Key Cloning. Luna 
Key Cloning allows CA keys to be securely backed up from one CA server to another 
in an encrypted format. 

The Luna CA3 is a FIPS 140-1 Level 3 compliant key management device. This 
certification is achieved with the use of a highly secure Pin Entry Device (PED) in 
concert with the reader and token hardware.

Manufacturer: SafeNet Inc.

Web site: www.safenet-inc.com
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Certificate Manager and Certificate Manager API support Luna-based cryptographic 
operations. Certificate Manager supports the use of Luna CA3 or Luna SA on 
Windows, Solaris, and Linux platforms. The following SafeNet configurations are 
recommended with RSA Certificate Manager 6.9.

Functionality

Key Pair Generation 

Certificate Manager and Certificate Manager API can create keys on tokens. 
Luna CA3 and Luna SA support key generation for varying key lengths in RSA and 
DSA key pairs.

RSA: 1024 bits, 2048 bits, 4096 bits 

DSA: 512 bits, 1024 bits, 2048 bits

Key Storage

Certificate Manager and Certificate Manager API support the storage of 
cryptographic keys on the token.

Platform Reader
Token 
Firmware

Token
PED 
Firmware

Drivers

Microsoft Windows 
Server 2003

Microsoft Windows 
Server 2008

Sun Solaris 10

Luna Dock 3.97 Luna CA3 1.6.2 8.0

Red Hat Enterprise 
Linux 4, 5, or 5.5

SUSE Linux 
Enterprise Server 11

Luna Dock 3.4 Luna CA3 1.6.2 3.1-1

Microsoft Windows 
Server 2003

Microsoft Windows 
Server 2008

Sun Solaris 10

Red Hat Enterprise 
Linux 4, 5, or 5.5

SUSE Linux 
Enterprise Server 11

n/a 4.6.7 Luna SA n/a n/a
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Signing with Keys

Certificate Manager and Certificate Manager API support the usage of keys on Luna 
tokens for signing operations. 

MofN Signing with Keys

Certificate Manager and Certificate Manager API support the usage of keys on 
Luna CA3 tokens for MofN signing operations. RSA has not tested MofN signing on 
Luna SA tokens.

Certificate Authority Creation

Certificate Manager and Certificate Manager API support the creation of CAs with 
private keys stored on the token.

Certificate Signing

Certificate Manager and Certificate Manager API support certificate signing for CA 
and end-entity certificates via a signing operation on the token itself. 

Revocation List Signing

Certificate Manager and Certificate Manager API support the signing of revocation 
lists using CA keys stored on the token.

Configuration of Luna CA3

Luna CA3 and the Luna PED

The Luna CA3 token requires the use of the Luna PIN Entry Device (PED). The Luna 
PED passes PINs to the token via a direct data port into the Luna Dock. This 
requirement has allowed the Luna CA3 token to achieve FIPS 140-1 Level 3 
validation. Datakeys, along with a regular PIN entered on the PED, are used for 
accessing token functionality. Datakeys are inserted into the Luna PED to log onto the 
token.
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Description of Datakeys

A number of datakeys are used with the PED. Each key is color coded and has a 
specific purpose.

Token Accounts

Luna tokens have two accounts: Security Officer and User. The security officer 
account is used for configuring your token and setting up the user account. It does not 
have access to view any private keys stored on the card. A security officer must be 
created when a token is initialized before a User PIN can be established. The 
Certificate Manager Administrator uses the Luna user account to access the data 
stored on the token, including the public and private keys. The user account is also 
used when cloning tokens. It has full access to all data stored on the token, including 
public and private keys. 

Luna tokens use PINs to secure access to a token. Tokens have both a user PIN and a 
security officer PIN. Luna CA3 tokens are also protected by Datakeys.

By default, PINs have a minimum length of four characters and a maximum length of 
48 characters. The default is set in the Token Policy Vector (TPV) and can be viewed 
using the SafeNet Lunadiag utility, option 7.

When you initialize a token, you must provide new user and security officer PINs. 
Whenever you perform signing operations or any other action with 
Certificate Manager that requires the entry of a PIN, only the user PIN is requested.

Luna Token Labels

Token labels are a name that you attach to a token to help you organize your tokens 
and keep track of what each one is used for. Labels are defined when the token is 
initialized, and can only be changed by re-initializing the token. If you are using more 
than one token with your Certificate Manager installation at the same time, each token 
must have a distinct label.

Grey This key is only used when initializing the token. By protecting this 
key, you can prevent accidentally (or maliciously) re-initializing the 
token.

Red This key is used in cloning.

Blue This is the security officer key and should not be required for 
day-to-day operations, therefore it should be protected along with the 
red and grey keys.

Black This is the user key and is required to create new key pairs and access 
private keys on the token.

Green These keys are used for MofN operations.
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Cryptoki Model

Luna tokens implement public key cryptography according to the PKCS #11 standard. 
The cryptographic token interface follows this standard, which mandates the Cryptoki 
model. The Cryptoki model introduces a number of logical abstractions to formalize 
token operations and management. The following points are important when using 
Luna tokens with Certificate Manager:

• The Cryptoki model uses the idea of a slot to generalize addressing.

• Any Cryptoki devices in a computer can be addressed via their slot number. 

• Operations on tokens take place in the context of sessions, which can be opened or 
closed. Per-token sessions are opened on a particular token via the slot number 
(one session per token). Operations on the token are logically separated into two 
types according to the privilege level of the session.

• Administrative operations must be performed by the security officer. Normal 
operations, such as those performed by Certificate Manager, are performed as the 
user. Both types of operations are secured via unique PINs or passwords. A 
security officer must be created when a token is initialized, and before a User PIN 
can be established.

Installing Luna Dock

Install the SafeNet hardware and software for Windows, Solaris, or Linux using the 
Safenet Luna Token Install Guide (InstGd.pdf) on the SafeNet Luna CD.

Installing/Upgrading Luna Drivers

Install the SafeNet Luna Drivers for Windows, Solaris, or Linux using the Safenet 
Luna Token Install Guide.

Getting Token Information

Token information can be retrieved using the Enabler utility described in Chapter 2 of 
the Safenet Luna Token User Guide (TkGd.pdf) on the SafeNet Luna CD.

Upgrading Luna Firmware

If you have new token hardware, you should have the correct version of the firmware. 
If you are unsure, you can check your firmware version using the Lunadiag utility 
provided on the SafeNet Luna CD.

1. Run Lunadiag.exe from the \Luna directory.

2. Choose option 4, Read Firmware Level.
The version number is displayed.

If you do not have the correct firmware, contact RSA Customer Support through 
SecurCare Online.
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Initializing Luna Tokens for Use with RSA Certificate Manager

Before you begin installation of RSA Certificate Manager, use the Enabler utility to 
initialize the Luna token. Initialization of Luna tokens using the Enabler utility can be 
found in Chapter 2 of the SafeNet Luna Token User Guide.

During initialization, Enabler asks if you want to use MofN. If you select Yes, 
Enabler prompts for the M and N values, and the PED prompts for green Datakeys to 
imprint them with secret shares.

Note: If you are using more than one token with Certificate Manager, each token must 
have a different label.

If you have already installed Certificate Manager and want to initialize a new token, 
for Certificate Manager or for cloning, use the Enabler utility.

RSA Certificate Manager Installation

During the installation of Certificate Manager, Luna token support can be added if 
available. You must install the Luna hardware, drivers, and firmware before you 
install Certificate Manager.

Adding Luna CA3 Support to an Existing RSA Certificate Manager

You do not need to re-install Certificate Manager to add token support to an existing 
installation that does not use tokens.

To add token support to an existing installation:

1. Install the Luna hardware, drivers, and firmware as described in the previous 
sections.

2. Initialize a token and insert it into the reader.

3. Modify the existing line in the installed-dir/Xudad/conf/xudad.conf file to 
specify the location of the Luna library.
For example, on Windows:
crypto_providers 
“pkcs11v2,C:\Program Files\luna\cryptoki.dll”

or on Solaris or Linux:
crypto_providers “pkcs11v2,/usr/lib/libcrystoki2.so”

4. Stop and restart Certificate Manager services.
A: Cryptographic Hardware Interoperability 97



RSA Certificate Manager 6.9 Installation Guide
Luna CA3 Configuration for Security

Luna CA3 can be configured to different security levels, permitting inclusion into a 
company’s security and operating requirements. These requirements range from the 
most secure where the system can be autostarted, but signing cannot take place 
without someone present, down to a level where the system can be autostarted and 
conduct signings. 

• High Security
The most secure configuration uses the Datakeys and a user PIN when initializing 
the token. The Datakeys should be kept separate from the token as they are only 
used when a signing takes place. A signing requires both the Datakey and the 
person with knowledge of the user PIN. 

Autostart of Certificate Manager is possible under this configuration by 
modifying the setpin directive in the xudad.conf file:

setpin slot=x PromptEveryTime

where x is the slot number where the token resides.

Optionally, the token can be removed from the slot and stored in a secure location, 
and only inserted when a signing operation is required. No setpin directive 
modification is required in this case.

• Moderate Security
If it is permissible to relax security to some extent and autostart is not required, a 
session can be established with the token at startup that allows unattended signing 
to take place. The token is initialized in the same manner as for “High Security”. 
To allow establishment of the session, the Datakey and the person with knowledge 
of the user PIN must be present when Certificate Manager is started. This option 
does not allow, at this time, for the automatic scheduling of backups, that is, 
automatically shutting down Certificate Manager, backing up, and automatically 
restarting Certificate Manager.

• Relaxed Security
If it is necessary to autostart Certificate Manager with signing capabilities, the 
Luna CA3 token is initialized with no user PIN and left in the reader with the 
Datakey. There is a downside to this configuration: the private keys on the token 
are now no more secure than the physical security of your reader. 

Under this configuration, you modify the setpin directive in the xudad.conf file:

setpin slot=x UsePED

where x is the slot number where the token resides.

A final configuration possibility is to use different levels of security for different 
tokens. You could use two tokens for your system. Keys which require the most 
security and perform few actual signing operations could be set up using the “High 
Security” option. Keys which do not require as much security and are required for 
day-to-day signing operations could be set up using the “Moderate Security” or 
“Relaxed Security” options (depending on your autostart requirements).
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Failed Login Attempts

By default, the user is allowed ten (10) successive failed login attempts and the 
security officer is allowed three (3) successive failed login attempts.

This default is also set in the Token Policy Vector (TPV) and can be viewed by using 
the Lunadiag utility, option 7.

Important: If the user surpasses the number of allowed failed login attempts, all of the 
information on the token that Certificate Manager uses is lost. If the failures occurred 
when entering the user’s PIN, the security officer must log into the token and initialize 
the user PIN. If the failures occurred when entering the security officer’s PIN, the 
token must be re-initialized.

Recovery Features

With Luna CA3 tokens, all of the relevant information is stored on the token and is 
protected by the datakeys. If a failure occurs that is connected with any part of the 
HSM (for example, hard drive failure, reader failure, or Luna reader device), you must 
reinstall the software and/or hardware and continue to use the token and datakeys as 
before. 

Loss of Token

It is highly recommended that you clone all tokens and keep the clones up to date in 
the event a token is lost. This allows operations to continue. Cloning instructions can 
be found in Chapter 5 of the SafeNet Luna Token User Guide.

Note: Cloning completely overwrites any user data currently on the destination token. 
Ensure there is no desired information on the destination token.

When performing cloning, remember these three points:

• For Luna CA3 cloning, the source token and the cloned token must share the same 
cloning vector (contained on the red key). This is set up when initializing the 
destination token.

• Cloning must be performed when logged onto both tokens as the user, not the 
security officer. The security officer does not have permission to read the private 
key information on the tokens.

• The destination token must be initialized before you clone for the first time.

Designate one token as the master and make all changes to that token and then 
reclone. If two tokens that are supposed to be clones are separately changed (i.e. create 
new CA), there is no way to sync the two tokens up again.

Note: Unlike previous cloning practices, the Enabler clones the entire token. You 
cannot clone individual elements.
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Using Cloned Tokens

If the cloned token has a different label than the source token, you can modify the 
Certificate Manager database to search for key information for token-based CAs or 
revocation list signers from the cloned token with the new label. For instructions, see 
“Updating Token ID of Luna-Based CAs” in the Administrator’s Guide.

Loss of Luna CA3 Datakeys

To protect against the loss of a Luna CA3 datakey, you should make multiple copies 
when initializing the token. Initialization of Luna CA3 tokens can be found in 
Chapter 2 of the SafeNet Luna Token User Guide. RSA recommends that you make a 
backup of the red (if you want to clone tokens), blue, black, and green keys and store 
them in a safe location. You cannot make additional keys after initialization is 
complete. If backups are needed after initialization, a second token would need to be 
initialized with the desired keys and then used to clone the original token.

Using Luna Tokens with RSA Certificate Manager API

When using Luna tokens with Certificate Manager API sample programs, you must 
define the token PROVIDER_NAME, PROVIDER_LIBRARY, and 
PROVIDER_TYPE. The definitions are as follows:

Configuration of Luna SA

Configure the Luna SA client, following the instructions in “Setting up Network 
Trusted Link” under “Configuration” in the Luna SA 4.3 Help. 

After you configure the Luna SA client, follow the instructions in the following 
sections to configure the Luna SA client with the Luna SA HSM. If the Luna SA HSM 
is configured with high availability, see the Luna SA documentation for instructions to 
configure the client with the Luna SA HSM server.

PROVIDER_NAME SafeNet 

Note: If you intend to use an older Chrysalis HSM, the 
provider name should be “Chrysalis-ITS, Inc.”

PROVIDER_LIBRARY The location of the provider’s library. 

On Windows, the default installed location for the 
library is C:\Program Files\Luna\cryst201.dll.

On Solaris and Linux, the default installed location for 
the library is /usr/lib/libcrystoki2.so.

PROVIDER_TYPE XUDA_CSP_PKCS11V2
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Import the Luna SA Server Certificate into the Client 

To import the server certificate into the client: 

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed. The default directory is C:\Program Files\LunaSA\. 

2. Securely transfer the server.pem file from the Luna SA, using the Chrysalis 
Transfer Program (ctp) utility. Type:

ctp admin@myLunaSA3:server.pem .

Note: The dot (.) at the end of the command indicates that the resulting file is 
placed in the current directory.

3. Verify that the server certificate was imported into the 
LunaSA-installation-directory\cert\server directory on the client.

Register the HSM Server Certificate with the Client 

You must register the server certificate with the client so that the client can create a 
secure connection with the HSM (the server).

To register the server certificate with the client:

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed.

2. Register the server certificate using the vtl utility. Type:

vtl addServer -n <LunaSAhostname-or-IPaddress> 
-c server.pem

Create a Client Certificate

To create a certificate and private key for the client:

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed.

2. Create a certificate using the vtl utility. Type: 

vtl createCert -n <clientHostname>

Note: The client hostname is case sensitive.

3. Verify that the certificate file, clientHostname.pem, and the key file, 
clientHostnameKey.pem, were created in the 
LunaSA-installation-directory\cert\client directory. 

After the createCert command, the vtl utility gives the full pathname to the certificate 
and key files that were generated.
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Export the Client Certificate to the Luna SA 

To export the client certificate to the Luna SA:

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed.

2. Export the client certificate to the Luna SA HSM, using the ctp utility. Type:

ctp cert\client\clientHostname.pem 
admin@<serverhostname-or-IP>:/ 

When prompted, enter the password of the Luna SA server administrator.

Register the Client Certificate to an HSM Partition

You must be connected to the HSM server (the Luna SA) and logged in as “admin”.

To register the client certificate with the server:

From the Luna command shell, type:

lunash:> client -register -client <client-name> -hostname 
<clientHostname> -installcert clientHostname.pem

where <client-name> is any string that allows you to easily identify this client. The 
client certificate filename is the same as the client hostname.

Assign a Client to a Server Partition

You must be connected to the HSM server (the Luna SA) and logged in as “admin”.

To assign the registered client to the HSM partition: 

From the Luna command shell, type:

lunash:> client assignPartition -client <client-name> 
-partition <partition-name>

Update the Luna SA Backup Token Firmware

If you update the appliance, you should update any Backup tokens. For instructions, 
see “Backup and Restore” under “Administration and Maintenance” in the 
Luna SA 4.3 Help.

RSA Certificate Manager Installation

During the installation of Certificate Manager, Luna token support can be added if 
available. You must install the Luna hardware, drivers, and firmware before you 
install Certificate Manager.
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Adding Luna SA Support to an Existing RSA Certificate Manager

You do not need to re-install Certificate Manager to add token support to an existing 
installation that does not use tokens.

To add token support to an existing installation:

1. Install the Luna hardware, drivers, and firmware as described in the previous 
sections.

2. Initialize a token and insert it into the reader.

3. Modify the existing line in the installed-dir/Xudad/conf/xudad.conf file to 
specify the location of the Luna library.
For example, on Windows:
crypto_providers 
“pkcs11v2,C:\Program Files\LunaSA\cryptoki.dll”

or on Solaris or Linux:
crypto_providers “pkcs11v2,/usr/lunasa/lib/libCryptoki2.so”

4. Modify the existing line in each of installed-dir/LogServer/conf/islog.conf, 
installed-dir/CmpServer/conf/icmpserver.conf, and 
installed-dir/WebServer/conf/server.conf, to specify the location of the Luna 
library. 
For example, on Windows:
crypto_providers=
“pkcs11v2,C:\Program Files\LunaSA\cryptoki.dll”

or on Solaris or Linux:
crypto_providers=“pkcs11v2,/usr/lunasa/lib/libCryptoki2.so”

5. Stop and restart Certificate Manager services.

Using Luna Tokens with RSA Certificate Manager API

When using Luna tokens with Certificate Manager API sample programs, you must 
define the token PROVIDER_NAME, PROVIDER_LIBRARY, and 
PROVIDER_TYPE. The definitions are as follows:

Additional Information

For further details on PKCS #11 (the RSA PKCS #11 FAQ), go to 
www.rsa.com/rsalabs/node.asp?id=2133.

PROVIDER_NAME SafeNet, Inc.

PROVIDER_LIBRARY The location of the provider’s library. 

On Windows, the default installed location for the 
library is C:\Program Files\LunaSA\cryptoki.dll.

On Solaris and Linux, the default installed location for 
the library is /usr/lunasa/lib/libCryptoki2.so.

PROVIDER_TYPE XUDA_CSP_PKCS11V2
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B Uninstalling RSA Certificate Manager

This appendix describes how to uninstall the RSA Certificate Manager software.

On Windows Server 2003

CAUTION: Removing Certificate Manager directories removes all information 
relating to your PKI. You may want to back up these directories before uninstalling 
Certificate Manager.

To uninstall RSA Certificate Manager:

Note: If you have more than one installation of Certificate Manager on the same 
machine, a number is added to the service names of subsequent installations. For 
example, [02] is added to the end of each service name for the second installation.

1. Stop all Certificate Manager services:

a. Click Start > Programs > Administrative Tools > Services.

b. From the Services list, select RSA CM 6.9 build 551 (Administration) and 
click Stop.

c. From the Services list, select RSA CMP Server 6.9 build 551 and click 
Stop.

d. From the Services list, select RSA CM 6.9 build 551 (Secure Directory) and 
click Stop.
The Secure Directory Server is required for the Administration Server and the 
CMP Server to operate. If you attempt to stop the Secure Directory Server 
before the Administration and CMP Servers, all three servers stop.

e. From the Services list, select RSA Secure Logging Server 6.9 and click 
Stop.

f. Click Close to close the Services dialog box.

2. Click Start > Settings > Control Panel > Add or Remove Programs.

3. Select RSA CM 6.9 build 551 (Secure Directory) and click Change/Remove.

4. Select RSA CM 6.9 build 551 (Administration) and click Change/Remove.

5. Select RSA CMP Server 6.9 build 551 and click Change/Remove.

6. Select RSA Secure Logging Server 6.9 and click Change/Remove.

Note: You can also uninstall the Installation Servers in the same manner. 

7. Click OK to close the Add or Remove Programs dialog box.
8. Go to \installed-dir and manually delete the installation directory.
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On Windows Server 2008

CAUTION: Removing Certificate Manager directories removes all information 
relating to your PKI. You may want to back up these directories before uninstalling 
Certificate Manager.

To uninstall RSA Certificate Manager:

Note: If you have more than one installation of Certificate Manager on the same 
machine, a number is added to the service names of subsequent installations. For 
example, [02] is added to the end of each service name for the second installation.

1. Stop all Certificate Manager services:

a. Click Start > Programs > Administrative Tools > Services.

b. From the Services list, select RSA CM 6.9 build 551 (Administration) and 
click Stop.

c. From the Services list, select RSA CMP Server 6.9 build 551 and click 
Stop.

d. From the Services list, select RSA CM 6.9 build 551 (Secure Directory) and 
click Stop.
The Secure Directory Server is required for the Administration Server and the 
CMP Server to operate. If you attempt to stop the Secure Directory Server 
before the Administration and CMP Servers, all three servers stop.

e. From the Services list, select RSA Secure Logging Server 6.9 and click 
Stop.

f. Click Close to close the Services dialog box.

2. Click Start > Control Panel > Programs > Programs and Features.

3. Select RSA CM 6.9 build 551 (Secure Directory) and click Uninstall/Remove.

4. Select RSA CM 6.9 build 551 (Administration) and click Uninstall/Remove.

5. Select RSA CMP Server 6.9 build 551 and click Uninstall/Remove.

6. Select RSA Secure Logging Server 6.9 and click Uninstall/Remove.

Note: You can also uninstall the Installation Servers in the same manner. 

7. Close the Programs and Features dialog box.
8. Go to \installed-dir and manually delete the installation directory.
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On Solaris or Linux

CAUTION: Removing Certificate Manager directories removes all information 
relating to your PKI. You may want to back up these directories before uninstalling 
Certificate Manager.

1. Change directories to the directory where you installed Certificate Manager.

2. At the command prompt, type:

./STOP

3. Delete the installed Certificate Manager file system directories.

Note: To uninstall the installation servers, delete the directories /installed-dir/ids/ 
and /installed-dir/iws/.
B: Uninstalling RSA Certificate Manager 107





RSA Certificate Manager 6.9 Installation Guide
C Media Verification

Media verification enables you to verify the integrity of the shipped product. You can 
verify that the distribution media has not been altered since it was signed by RSA.

Media verification is a two-step procedure. The first step is to validate the media. A 
second, optional step, if you want a higher degree of assurance, is to validate the 
verification certificate and the media verification utility.

Validating the Media

To validate the distribution media:

1. At the command prompt, change directories to the top directory of the product 
CD. 

2. Run the media verification utility from the top directory of the product CD. 
Depending on your platform, do one of the following:

• On Windows, type:

.\Windows\Utils\mediaverify.exe .

• On Solaris, type:

./Solaris/Utils/mediaverify .

• On Red Hat Linux, type:

./RH_Linux/Utils/mediaverify .

• On SUSE Linux, type:

./SuSE_Linux/Utils/mediaverify .
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3. Check the success message at the end of the output and verify that the media 
verification utility did not report any errors.
If the verification is successful, you see output like the following example (output 
varies depending on the content of the CD).

If there are any errors, consider your distribution to be suspect. Contact 
RSA Customer Support. For a list of error messages, see the Administrator’s 
Guide.

Validating the Certificate and the Utility

Before you can validate the verification certificate and the media verification utility, 
you need to obtain the following from RSA:

• The verification certificate

• The MD5 code of the media verification utility for your platform (Windows, 
Solaris, or Linux)

To obtain the verification certificate and MD5 code:

1. Go to https://knowledge.rsasecurity.com/ and log on with your user name and 
password.

2. Under Browse by Product Family, click RSA Digital Certificates.
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3. On the Product Documentation tab, click RSA Certificate Manager 6.9 Media 
Validation Utilities.

4. Download the verification certificate and obtain the MD5 checksums for the 
verification certificate and the mediaverify utility for your platform.

If you want a higher degree of assurance, you can contact your account manager to 
obtain the verification certificate and the MD5 code.

Validating the Verification Certificate

To validate the verification certificate:

1. At the command prompt, change directories to the top directory of the product 
CD. 

2. Run the media verification utility with the -signercert and -verifycert options. 
Depending on your platform, do one of the following:

• On Windows, type:

.\Windows\Utils\mediaverify.exe -signercert certfile 
-verifycert yes .

• On Solaris, type:

./Solaris/Utils/mediaverify -signercert certfile 
-verifycert yes .

• On Red Hat Linux, type:

./RH_Linux/Utils/mediaverify -signercert certfile 
-verifycert yes .

• On SUSE Linux, type:

./SuSE_Linux/Utils/mediaverify -signercert certfile 
-verifycert yes .

where certfile is the name of the verification certificate that you obtained from 
RSA.

3. Verify that the media verification utility did not report any errors.
If the validation is successful, the media verification utility returns the message, 
“Specified certificate matches the certificate found in the media signature file.”
If the certificate specified by the -signercert option does not match the certificate 
used to sign the media, the media verification utility raises an error. If this 
happens, consider your distribution to be suspect. Contact RSA Customer 
Support.
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Validating the Media Verification Utility

You need an MD5 summing utility, such as OpenSSL (for Windows, Solaris, or Linux, 
depending on your platform) or the UNIX md5sum utility, to validate the media 
verification utility.

To validate the media verification utility: 

1. Run your MD5 summing utility on the media verification utility, mediaverify.exe 
in the Windows\Utils directory, or mediaverify in the Solaris/Utils, 
RH_Linux/Utils, or SuSE_Linux/Utils directory, depending on your platform.

2. Verify that the MD5 sum you calculate matches the one you obtained from RSA.
If they do not match, consider your distribution to be suspect. Contact 
RSA Customer Support. 
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D High Availability

If RSA Certificate Manager uses an external LDAP directory for data storage, you can 
install multiple instances of Certificate Manager that share a common data store—the 
LDAP directory. Therefore, if the LDAP directory provides fault tolerance and high 
availability, Certificate Manager can be made “highly available” for the issuance and 
revocation of certificates.

With the proper clustering or front-end application, Certificate Manager can also act 
as a cluster in this configuration with multiple instances of Certificate Manager 
simultaneously issuing certificates. You can configure RSA OneStep to load balance 
requests between multiple instances of Certificate Manager.

This appendix describes:

• LDAP Requirements

• High Availability Guidelines

• Installing and Configuring RSA Certificate Manager for High Availability

• Upgrading an RSA Certificate Manager High Availability Installation

LDAP Requirements

You need a standard LDAP directory to take advantage of the High Availability 
feature.

Certificate Manager uses its own separate branch to store data in the LDAP directory. 
The LDAP directory schema and index must be updated in order to store the 
Certificate Manager data. The schema determines the type of data the directory can 
store and how the data is organized. The indexes determine how the directory searches 
for and retrieves data.

The exact requirements for updating the schema and index depend on the LDAP 
directory used. RSA has created the appropriate schemas and tested each with the 
following leading LDAP directories:

• Sun ONE Directory Server 5.2

• Sun Java System Directory Server Enterprise Edition 6.3

• OpenDS Directory Server 2.2.1

• Microsoft Active Directory Application Mode (ADAM)

Contact RSA Customer Support for the appropriate files for your Certificate Manager 
configuration. RSA Professional Services can provide assistance if you are using a 
directory for which RSA Customer Support is unable to provide a schema.
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High Availability Guidelines

Use the following guidelines for Certificate Manager High Availability:

• RSA recommends that you select one Certificate Manager instance as the Primary 
and only administer Certificate Manager from this Primary instance. However, all 
instances in this configuration act independently and rely on a front-end 
application, such as a load balancer, to distribute certificate issuances and 
revocations.

• The use of an LDAP directory as a common database, shared by all instances of 
Certificate Manager, allows for the construction of revocation lists in one 
location. You can configure a Primary instance and one Secondary instance for 
CRL generation. Revocation lists are generated at the Primary. The Secondary 
monitors the Primary and, if the Primary fails, the Secondary takes over 
revocation list generation. For more information, see the Administrator’s Guide.

• You must back up your LDAP directory regularly. RSA recommends that your 
LDAP directory be highly available to provide true fault tolerance.

Note: Because a database plug-in is being used in this configuration of Certificate 
Manager instead of the default database, the Database Backup Configuration 
feature is not available and is not an option in the System Configuration 
Workbench.

• RSA recommends that you back up all Certificate Manager configuration files at 
the Primary instance.

• If the Primary instance of Certificate Manager fails, you must select another 
instance as the Primary, and administer Certificate Manager from this new 
Primary. You can restart Certificate Manager services at the failed Primary 
instance at any time.

Installing and Configuring RSA Certificate Manager for High 
Availability

Perform the following tasks to install and configure Certificate Manager and OneStep 
for high availability:

• Install the first instance of Certificate Manager and configure it to use the 
common database.

Note: Certificate Manager is configured to use a password or certificate to access 
the LDAP directory (see step 3 in “Setting Up the First Instance of 
RSA Certificate Manager”). You are responsible for implementing any other 
security precautions with respect to the LDAP directory.

• Set up the common database.
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• Install additional instances of Certificate Manager and configure them to use the 
common database.

• (Optional) Configure OneStep to provide a load-balancing feature. This prevents 
requests on the same certificate object from being processed by two different 
instances, and balances the load of request processing among the instances.

RSA Certificate Manager and the Common Database

All Certificate Manager instances within the group use a single LDAP directory as 
their database plug-in. To use this plug-in, you must:

• Modify plugin.conf to define the LDAP directory and the basedn where the 
Certificate Manager object classes are stored.

• Modify xudad.conf to configure Certificate Manager to use the plug-in for 
database storage.

• Run dataconvert to convert the LDAP Data Interchange Format (LDIF) data.

• Modify the schema of the target LDAP directory to support Certificate Manager.

Setting Up the First Instance of RSA Certificate Manager

To set up the first instance of Certificate Manager:

1. Install Certificate Manager or upgrade an existing installation.
For instructions, see Chapter 2, “Installing RSA Certificate Manager” or 
Chapter 3, “Upgrading RSA Certificate Manager.”

2. Stop all Certificate Manager services.

3. Modify plugin.conf to point to the LDAP directory:

a. Save a copy of /installed-dir/Xudad/plugin/ldap/plugin.conf.

b. Open plugin.conf in a text editor.

c. Enter LDAP directory information as follows and save changes to the 
configuration file:

binddn DN used (along with bindpw) for binding to the target 
directory through LDAP. binddn is not needed if using 
client-authenticated SSL.

bindpw Passphrase used (along with binddn) for binding to the 
target directory through LDAP. If the value prompt is 
included, Xudad prompts for the password when it starts. 
bindpw is not needed if using client-authenticated SSL.

Important: You can encrypt the password in this file using the procedure 
“Encrypting the PIN or Passphrase for Unattended Startup” in the Administrator’s 
Guide.

host Hostname of the target directory server.

port Port number of the target directory server.
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For example:

binddn cn=Directory Manager

bindpw 12345678

host production.mycompany.com

port 2345

basedn dc=na,dc=rsa,dc=net

logfile plugin.log

loglevel high

usessl 1

sslcertfile cert_filename

sslkeyfile key_filename

ssltrustedcertfile cert_filename

cipherlist RSA-FIPS-3DES-SHA

Note: RSA has only tested RSA-FIPS-3DES-SHA with Sun ONE Directory 
Server.

basedn DN of the branch (or subtree) where XUDA objects are 
stored.

logfile Filename of the trace log file either as an absolute path 
or as a relative path to Xudad/bin/.

loglevel Level of logging detail (off, low, or high).

usessl Use the SSL connection for communication with the 
remote directory server (0 = off, 1 = on).

sslcertfile Specifies a certificate, in PEM format, to use for client 
authentication.

sslkeyfile Specifies a keyfile, in PEM format, to use for client 
authentication.

Note: If the LDAP server requires SSL client authentication, you must specify both 
the sslcertfile and sslkeyfile directives. If the sslkeyfile directive is 
used and the key is encrypted or hardware-based, a passphrase or PIN may be 
needed at startup. You can set a passphrase or PIN using the sslpw directive or 
enter it when prompted at startup.

sslpw Set a passphrase or PIN for unattended startup. (For 
security reasons, RSA does not recommend this.) If not 
provided, a PIN is prompted for at startup.

Important: Safeguard the plugin.conf file if the passphrase is stored in this file.

ssltrustedcertfile Trusted certificates (one or more), in PEM format, to be 
used for SSL server authentication.

cipherlist A colon-separated list of ciphers that can be used to 
establish the SSL connection.
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4. Modify xudad.conf to use the database plug-in:

a. Save a copy of /installed-dir/Xudad/conf/xudad.conf.

b. Open xudad.conf in a text editor.

c. Locate the line:

database ldbm

and comment out this line by prepending a “#” character to the line.

d. Immediately below this line, insert the appropriate line for your platform.
On Windows, type:

database plugin 
“/installed-dir/Xudad/plugin/ldap/plugin.dll” 
plugin-conf 
“/installed-dir/Xudad/plugin/ldap/plugin.conf”

On Solaris or Linux, type:

database plugin 
“/installed-dir/Xudad/plugin/ldap/plugin.so” 
plugin-conf 
“/installed-dir/Xudad/plugin/ldap/plugin.conf”

e. Locate the line (it should be two lines below):

directory “installed-dir/Xudad/db”

and comment out this line by prepending a “#” character to the line.

f. Save the changes to the configuration file.

5. At the command prompt, type:

cd /installed-dir/Xudad/db/

6. To convert the Certificate Manager database to LDIF format, at the command 
prompt, type:

/installed-dir/Xudad/bin/ldbmcat -n id2entry.dbh > 
rcm.ldif

7. To convert the LDIF format so that you can use it with your directory server, at the 
command prompt, type:

/installed-dir/Xudad/plugin/ldap/dataconvert 
/installed-dir/Xudad/plugin/ldap/plugin.conf rcm.ldif 
rcm-converted.ldif

8. Restart all Certificate Manager services.
D: High Availability 117



RSA Certificate Manager 6.9 Installation Guide
Setting Up the Common Database

If your external LDAP directory is Sun ONE Directory Server, for instructions, see 
“Setting Up High Availability with Sun ONE Directory Server” on page 118.

If your external LDAP directory is Sun Java System Directory Server, for instructions, 
see “Setting Up High Availability with Sun Java System Directory Server” on 
page 120.

If your external LDAP directory is OpenDS, for instructions, see “Setting Up High 
Availability with OpenDS Directory Server” on page 121.

If your external LDAP directory is Microsoft ADAM, for instructions, see “Setting Up 
High Availability with Microsoft ADAM” on page 122.

Because revocation list entries can be very large, you must ensure that the LDAP 
requests are large enough to get and update revocation list entries correctly. For 
example, if each entry is about 100 bytes and the maximum number of revocation 
entries is 100,000, each LDAP request must be able to hold at least 10 MB of data. If 
you are using the Sun ONE Directory Server, RSA recommends that you modify the 
nsslapd-maxbersize (maximum message size) attribute. For more information, see the 
Oracle web site.

Setting Up High Availability with Sun ONE Directory Server

To configure Certificate Manager for High Availability with Sun ONE Directory 
Server:

• (Optional) Enable SSL-LDAP to protect communication between Certificate 
Manager and Sun ONE Directory Server.

• Update the schema and indexes of Sun ONE Directory Server, and import the 
converted Certificate Manager data into Sun ONE Directory Server.

Prerequisite

Obtain the latest version of the following files from RSA Customer Support:

• 69rcm-sun-one-schema.ldif

• 69rcm-sun-one-index.ldif

To enable SSL-LDAP on Sun ONE Directory Server:

1. Following the detailed instructions in the Sun ONE Directory Server 
documentation, obtain an SSL server certificate:

a. Generate a certificate request.

b. Submit the certificate request to your CA.

c. Install the SSL server certificate in Sun ONE Directory Server.
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2. Following the detailed instructions in the Sun ONE Directory Server 
documentation, trust the CA:

a. Trust the CA that issued the Sun ONE Directory Server SSL server certificate. 
In the Certificate Install Wizard, when prompted to select the purpose of 
trusting this CA, select Accepting connections to other servers (Server 
Authentication). If you are using client-authenticated SSL and this CA also 
issued the Certificate Manager SSL client certificate, also select Accepting 
connections from clients (Client Authentication).

b. If you are using client-authenticated SSL and the CA that issued the 
Certificate Manager SSL client certificate is a different CA than the one that 
issued the SSL server certificate, trust the CA that issued the Certificate 
Manager SSL client certificate. In the Certificate Install Wizard, when 
prompted to select the purpose of trusting this CA, select Accepting 
connections from clients (Client Authentication). If the CA that issued the 
SSL server certificate also issued the Certificate Manager SSL client 
certificate, you already trusted the CA in step a.

3. Following the detailed instructions in the Sun ONE Directory Server 
documentation, enable SSL on the Sun ONE Directory Server, ensuring:

• When you select cipher settings, in the Cipher Preferences dialog box, on the 
SSL 3.0 tab, select Triple-DES.

• When you select client authentication preferences, select either Allow client 
authentication or Require client authentication.

4. Enable SSL on Certificate Manager.
For instructions on installing the database plug-in and configuring it to use SSL, 
see “Setting Up the First Instance of RSA Certificate Manager” on page 115.

To update the Sun ONE schema and import the Certificate Manager data:

1. To update the schema, copy 69rcm-sun-one-schema.ldif into the Sun ONE 
Directory Server’s Server schema directory, 
/SunOne_install_directory/SUN/MPS/slapd_system_name/config/schema/
where system_name is the computer hostname.

2. Restart the directory server.

3. To update the indexes, import 69rcm-sun-one-index.ldif into the Sun ONE 
Directory Server:

a. Open the Sun ONE Server Console.

b. On the Servers and Applications tab, expand the tree. 

c. Double-click your directory server, Directory Server (system_name).

d. On the Tasks tab, click Import from LDIF.

e. Browse to 69rcm-sun-one-index.ldif and import it.

f. Restart the directory server.

4. To import the Certificate Manager data, repeat step 3 to import 
rcm-converted.ldif (created in step 7 of “Setting Up the First Instance of 
RSA Certificate Manager”) into the Sun ONE Directory Server.
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Setting Up High Availability with Sun Java System Directory Server

To configure Certificate Manager for High Availability with Sun Java System 
Directory Server:

• (Optional) Enable SSL-LDAP to protect communication between Certificate 
Manager and Sun Java System Directory Server.

• Update the schema and indexes of Sun Java System Directory Server, and import 
the converted Certificate Manager data into Sun Java System Directory Server.

Prerequisites

• Configure Directory Server Control Center to administer the directory server from 
the Web or Java UI.

• Obtain the latest version of the following files from RSA Customer Support:

– 69rcm-sun-one-schema.ldif

– 69rcm-sun-one-63-index.ldif

To enable SSL-LDAP on Sun Java System Directory Server:

1. Following the instructions in the Sun Java System Directory Server 
documentation, obtain an SSL server certificate:

a. Generate a certificate request.

b. Submit the certificate request to your CA.

c. Install the SSL server certificate in Sun Java System Directory Server.

2. Following the detailed instructions in the Sun Java System Directory Server 
documentation, trust the CA:

a. Trust the CA that issued the Sun Java System Directory Server SSL server 
certificate. In the Certificate Install Wizard, when prompted to select the 
purpose of trusting this CA, select Accepting connections to other servers 
(Server Authentication). If you are using client-authenticated SSL and this 
CA also issued the Certificate Manager SSL client certificate, also select 
Accepting connections from clients (Client Authentication).

b. If you are using client-authenticated SSL and the CA that issued the 
Certificate Manager SSL client certificate is a different CA than the one that 
issued the SSL server certificate, trust the CA that issued the Certificate 
Manager SSL client certificate. In the Certificate Install Wizard, when 
prompted to select the purpose of trusting this CA, select Accepting 
connections from clients (Client Authentication). If the CA that issued the 
SSL server certificate also issued the Certificate Manager SSL client 
certificate, you already trusted the CA in step a.

3. Following the instructions in the Sun Java System Directory Server 
documentation, enable SSL on the Sun Java System Directory Server, ensuring:

• When you select cipher settings, in the Cipher Preferences dialog box, on the 
SSL 3.0 tab, select Triple-DES.

• When you select client authentication preferences, select either Allow client 
authentication or Require client authentication.
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4. Enable SSL on Certificate Manager.
For instructions on installing the database plug-in and configuring it to use SSL, 
see “Setting Up the First Instance of RSA Certificate Manager” on page 115.

To update the Sun Java System schema and import the Certificate Manager 
data:

1. To update the schema, copy 69rcm-sun-one-schema.ldif into the Sun Java 
System Directory Server schema directory, instance-path/config/schema/, where 
instance-path is the path of the Directory Server.

2. Restart the directory server instance.

3. To update the indexes, import 69cm-sun-one-63-index.ldif into the Sun Java 
System Directory Server. At the command prompt, type:

$ ldapmodify -a -h host-name -p port -D “cn=Directory 
Manager” -w - -f “69rcm-sun-one-63-index.ldif”

4. To import the Certificate Manager data, rcm-converted.ldif (created in step 7 of 
“Setting Up the First Instance of RSA Certificate Manager”) into the Sun Java 
System Directory Server, at the command prompt, type:

dsconf import -h hostname -P port rcm-converted.ldif 
DN suffix

where:

• hostname is the directory server hostname.

• port is the secure port of the directory server.

• DN suffix is where Certificate Manager data is stored in the directory server.

5. (Optional) Register in the Directory Server Control Center to monitor the instance 
from the web interface.

Setting Up High Availability with OpenDS Directory Server

Prerequisite

Obtain the latest version of the following files from RSA Customer Support:

• 69rcm-sun-one-schema.ldif

• 69rcm-sun-one-index.ldif

To update the OpenDS schema and import the Certificate Manager data:

1. To update the schema, copy 69rcm-sun-one-schema.ldif to 
/OpenDS_install_directory/config/schema.

2. Restart the directory server.

3. To update the indexes, import 69rcm-sun-one-index.ldif into the OpenDS 
Directory Server. To import, do the following:

a. Open the OpenDS Server Console.

b. Under Directory Data, click Import LDIF.
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c. In the File to Import field, browse to 69rcm-sun-one-index.ldif.

d. For Import Type, select Append to Existing Data.

e. Click OK to import the file.

4. Restart the directory server.

5. To import the Certificate Manager data, import the rcm-converted.ldif file into 
the OpenDS Directory Server:

a. Open the OpenDS Server Console.

b. Under Directory Data, click Import LDIF.

c. In the File to Import field, browse to the rcm-converted.ldif file (created in 
step 7 of “Setting Up the First Instance of RSA Certificate Manager”).

d. For Import Type, select Append to Existing Data.

e. Under Data Inclusion Options, in the DNs to Include field, enter the 
BaseDN of the directory server.

f. Click OK to import the file.

6. Restart the directory server.

Setting Up High Availability with Microsoft ADAM

To configure Certificate Manager for High Availability with ADAM:

• Create an instance of ADAM, or use an existing installation of ADAM.

• Update the ADAM schema.

• Import the converted Certificate Manager data.

Note: By default, ADAM returns a maximum of 1000 records. You can change this 
number by changing the value of MaxPageSize in ADAM. For more information, see 
the ADAM documentation.

Prerequisite

Obtain the latest version of 69rcm-active-directory-schema.ldif from RSA Customer 
Support.

To install an ADAM instance and partition:

1. To open the ADAM Setup Wizard, run adamsetup.exe.
You can proceed only if you accept the Licence Agreement.

2. On the Installation Options page, select ADAM and administration tools.

3. Select A unique instance.

4. Give the instance a name, for example, RSA-CM.

5. Unless another application is using 389 and 636, accept the default ports.
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6. Select Yes, create an application directory partition and give it a name, for 
example, DC=rsa,DC=com.
This DN is the basedn you enter in the plugin.conf file in Certificate Manager.

7. Accept the default file locations.

8. Accept the default, Network service account, for permissions.

9. For ADAM administrators, select Currently logged on user.

10. Select Import the selected LDIF files for this instance of ADAM and add all 
the files to the schema.
You need these files to add users.

11. On the Ready to Install page, if the information is correct, click Next.

12. After installation, start ADAM ADSI Edit.

13. Configure the connections to this ADAM partition:

a. Highlight ADAM ADSI Edit. 

b. Select Action > Connect to.

c. Enter a connection name.

d. Leave the server name as localhost.

e. Unless you selected a different port during installation, accept the default port 
number of 389.

f. Select Distinguished name (DN) or naming context and enter the partition 
name, for example, DC=rsa,DC=com.
This DN is the basedn that you enter in the plugin.conf file in Certificate 
Manager.

g. Connect through the account of the currently logged-on user.

h. Click OK.

14. Create a container for users and create a new user to bind to ADAM using LDAP:

a. To create an organizational unit under the application directory partition, click 
Action > New > Object and select organizationalUnit.

b. Give the organizational unit a name. If you name it users, in the previous 
example, the DN is OU=users,DC=rsa,DC=com.

c. To create a user under the container, click Action > New > Object and select 
user.

d. Give the user a name. If you use the name CMAdministrator, in the previous 
example, the DN is CN=CMAdministrator,OU=users,DC=rsa,DC=com.
This is the binddn that you enter in the plugin.conf file in Certificate 
Manager.

15. Set the user’s password:

a. Right-click the user and select Reset password.

b. Enter and confirm the password.
This is the bindpw that you enter in the plugin.conf file in Certificate 
Manager.
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16. Activate the user’s account:

a. Right-click the user and select properties.

b. Select msDS-UserAccountDisabled in the list and click Edit.

c. Select False and click OK.

17. Make the user an ADAM administrator for this partition:

a. Click CN=Roles.

b. Right-click CN=Administrators and select Properties. In the previous 
example, the DN of the Administrators group is 
CN=Administrators,OU=users,DC=rsa,DC=com.

c. In the Attribute Editor, select the member attribute and click Edit.

d. Click Add ADAM Account.

e. Enter the DN of the user you want to make into the administrator. In the 
previous example, the DN of this user is 
CN=CMAdministrator,OU=users,DC=rsa,DC=com.

f. Apply the changes.

For further configuration details, refer to the ADAM documentation.

To update the ADAM schema:

1. Obtain the GUID for the schema partition:

a. Start ADAM ADSI Edit.

b. Highlight ADAM ADSI Edit.

c. Select Action > Connect to.

d. Enter a connection name, for example, schema.

e. Leave the server name as localhost.

f. Unless you selected a different port during installation, accept the default port 
number of 389.

g. Select Well-known naming context and, from the drop-down list, select 
Schema.

h. Connect through the account of the currently logged-on user.

i. Click OK.

j. Expand the new connection.
The schema naming context is the final entry in the DN 
CN=Schema,CN=Configuration,CN={GUID}. The DN looks similar to the 
following example: 
CN=Schema,CN=Configuration,CN={29A13F57-4526-4912-89B9-C13879
CA6280}.

k. Copy CN={GUID}.

2. Using the Start menu, navigate to the ADAM menu and select ADAM Tools 
Command Prompt.
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3. In the Command Prompt, type:

ldifde -i -f pathname\69rcm-active-directory-schema.ldif 
-s servername:portnumber -k -j . 
-c “dc=company,dc=com” “cn={GUID}”

where:

• pathname is the location where you stored the schema update file.

• servername is the name of the computer on which ADAM is installed.

• portnumber is the LDAP communications port of the ADAM instance.

• cn={GUID} is the data you copied in step 1, for example, 
CN={29A13F57-4526-4912-89B9-C13879CA6280}.

4. Press Enter.
When the file is imported, you see a confirmation message.

To import the converted Certificate Manager data:

1. Ensure that you have entered the ADAM partition name in the basedn in the 
plugin.conf file in Certificate Manager.

2. Using the Start menu, navigate to the ADAM menu and select ADAM Tools 
Command Prompt.

3. In the Command Prompt, type:

ldifde -i -f pathname\rcm-converted.ldif -s 
servername:portnumber -k -j .

where: 

• pathname is the location where you stored the converted data file.

• rcm-converted.ldif is the file created in step 7 of “Setting Up the First Instance 
of RSA Certificate Manager.”

• servername is the name of the computer on which ADAM is installed.

• portnumber is the LDAP communications port of the ADAM instance.

4. Press Enter. 
When the file is imported, you see a confirmation message.

Setting Up Additional Instances of RSA Certificate Manager

For each additional instance of Certificate Manager:

1. Install Certificate Manager.
For installation instructions, see Chapter 2, “Installing RSA Certificate Manager.”

2. Modify xudad.conf to use the database plug-in:

a. Save a copy of /installed-dir/Xudad/conf/xudad.conf.

b. Open xudad.conf in a text editor.
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c. Locate the line:

database ldbm

and comment out this line by prepending a “#” character to the line.

d. Immediately below this line, insert the appropriate line for your platform.
On Windows, type:

database plugin 
“/installed-dir/Xudad/plugin/ldap/plugin.dll” 
plugin-conf 
“/installed-dir/Xudad/plugin/ldap/plugin.conf”

On Solaris or Linux, type:

database plugin 
“/installed-dir/Xudad/plugin/ldap/plugin.so” 
plugin-conf 
“/installed-dir/Xudad/plugin/ldap/plugin.conf”

e. Locate the line (it should be two lines below):

directory “installed-dir/Xudad/db”

and comment out this line by prepending a “#” character to the line.

f. Save the changes to the configuration file.

3. Make the same changes to the plugin.conf file that you made for the first instance 
of Certificate Manager (see step 3 in “Setting Up the First Instance of 
RSA Certificate Manager” on page 115).

4. Copy the SSL certificate and key (respectively) from the following directories of 
the first instance of Certificate Manager to the corresponding directories of this 
instance:

• /installed-dir/Xudad/ssl/certs/ and 
/installed-dir/Xudad/ssl/private/

• /installed-dir/CmpServer/ssl/certs/ and 
/installed-dir/CmpServer/ssl/private/

• /installed-dir/LogServer/ssl/certs/ and 
/installed-dir/LogServer/ssl/private/

• /installed-dir/LogServer/sign/certs/ and
/installed-dir/LogServer/sign/private/

• /installed-dir/WebServer/ssl/certs/ and 
/installed-dir/WebServer/ssl/private/

Note: If you re-sign any of the SSL certificates, you need to copy them to the 
corresponding directory of the other instances.

5. Restart all Certificate Manager services.
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Configuring RSA OneStep

The addition of the following directives to /installed-dir/WebServer/OneStep/
conf/onestep.conf supports OneStep communications with many instances of 
Certificate Manager:

• capool directive

• statusfile directive

Note: These modifications do not affect how OneStep works in an environment with 
only one instance of Certificate Manager.

To set up OneStep to support communications:

1. Open the /installed-dir/WebServer/OneStep/conf/onestep.conf file at one 
instance of Certificate Manager in a text editor.

2. Locate the line:

capool 
<instance 1 hostname:port>;<instance 2 hostname:port>;...

and remove the prepended “#” at the beginning of the line.

3. Enter the hostname and port number of each Certificate Manager instance that you 
want to configure.

4. Locate the line:

statusfile onestep.status

and remove the prepended “#” at the beginning of the line. 
The onestep.status file contains the last Certificate Manager hostname and port 
number used. This file is modified automatically by OneStep.

Note: The onestep.status file must be created on a non-shared file system.

5. Save the configuration file.

Upgrading an RSA Certificate Manager High Availability Installation

Important: Do not perform any operations on any of the Certificate Manager 
installations or the external LDAP until the entire upgrade has been completed.

Upgrading the Primary Certificate Manager Installation

Follow this procedure to upgrade the Primary instance of multiple RSA Certificate 
Manager 6.6, 6.7, or 6.8 installations that target the same external LDAP directory. 
This procedure can also be used to upgrade a single RSA Certificate Manager 6.6, 6.7, 
or 6.8 installation that uses an external database.
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If you are moving an existing RSA Certificate Manager 6.9 installation, follow the 
instructions under “Moving RSA Certificate Manager 6.9 to Another Machine or 
Platform” on page 133.

To upgrade the Primary instance, the following tasks must be completed in the order 
presented:

• Create the upgrade package.

• Update the Sun ONE schema and index, or the ADAM schema.

• Complete the upgrade of Certificate Manager.

Creating the Upgrade Package

1. Back up the LDAP data.

2. Make sure that you have performed the necessary steps under “Preparing to 
Upgrade” on page 45, including backing up your Certificate Manager installation.

3. To create the upgrade package, do one of the following:

• On Windows, follow the instructions in “Creating the Upgrade Package on 
Windows” on page 47. 

• On Solaris or Linux, follow the instructions in “Creating the Upgrade Package 
on Solaris or Linux” on page 48.

Updating the LDAP Schema and Index

Before you complete the upgrade, you must update the schema and the index on Sun 
One Directory Server, Sun Java System Directory Server, or OpenDS Directory 
Server, or the schema on ADAM.

Prerequisite

You need the following files, which are available from RSA Customer Support:

• For Sun ONE Directory Server, 69rcm-sun-one-schema.ldif and 
69rcm-sun-one-index.ldif

• For Sun Java System Directory Server, 69rcm-sun-one-schema.ldif and 
69rcm-sun-one-63-index.ldif

• For OpenDS Directory Server, 69rcm-sun-one-schema.ldif and 
69rcm-sun-one-index.ldif

• For ADAM, depending on the version of Certificate Manager from which you are 
upgrading:

– 66to69rcm-active-directory-schema.ldif

– 67to69rcm-active-directory-schema.ldif

– 68to69rcm-active-directory-schema.ldif
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To update the Sun ONE schema and index:

1. Delete the Certificate Manager schema (67rcm-sun-one-schema.ldif or 
68rcm-sun-one-schema.ldif) from the Sun ONE Directory Server installation.

2. To update the schema, copy 69rcm-sun-one-schema.ldif into the Sun ONE 
Directory Server’s Server schema directory, 
/SunOne_install_directory/SUN/MPS/slapd_system_name/config/schema/, 
where system_name is the computer hostname.

3. Restart the directory server.

4. To update the indexes, import 69rcm-sun-one-index.ldif into the Sun ONE 
Directory Server:

a. Open the Sun ONE Server Console.

b. On the Servers and Applications tab, expand the tree. 

c. Double-click your directory server, Directory Server (system_name).

d. On the Tasks tab, click Import from LDIF.

e. Browse to the .ldif file and import it.

5. Restart the directory server.

To update the Sun Java System schema and index:

1. Delete the Certificate Manager schema, 68rcm-sun-one-schema.ldif, from the 
Sun Java System Directory Server installation.

2. Copy 69rcm-sun-one-schema.ldif into the Sun Java System Directory Server 
schema directory, instance-path/config/schema/, where instance-path is the path 
of the directory server.

3. Restart the directory server instance.

4. To update the indexes, import 69cm-sun-one-63-index.ldif into the Sun Java 
System Directory Server. At the command prompt, type:

$ ldapmodify -a -h host-name -p port -D “cn=Directory 
Manager” -w - -f “69rcm-sun-one-63-index.ldif”

To update the OpenDS schema and index:

1. Delete the Certificate Manager schema, 68rcm-sun-one-schema.ldif, from the 
OpenDS Directory Server installation.

2. Copy 69rcm-sun-one-schema.ldif to /OpenDS_install_directory/config/schema.

3. Restart the directory server.

4. To update the indexes, import 69rcm-sun-one-index.ldif into the OpenDS 
Directory Server. Open the OpenDS Server Console and follow these steps:

a. Under Directory Data, click Import LDIF.

b. In the File to Import field, browse to 69rcm-sun-one-index.ldif.

c. For Import Type, select Append to Existing Data.

d. Click OK to import the file.

5. Restart the directory server.
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To update the ADAM schema:

1. Obtain the GUID for the schema partition:

a. Start ADAM ADSI Edit.

b. Highlight ADAM ADSI Edit.

c. Select Action > Connect to.

d. Enter a connection name (for example, schema).

e. Leave the server name as localhost.

f. Unless you selected a different port during installation, accept the default port 
number of 389.

g. Select Well-known naming context and select Schema from the drop-down 
list.

h. Connect through the account of the currently logged-on user.

i. Click OK.

j. Expand the new connection. 
The schema naming context is the final entry in the DN, 
CN=Schema,CN=Configuration,CN={GUID}. The DN looks similar to the 
following example: 
CN=Schema,CN=Configuration,CN={29A13F57-4526-4912-89B9-C13879
CA6280}.

k. Copy CN={GUID}. 

2. From the Start menu, navigate to the ADAM menu and select ADAM Tools 
Command Prompt.

3. In the Command Prompt, type:

ldifde -i -f pathname\schemafile -s servername:portnumber 
-k -j . -c “dc=company,dc=com” “cn={GUID}”

where:

• pathname is the location where you stored the schema update file.

• schemafile is one of 66to69rcm-active-directory-schema.ldif, 
67to69rcm-active-directory-schema.ldif, or 
68to69rcm-active-directory-schema.ldif.

• servername is the name of the computer on which ADAM is installed.

• portnumber is the LDAP communications port of the ADAM instance.

• cn={GUID} is the data you copied in step 1, for example, 
CN={29A13F57-4526-4912-89B9-C13879CA6280}.

4. Press Enter. 
When the file is imported, you see a confirmation message.
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Completing the Upgrade of Certificate Manager

To complete the upgrade on the same machine:

• For Windows, follow the instructions in “Completing an Upgrade on Windows” 
on page 49.

• For Solaris or Linux, follow the instructions in “Completing an Upgrade on 
Solaris or Linux” on page 53.

To complete the upgrade on a different machine:

1. Copy the package.tar file to the new machine.

2. For Windows, do one of the following:

• If you are upgrading Certificate Manager to another machine with the same 
Windows operating system, complete the upgrade according to the 
instructions in “Completing an Upgrade on Windows” on page 49.

• If you are upgrading your operating system from Windows 2000 Server to 
Windows Server 2003 or Windows Server 2008 or from Windows 
Server 2003 to Windows Server 2008, upgrade the operating system first, then 
complete the upgrade according to the instructions in “Completing an 
Upgrade on Windows” on page 49.

• If you are upgrading Certificate Manager from a Windows machine to a 
Solaris or Linux machine, complete the upgrade according to the instructions 
in “Completing an Upgrade on Solaris or Linux” on page 53.

3. For Solaris or Linux, do one of the following:

• If you are upgrading Certificate Manager to another machine with the same 
operating system, complete the upgrade according to the instructions in 
“Completing an Upgrade on Solaris or Linux” on page 53.

• If you are upgrading Certificate Manager from a Solaris or Linux machine to a 
Windows machine, complete the upgrade according to the instructions in 
“Completing an Upgrade on Windows” on page 49.

Upgrading Additional Certificate Manager Installations

If you have multiple RSA Certificate Manager 6.6, 6.7, or 6.8 installations targeting 
one external LDAP directory:

1. Upgrade the Primary installation by following the instructions under “Upgrading 
the Primary Certificate Manager Installation” on page 127.

2. Upgrade each remaining installation using the following Windows, Solaris, or 
Linux procedure in conjunction with the information in Chapter 3, “Upgrading 
RSA Certificate Manager.”
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Upgrading Additional Installations on Windows

1. In the next RSA Certificate Manager 6.6, 6.7, or 6.8 installation that you want to 
upgrade, ensure that you have performed the necessary steps under “Preparing to 
Upgrade” on page 45.

2. In this installation, locate the plugin.conf file, which is stored by default in 
installed-dir\Xudad\plugin\ldap\.

3. Open plugin.conf in a text editor.

4. At the end of the file, add the directive:

primaryrcm 0

This directive prevents the upgrader from updating the external LDAP again.

5. Press Enter.

6. Save plugin.conf.

7. Follow the instructions in “Creating the Upgrade Package on Windows” on 
page 47 and “Completing an Upgrade on Windows” on page 49.

8. Repeat this procedure for each remaining Certificate Manager installation that you 
want to upgrade.

Upgrading Additional Installations on Solaris or Linux

1. In the next RSA Certificate Manager 6.6, 6.7, or 6.8 installation that you want to 
upgrade, ensure that you have performed the necessary steps as described in 
“Preparing to Upgrade” on page 45, including backing up Certificate Manager.

2. In this installation, locate the plugin.conf file, which is stored by default in 
installed-dir/Xudad/plugin/ldap/.

3. Open plugin.conf in a text editor.

4. At the end of the file, add the directive:

primaryrcm 0

This directive prevents the upgrader from updating the external LDAP again.

5. Press Enter.

6. Save plugin.conf.

7. Follow the instructions in “Creating the Upgrade Package on Solaris or Linux” on 
page 48 and “Completing an Upgrade on Solaris or Linux” on page 53.

8. Repeat this procedure for each remaining Certificate Manager installation that you 
want to upgrade.
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Moving RSA Certificate Manager 6.9 to Another Machine or Platform

1. In the RSA Certificate Manager 6.9 installation that you want to move, ensure that 
you have performed the necessary steps under “Preparing to Upgrade” on 
page 45, including backing up Certificate Manager.

2. Follow the instructions from step 2 under “Upgrading Additional Installations on 
Windows” on page 132 or “Upgrading Additional Installations on Solaris or 
Linux” on page 132.
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Glossary

Abstract Syntax Notation One (ASN.1)
Abstract Syntax Notation One (ASN.1) is an International Standards Organization 
(ISO) standard notation for defining the syntax of information data. It defines a 
number of simple data types and specifies a notation for referencing these types and 
for specifying values of these types.

ActiveX Control
ActiveX control is a software component that may be downloaded and installed 
automatically through a web browser, allowing web pages to utilize capabilities of the 
Windows operating system that they would ordinarily not have access to. ActiveX 
controls are typically signed with a digital certificate, allowing users to confidently 
establish the origin of the software before deciding to trust it.

Access Control Lists (ACL)
ACLs control who can access different parts of a system. In the RSA Digital 
Certificate Solution product suite, ACLs are used primarily to control who has access 
to files and directories on a web server.

Administration Server
A virtual web server that is a component of the RSA Certificate Manager and 
RSA Registration Manager Web Servers. The Administration Server is used by 
Administrators to manage Certificate Manager or Registration Manager via a web 
interface. The Administration Server requires client authentication. It also 
communicates securely with the Secure Directory Server.

Administrative CA
A CA created during RSA Certificate Manager installation. This CA signs the 
end-entity certificates for all RSA Certificate Manager Administrators, Vettors, and 
Auditors.

Administrative Certificate
An end-entity certificate issued to one of three Administrative types: Administrator, 
Vettor, and Auditor. RSA Certificate Manager Administrative certificates are signed 
by the Administrative CA; RSA Registration Manager Administrative certificates are 
signed by the CA of the Registration Manager initial target Jurisdiction.

Administrator
A person, possibly with an end-entity certificate, who has access to certain 
administration features through the Administration Server, which may include the CA 
Operations, Administrator Operations, and System Configuration Workbenches. 
Administrator tasks may include planning the PKI implementation, installing 
components of the RSA Digital Certificate Solution product suite, performing initial 
configuration, and managing the daily administration tasks.
The RSA Certificate Manager Administrator certificate is signed by the 
Administrative CA; the RSA Registration Manager Administrator certificate is signed 
by the CA of the Registration Manager initial target Jurisdiction.

Anonymity
The ability of participating entities to use public keys while revealing only that 
information that is pertinent to the situation.
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ARL
See Authority Revocation Lists.

ASN.1
See Abstract Syntax Notation One.

Attribute Certificate
A certificate that emphasizes the holder’s access rights and constraints. This is in 
contrast to identity certificates, which bind a distinguished name (DN) and a public 
key. Commonly, attribute certificates are issued with short validity periods and do not 
contain a public key value.

Auditor
A person with an end-entity certificate who has access to the auditor features on the 
Administration Server. Auditor tasks include viewing and managing the audit logs.
The RSA Certificate Manager Auditor certificate is signed by the Administrative CA; 
the RSA Registration Manager Auditor certificate is signed by the CA of the 
Registration Manager initial target Jurisdiction.

Audit Log
An XML-encoded tamper-resistant file generated by the Logging Server that details 
the success or failure of all PKI operations for which logging has been configured.

Authentication
Certificates are used to identify the author of a message or entity, such as a web server 
or client. People or applications who receive a certificate can verify the identity of the 
certificate owner and the validity of the certificate. This process is called 
authentication.

Authority Revocation List (ARL)
A list of CA certificates that have been revoked or suspended by a particular CA. You 
can use ARLs to check the status of CA certificates offline.

CA
See Certificate Authority.

CA Certificate
A certificate that identifies a CA. When a CA issues a certificate to a client, a server, 
or other entity, the CA private key signs the certificate. You can verify the signature 
using the public key in the CA certificate. See also root CA.

Certificate
Certificates verify the identity of an individual, organization, web server, or hardware 
device. They also ensure non-repudiation in business transactions, as well as to enable 
confidentiality through the use of public-key encryption. PKI uses three main kinds of 
certificates: CA certificates, server certificates (also referred to as SSL certificates), 
and end-entity certificates.

Certificate Authority (CA)
An entity that issues and manages certificates within a PKI. You create and manage 
CAs using a CA software application, such as RSA Certificate Manager.

Certificate Extension
See X.509 v3 Certificate Extension.
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Certificate Fingerprint
The MD5 of a DER-encoded certificate used to identify a certificate when setting 
LDAP and web server ACL rules.

Certificate ID
A certificate identifier used by RSA Certificate Manager to search for or label a 
certificate in the Secure Directory.

Certificate Management Protocol (CMP)
CMP (RFC 2510) is an Internet standard certificate management protocol that defines 
message syntax and semantics supporting many aspects of certificate creation and 
management. This includes registration, revocation, key update, key recovery, 
cross-certification, and many other features. This protocol provides an alternative to 
web-based certificate enrollment.

Certificate Policy (CP)
The conditions and limitations for the use of a digital certificate.

Certificate Profile
A set of extensions along with rules, constraints, and default values for the fields of 
the associated extensions. They are used in the vetting process, as well as to constrain 
and/or validate the information being entered into the certificate extensions.

Certificate Request Syntax (CRS)
CRS, Internet PKI Certificate Request Syntax, specifies an interface to public-key 
certification products and services based on PKCS #7 and PKCS #10. A small number 
of additional services are defined to supplement the core certificate request service. 
Current industry practice regarding the use of PKCS #7 and PKCS #10 is also 
documented for the benefit of the Internet community. In general, the use of PKCS #7 
in CRS is aligned to the Cryptographic Message Syntax (CMS) (RFC 2630), which 
provides a superset of the PKCS #7 syntax.
The above definition and further information is available at 
www.ietf.org/proceedings/98aug/I-D/draft-ietf-smime-crs-00.txt.

Certificate Revocation List (CRL)
A list of revoked and suspended certificates (CA or end-entity) for a particular CA. 
You can use CRLs to check the status of certificates offline. See also Complete CRL 
and Delta CRL.

Certification Practice Statement (CPS)
A CPS defines an organization’s security policies for the issuance and management of 
certificates.

Client Certificate
See End-Entity Certificate.

Complete CRL
A list that contains the serial numbers of certificates that a CA has revoked or 
suspended.

CRL
See Certificate Revocation List.
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CRL Server
A virtual web server host that is a component of the RSA Certificate Manager Web 
Server. The CRL Server is used by Certificate Manager as a publishing site for CRLs 
and ARLs for HTTP-based CRL and ARL retrieval respectively. It is not 
SSL-enabled.

Cross-Certificate
A certificate issued by one CA to another CA that allows users to determine the 
trustworthiness of certificates issued by the other CA. 

Cryptographic Provider
The library the RSA Digital Certificate Solution product uses for private-key 
cryptographic operations (such as key pair generation and digital signatures). The 
method is either software-based or hardware-based.

Data Encryption Standard (DES)
A National Institute of Standards & Technology (NIST) standard for secret key 
cryptography that uses a 56-bit key. DES is based on an IBM algorithm that was 
further developed by the U.S. National Security Agency. It is a block cipher, which 
breaks text into 64-bit blocks before encrypting it. There are several DES encryption 
modes.
DES encryption and decryption are very fast and widely used. The secret key may be 
used repeatedly, or it can be randomly generated for each session, in which case the 
new key is transmitted to the recipient using a public key cryptography method such 
as RSA. For more information, see the standard at 
http://csrc.nist.gov/publications/fips/fips46-3/fips46-3.pdf.

Digital Signature Algorithm (DSA)
The algorithm used in the Digital Signature Standard (DSS) created by the U.S. 
government. For more information, see the standard designation FIPS 
186-2+ChangeNotice at 
http://csrc.nist.gov/publications/fips/fips186-2/fips186-2-change1.pdf.

Directory
LDAP-based directories are databases that can be used to search for and retrieve 
attribute-value pairs. Directories can be configured to use (or support) authentication 
and access control protection. The schema of a directory describes the objects in the 
directory. The Secure Directory schema defines objects that support PKI.

Distinguished Encoding Rules (DER)
An ASN.1 encoding standard used for signature calculation for end-entity certificates 
and revocation lists (that is, CRLs, delta CRLs and ARLs). Also known as Binary.

Distinguished Name (DN)
The combination of attributes in a certificate forms the certificate DN. The following 
attributes are the most commonly used attributes:
• Common Name
• User ID
• E-mail Address 
• Organizational Unit
• Organization
• Locality
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• State or Province
• Country
• Domain Component
To avoid potential problems, all CAs in the PKI, including trusted CAs, should have a 
unique DN.

Elliptic Curve Cryptography (ECC)
A form of public key cryptography based on elliptic curve mathematics. ECC keys 
can be smaller than other keys while still providing the same degree of protection. 
Because of their smaller size, ECC computations tend to take less time and resources. 
These factors make ECC an attractive choice for systems such as embedded devices or 
smart cards, where resources such as RAM and CPU power can be severely 
constrained.

Elliptic Curve Digital Signature Algorithm (ECDSA)
The Digital Signature Algorithm (DSA) standard implemented using elliptic curve 
cryptography (ECC).

Elliptic Curves A and B
Elliptic curves A and B are the types of ECC curves that are supported in 
RSA Certificate Manager. For further information, see the IEEE standard P1363, 
“Standard Specifications for Public Key Cryptography.”

End-Entity Certificate
A certificate issued to an entity that cannot itself issue certificates (that is, the entity is 
not a CA). Because the entity that requests such a certificate is sometimes referred to 
as the client, end-entity certificates are sometimes called client certificates.

End User (or End-Entity)
An individual, group, or organization that either requests or holds an end-entity 
certificate. An end user can also be an individual who requests an end-entity 
certificate for a hardware device (such as a router), a server, a software application, or 
a piece of code. An end user that requests a certificate is sometimes called a requestor. 
An end user that is issued a certificate is sometimes called a certificate owner, 
certificate subject, or end-entity. An end user that relies upon someone else’s 
certificate to verify that person’s identity is sometimes called an end user, certificate 
user, or relying party.

Enrollment Server
A virtual web server host that is a component of the RSA Certificate Manager or 
Registration Manager Web Server. The Enrollment Server offers a 
server-authenticated site where public users (clients) can make certificate requests, 
retrieve issued certificates, and download CA certificates. The Enrollment Server has 
limited access to the Secure Directory Server.

Enterprise
An organization that uses computers and applications. In general use, this term is 
applied to businesses or organizations that operate on a large scale. Applications that 
are designed for these organizations are often referred to as enterprise applications.

Entity
A person, organization, or device (such as a router). In a PKI, an entity may be thought 
of as anything you can issue a certificate to.
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Extended Validation Certificate
A certificate issued to a web site so that its users can confirm the identity of the entity 
that controls the web site. EV certificates must meet the requirements in Guidelines 
for Extended Validation Certificates, established by the CA/Browser Forum. For more 
information, go to the CA/Browser Forum web site at 
http://www.cabforum.org/documents.html.

Extension
See X.509 v3 Certificate Extension.

FASC-N
FASC-N is the Federal Agency Smart Credential Number, which uniquely identifies 
each Personal Identity Verification (PIV) card. It is part of the Cardholder Unique 
Identification file (CHUID) and is the primary identification string used on all 
government issued credentials. For more information, see the standard at 
http://csrc.nist.gov/publications/fips/fips201-1/FIPS-201-1-chng1.pdf.

FIPS 140-1 Level 2 & 3
FIPS 140-2 Level 2 & 3

A standard developed by the National Institute of Standards and Technology (NIST) 
for implementation of cryptographic modules. Level 3 provides greater security than 
Level 2.

Firewall
A system designed to prevent unauthorized access to or from a private network.

Fully Qualified Domain Name (FQDN)
The full name of a system, consisting of its local hostname and its domain name. For 
example, “venera” is a hostname and “venera.isi.edu” is the FQDN. 

GOST
GOST (Gosudarstvenii Standart) refers to the Russian Government Standard for 
cryptographic protection for Data Protection Systems. Software products exported to 
Russia require the use of the GOST algorithm in order to be offered for sale. 
The GOST algorithm is supplied through the use of the Crypto-Pro Cryptographic 
Service Provider (CSP) v1.2.

Hardware Security Module (HSM)
The module that performs cryptographic functions and stores cryptographic keys in a 
secure fashion.

Hypertext Transfer Protocol (HTTP)
A set of rules for exchanging files (text, graphic images, sound, video, and other 
multimedia files) on the World Wide Web. 
Web browsers are HTTP clients that send requests to server machines. Users enter 
page requests by either typing a URL or clicking a hypertext link. The browser builds 
an HTTP request for the user and sends it to the Internet Protocol (IP) address 
indicated in the URL. The HTTP daemon in the destination server receives the request 
and, after any necessary processing, returns the requested page. See also HTTPS.

HTTPS
HTTP over an SSL/TLS connection.
140 Glossary

http://www.cabforum.org/documents.html
http://csrc.nist.gov/publications/fips/fips201-1/FIPS-201-1-chng1.pdf


RSA Certificate Manager 6.9 Installation Guide
Identity Certificate
A certificate that links a public key value to a real-world entity such as a person, a 
computer, or a web server. Server certificates, CA certificates, and most end-entity 
certificates are all examples of identity certificates.

Issuing
The act of signing a certificate request with the private key of a CA to create a 
certificate.

Jurisdiction
A Jurisdiction is a set of configurations that define the form and content of the 
certificates issued under it, the life cycle management of those certificates, and the 
look and feel users will find when enrolling.

Key Pair
A public key and a private key associated with an entity that needs to authenticate its 
identity electronically or to sign or encrypt data. The public key is published, and the 
corresponding private key is kept secret. You can only decrypt data encrypted with the 
public key with the private key.

Key Recovery
The process of recovering a private decryption key from a secure archive for the 
purposes of recovering data that has been encrypted with the corresponding 
encryption key.

Key Recovery Operator (KRO)
An entity involved in the recovery of private keys through the use of tokens or smart 
cards. A configurable minimum number of KROs are required to access the hardware 
security module (HSM) individually within a specific time period.

Key Size
The size (in bits) of the key pair. A larger key size provides greater security. 
RSA Certificate Manager and RSA Registration Manager supports 1024, 2048, and 
4096 bit keys.

LDAP Directory
An LDAP-based directory is a database. You can search for and retrieve 
attribute-value pairs. You can configure directories to use (or support) authentication 
and access control protection. The schema of a directory describes the objects in the 
directory.

LDAPS
LDAP over SSL/TLS Connection.

Lightweight Directory Access Protocol (LDAP)
The standard Internet protocol for accessing directory servers over a network. LDAP 
is a “lightweight” (smaller amount of overhead) version of Directory Access Protocol 
(DAP), which is part of X.500, a standard for directory services in a network. There 
are two currently supported versions, LDAP versions 2.0 and 3.0. See also LDAPS.

Load Balancer
A software or hardware product that routes incoming data to one of a number of 
possible resources or applications.
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Logging Server
The Logging Server records PKI events for one or more client applications such as the 
Secure Directory Server. Event data is stored in a signed log file that can be verified 
and exported in XML or comma-separated value format.

Message Digest 5 (MD5)
An algorithm for creating a cryptographic hash (or “fingerprint”) of a message or data. 
MD5 can also refer to the value resulting from the application of the MD5 algorithm. 
A certificate MD5 value is unique to that certificate, and is often used to identify a 
certificate when setting LDAP and web server ACL rules.

MofN
A process of key encryption where a private key is split into N shares to be stored on a 
hardware device such as a token. M can be any value between 1 and to N. M shares 
are required to reconstitute the private key.

Nickname
A user-friendly character string that uniquely identifies a CA or CRL signer.

Non-repudiation
A concept that prevents the author of a message from denying having created that 
message at a later date (that is, repudiation cannot occur). Digital signatures help 
ensure the non-repudiation of transactions.

OCSP
See Online Certificate Status Protocol.

OCSP Client
The entity that issues a certificate status request to an OCSP responder. The OCSP 
client suspends acceptance of the certificate until the responder returns the certificate 
status.

OCSP Request
A client issues an OCSP request to obtain the status of a certificate. The client 
suspends acceptance of the certificate until it receives an OCSP response.

OCSP Responder
The OCSP Responder accepts certificate status requests from OCSP-enabled clients, 
looks up a certificate status in a CA database, and responds with the current certificate 
status.

OCSP Response
Once an OCSP response is received by the client who issued the OCSP request, the 
certificate is accepted by the client.

Online Certificate Status Protocol (OCSP)
A protocol, defined in RFC 2560, that enables applications to check the status of a 
certificate every time the certificate is used. If you configure your PKI to use OCSP, 
CRLs are unnecessary for end users.

Online Validation
Online validation occurs when a CA can be queried directly about the validity of a 
certificate every time the certificate is used. 
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Operator Card Set (OCS)
A card set within the nCipher security world that is used to generate, protect, and 
access the private keys created within it.

Persistent
If an OCS is made persistent, the keys protected by a member card remain in the HSM 
after the card has been removed from the card reader. By default, an OCS is 
non-persistent. An OCS can be made persistent or non-persistent at creation only.

PIV NACI
PIV NACI is Personal Identity Verification National Agency Check with Written 
Inquiries. Identity credentials issued to individuals without a completed NACI can be 
electronically distinguishable from identity credentials issued to individuals who have 
a completed investigation, based on the PIV NACI indicator extension.

PKCS #7
The Cryptographic Message Syntax Standard. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/pkcs-7/.

PKCS #9
The Selected Attribute Types Standard. For more information on the standard, go to 
www.rsa.com/rsalabs/pkcs/pkcs-9/.

PKCS #10
The Certification Request Syntax Standard. For more information on the standard, go 
to www.rsa.com/rsalabs/pkcs/pkcs-10/.

PKCS #11
The Cryptographic Token Interface Standard. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/pkcs-11/.

PKCS #12
The Personal Information Exchange Syntax Standard. For more information on the 
standard, go to www.rsa.com/rsalabs/pkcs/pkcs-12/.

PKIX
The evolving Internet Engineering Task Force (IETF) standard for PKI using X.509 
certificates. For more information on the standard, go to 
www.ietf.org/html.charters/pkix-charter.html/.

Privacy Enhanced Mail (PEM) format
PEM was originally created to provide secure e-mail services on the Internet, but it 
became too unwieldy for widespread use. Now, “PEM format” usually refers to the 
Base64 encoding algorithm that was part of the PEM proposal.
PEM encoding is useful for presenting binary data in a text-readable form. (For 
example, to allow you to copy and paste data between applications.) Also known as 
Base64.

Private Key
The private part of a public-key key pair. With RSA Certificate Manager and 
RSA Registration Manager, private keys are generated on the client whenever a 
certificate request is madePrivate keys must be securely stored to prevent 
unauthorized access and accidental deletion.
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A digital signature involves encrypting a message digest with a private key and allows 
anyone with the corresponding public key to decrypt the message digest to be certain 
of who sent the message and that it has not been tampered with.
You can decrypt information encrypted with a public key with the corresponding 
private key.

Public Key
The public and widely distributed part of a public-key key pair. For example, a 
certificate contains information about the certificate subject, the certificate signer, and 
a public key value. In general, you can only decrypt information encrypted with a 
public key with the corresponding private key.

Public-Key Cryptography Standards (PKCS)
A set of standard protocols developed by RSA for making secure information 
exchange possible. The standards include RSA encryption, password-based 
encryption, and cryptographic message syntax. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/.

Public Key Infrastructure (PKI)
A system for publishing, distributing, and managing the public key values used in 
public key cryptography. All PKIs involve issuing public key certificates to 
individuals, organizations, and other entities and verifying that these certificates are 
valid.

Qualified Certificate
An end-entity certificate whose primary purpose is to identify a person with a high 
level of assurance in public non-repudiation services. For more information on the 
standard, go to www.ietf.org/rfc/rfc3739.txt?number=3739.
For more information on the European Telecommunications Standards Institute 
(ETSI) Technical Specification (TS) for the use of Qualified Certificates, No. 101 862 
v1.2.1, go to www.etsi.org/.

Registration Authority (RA)
An entity that performs registration services on behalf of a CA. RAs work with a 
particular CA to vet requests for certificates that will then be issued by the CA.

Revocation
Revoking a certificate invalidates it and removes all of its privileges in the PKI. 
Revocation is necessary if the CA administrator wants to invalidate the certificate 
before it expires. Administrators revoke certificates by marking them as invalid in the 
Secure Directory. Users of the PKI are notified of the revoked status a certificate 
during online validation or with revocation lists.
Revoking a CA invalidates the CA certificate and removes all the PKI privileges of 
the CA. Revoke a CA only if you have organizational-based security concerns and 
only as a last resort.

Revocation List Signer
An entity that signs complete CRLs, delta CRLs, and ARLs for a specific CA. An 
Administrator can designate a particular entity or the CA itself. 

Rivest-Shamir-Adleman (RSA)
A highly secure cryptography method created by the three founders of RSA: 
Professors Ronald L. Rivest, Adi Shamir, and Leonard M. Adleman.
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RSA uses a two-part key. The private key is kept by the owner; the public key is 
published. Data that is encrypted using the recipient’s public key can only be 
decrypted by the recipient’s private key, and vice-versa.
The RSA algorithm is computation intensive. Therefore, it is often used to create a 
digital envelope, which holds an RSA-encrypted symmetric key (often DES) and 
symmetric key-encrypted data. This method encrypts the secret symmetric key so that 
it can be transmitted over the network, but encrypts and decrypts the actual message 
using the much faster symmetric key algorithm.
The RSA algorithm is also used for authentication using digital signatures. In this 
case, the sender’s private key is used for signing, and the sender’s public key is used 
for verification. The RSA algorithm is also implemented in hardware. As RSA chips 
get faster, RSA encoding and decoding will add less overhead to the operation.

Root Bind
Clients normally identify themselves when binding (connecting) to an LDAP server 
(anonymous connections are also possible). Access control rules allow access to be 
granted to the directory information tree on the basis of the client's identity. A client 
may connect with root privileges if it identifies itself as the root user and has the 
necessary credentials to authenticate itself as such.
Clients binding as root are not subject to the normal access control rules and may read 
or write to any part of the directory information tree.
To bind as root, a client must know the name of the root user. In addition, it must have 
the corresponding password, or a specific X.509 client certificate from which the root 
name can be derived. 

root CA
A CA whose certificate is self-signed (that is, the issuer and the subject are the same). 
A root CA is at the top of a hierarchy.

SCEP Server
A virtual web server host that implements the Simple Certificate Enrollment Protocol, 
and provides a means for clients (primarily IPSec hardware and software agents) to 
obtain CA certificates and revocation lists, and to enroll for end-entity certificates. 
The SCEP Server is used by RSA Certificate Manager both as an enrollment 
mechanism and as a repository for end-entity certificates to be retrieved by routers and 
standalone devices with little non-volatile memory. It is not SSL-enabled. Security 
and authentication are enforced through the use of signed and encrypted PKCS #7 
messages. The SCEP Server has limited access to the Secure Directory Server.

Schema
A schema describes an object and its attributes in LDAP directories such as the 
RSA Certificate Manager or RSA Registration Manager Secure Directory.

Secure Directory Server
A secure LDAP directory that stores all of the information for your PKI. The Secure 
Directory publishes certificates and is used as a read-only repository for public users.

Secure Hash Algorithm (SHA-1)
An algorithm developed by the U.S. National Institute of Standards & Technology 
(NIST). SHA-1 is used to create a cryptographic hash (or “fingerprint”) of a message 
or data. SHA-1 is considered to be somewhat stronger than MD5. SHA-1 is defined in 
FIPS Publication 180-2, the Secure Hash Standard (SHS).
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Secure Hash Algorithm (SHA-256)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-256 
operates in the same manner as MD5 and SHA-1 and creates a 256-bit cryptographic 
hash of a message or data. SHA-256 is considered to be stronger than SHA-1.

Secure Hash Algorithm (SHA-384)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-384 is a 
variant of SHA-512 and creates a 384-bit cryptographic hash of a message or data. 
SHA-384 is considered to be stronger than SHA-1.

Secure Hash Algorithm (SHA-512)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-512 is a 
variant of SHA-256 and creates a 512-bit cryptographic hash of a message or data. 
SHA-512 is considered to be much stronger than SHA-1.

Secure Sockets Layer (SSL)
A protocol layer created by Netscape to manage the security of message transmissions 
in a network. Security is achieved through encryption. “Sockets” refers to the sockets 
method of passing data back and forth between client and server programs in a 
network or between program layers in the same computer.

Secured Electronic Information in Society (SEIS)
The name of a non-profit organization in Sweden, working on implementing a 
common and open infrastructure to make communications in an open network, such as 
the Internet, secure. SEIS, founded in 1995, has developed a concept and the strategy 
to implement IT security for commercial use on a worldwide scale.

Security World
A security world consists of at least one hardware module, a set of smart cards, and 
encrypted data stored on a computer.

Server Certificate
An end-entity certificate issued to a server. Servers present their certificates to web 
browsers so browsers can verify (authenticate) the identity of the server. Server 
certificates are sometimes called SSL or TLS certificates.

Signing
A process by which a digital signature is affixed to a file, document, or certificate as 
proof that it has not been tampered with and that the author is who claims to be the 
author.

Simple Certificate Enrollment Protocol (SCEP)
A PKI communication protocol that supports the secure issuance of certificates to 
routers and other standalone devices in a scalable manner by using PKCS #7 and 
PKCS #10. 

S/MIME
Microsoft and Netscape include S/MIME in the latest versions of their e-mail clients. 
Other vendors of message products also endorse S/MIME.
MIME itself, described in the IETF standard RFC 1521, defines the structure of an 
electronic message. S/MIME allows the message body to include encryption 
information and a digital certificate. S/MIME has extended the syntax provided in 
PKCS #7. For more information on the standard, go to 
www.ietf.org/html.charters/smime-charter.html.
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SSL Client Authentication
The process whereby a server authenticates a client by verifying the end-entity 
certificate presented by the client during SSL operations.

SSL-LDAP
See LDAPS.

SSL Server Authentication
The process whereby a client application authenticates a server by verifying the 
certificate chain presented by the server during SSL operations, starting with a CA 
trusted by the client.

Status
The validity of a certificate: active, reinstated, revoked, or suspended.

Suspension
The process of marking a certificate as temporarily invalid. The end user presenting 
the suspended certificate is denied access where the certificate previously allowed 
access. Reinstating a certificate returns all removed PKI privileges.
Suspending a CA certificate marks it as temporarily invalid and removes all PKI 
privileges of the CA. Reinstating a CA certificate returns all removed PKI privileges.

System CA
The CA created during installation of RSA Certificate Manager to issue the server 
certificates for the System Web Servers and the certificates for accessing back-end 
functionality, either through the Web Servers, the Logging Server, or RSA Certificate 
Manager API applications. The System CA also signs the Administrative CA 
certificate. The System CA should not be used after installation except to re-sign the 
certificates it issued during installation.

System Log
An operating system-specific file that RSA Certificate Manager or RSA Registration 
Manager uses to record systemic events not related to regular operations or 
configuration changes.

Trace Log
A file containing information suitable for debugging purposes.

Transport Layer Security (TLS)
Internet protocol that provides privacy between server and client. TLS ensures that no 
third party may eavesdrop or tamper with any message. TLS is the successor to SSL; 
however, they are not interoperable.

UTF-8 Encoding
An ASCII compatible multibyte Unicode and UCS encoding, used by current 
browsers, Java and Plan 9.

Validation
The process of verifying that a certificate is valid. Validation can occur online or 
through the use of revocation lists.

Vetting
The process of reviewing a certificate request, verifying the information provided in it, 
and determining if a certificate should be issued. RAs may be used to vet certificates 
for CAs in large PKIs.
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Vettor
A person with an end-entity certificate who has vetting access to one or more 
Jurisdictions of one or more CAs through the Certificate Operations Workbench. 
Vettors are the trusted individuals within an organization that review requests for 
end-entity certificates. Vettors determine whether the RSA Certificate Manager or 
RSA Registration Manager should issue a certificate. Vettors also manage the status of 
certificates after they are issued.
The Certificate Manager Vettor certificate is signed by the Administrative CA; the 
Registration Manager Vettor certificate is signed by the CA of the Registration 
Manager initial target Jurisdiction.

Web of Trust
In an unstructured PKI, if enough CAs issue certificates that bind a particular name to 
a particular key, then another CA can accept that binding based on the trust that exists 
between the other CAs.

Web Server
An Apache-based server that is the primary interface to RSA Certificate Manager and 
RSA Registration Manager.

X.509
An International Standards Organization (ISO) standard that describes a basic 
electronic format for digital certificates.

X.509 v3 Certificate Extension
Certificate extensions, including extensions for PKIX, SET, and SSL. The 
RSAValidation Solution supports X.509 v3 that conform to version 3 of the X.509 
standard and specify additional constraints or capabilities on the certificate subject.

X-Parse
A template-based HTML extension language. It is used to compose web-based 
PKI-enabled applications.

XUDA Template
A XUDA template is a scripted HTML file. Each template combines regular HTML 
with scripting tags from the RSA X-Parse server-side scripting language, in much the 
same way that Java Server Pages combine regular HTML with JSP scripting tags. The 
X-Parse tags embedded in the HTML are parsed by the RSA Certificate Manager and 
RSA Registration Manager Web Servers, and the fully formed HTML result is 
returned to the browser.

Xudad
See Secure Directory Server.
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Acronyms

ACL access control list

AES Advanced Encryption Standard

API application programming interface

ARL authority revocation list

ASN.1 Abstract Syntax Notation One

CA certificate authority

CGI common gateway interface

CMP certificate management protocol

CP certificate policy

CPS certification practice statement

CRL certificate revocation list

CRMF certificate request message format

CRS certificate request syntax

CSR certificate signing request

DER Distinguished Encoding Rules

DES Data Encryption Standard

DH Diffie-Hellman

DIB directory information base

DSA Digital Signature Algorithm

ECC elliptic curve cryptography

ECDSA Elliptic Curve Digital Signature Algorithm

ETSI European Telecommunications Standards Institute

EV Extended Validation

FQDN fully qualified domain name

GAL Global Address List

GLB greatest lower bound
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GOST Gosudarstvenii Standart (Russian Equivalent of ANSI)

GUI graphical user interface

HSM hardware security module

HTML Hypertext Markup Language

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol (over an SSL connection)

IDS interoperability datasheet

I18N Internationalization

IEEE Institute of Electrical and Electronics Engineers

IETF Internet Engineering Task Force

IME Input Method Editors

IPSec IP Security Protocol

ISO International Standards Organization

ITU/CCITT International Telecommunication Union

KRO Key Recovery Operator

LDAP Lightweight Directory Access Protocol

MD5 Message Digest 5

MSIE Microsoft Internet Explorer

NES Netscape Enterprise Server

OCS Operator Card Set

PCI Peripheral Component Interconnect

PEM Privacy Enhanced Mail format

PIN personal identification number

PKCS Public-Key Cryptography Standards

PKI public key infrastructure

PKIX Public Key Infrastructure (X.509)

POP proof of possession

RA registration authority

RAM random access memory
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RSA Rivest-Shamir-Adleman

RSA-PSS RSA - Probabilistic Signature Scheme

S/MIME Secure Multi-Purpose Internet Mail Extensions

SCEP Simple Certificate Enrollment Protocol

SDK software development kit

SEIS Secured Electronic Information in Society

SHA-1

SHA-256

SHA-384

SHA-512

Secure Hash Algorithms

SPKAC Signed Public Key and Challenge

SSL Secure Sockets Layer

SSL-LDAP Lightweight Directory Access Protocol over a Secure Sockets 
Layer connection

UCS Universal Character Set (the superset of all other character sets)

URI Uniform Resource Identifier

URL Uniform Resource Locator

UTF-8 Universal Transformation Format

VPN virtual private network

XML Extensible Markup Language
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Index

A
Administration Server

definition, 64
issued certificates, 66

Administrative CA
certificate, 65
signing certificates, 65

B
browser settings

Microsoft Internet Explorer, 14
Mozilla, 14
Mozilla Firefox, 14

browser support, administration, 13

C
caoperations back end

configuration, 73
certificate authorities (CAs)

installed during installation, 65
Certificate Manager

configuration files, 71–72
failover startup procedure, 43–44
failover, pre-installation 

modifications, 43
failover, primary instance, 44
failover, secondary instance, 44
installing, 19–39
starting, 39–41
uninstalling, 105–107
upgrading, 45–58

Certificate Renewal Server, definition, 65
certificate request syntax. See CRS
certificates issued during installation, 66–67
checklist

post-installation, 38
pre-installation, 19

Chrysalis-ITS, 100
CM Administrative certificate, 66
CMP Enroll Server, definition, 65

CMP Server
configuring, 77
definition, 65
issued certificate, 67

configuration
of CMP Server, 77
CMP Server settings, 71
directory structure, 68
Logging Server settings, 72
mail server settings, 71
of Secure Directory Server, 72–76
Secure Directory Server settings, 71
unattended startup settings, 72
of Web Server, 72
Web Server settings, 71
See also installation

CRL Server, definition, 65
CRS

certificate requests, 64
signing certificate, 67

cryptographic support, 16

D
directive

crypto_providers, 88, 97, 103
setpin, 98

distribution media, verification, 109

E
Enrollment Server

definition, 64
issued certificates, 66

F
failover, 42
file directory structure, 68

H
hardware security module. See HSM
high availability, 113
HSM support, 17
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I
installation

browser-based phase, 27–37
for high availability, 113–127
issued certificates, 66–67
license file, 37
on Linux, 26
on Solaris, 26
on Windows, 24
post-installation checklist, 38
post-installation tasks, 39
pre-installation checklist, 19

international characters, entering and 
displaying, 15

interoperability
nCipher smart cards, 83–91
SafeNet Luna tokens, 92–103

L
license file, 37
logging

configuration settings, 72
Logging Server

definition, 65
issued certificates, 66

Luna tokens, 92–103

M
mail server

return address of Administrator, 71
settings, 71

media verification utility, 109

N
nCipher smart cards, 83–91

P
post-installation

checklist, 38
tasks, 39

pre-installation checklist, 19

S
SafeNet Luna tokens. See Luna tokens
SCEP Server

definition, 64
issued certificates, 67

Secure Directory Server
back end configuration, 72–73
configuring, 72–76
definition, 65
security configuration, 74–76
See also caoperations back end

server configuration, 64–65
server keys, converting from software to 

hardware, 59–61
signing engine. See caoperations back end
Simple Certificate Enrollment Protocol. See 

SCEP Server
smart cards

smart card support, 17
See also nCipher smart cards

System CA
certificate, 65
signing certificates, 65–67
validity period, 21

system requirements, 11–??
browser, 13
Linux, 12
Solaris, 12
Windows, 11

T
tokens

token support, 17
See also Luna tokens
See also nCipher smart cards

U
uninstalling

on Linux, 107
on Solaris, 107
on Windows, 105

upgrading
creating Linux upgrade package, 48–49
creating Solaris upgrade package, 48–

49
creating Windows upgrade 

package, 46–48
high availability installation, 127–132
on Linux, 53–55
on Solaris, 53–55
on Windows, 49–53
preparation, 45
troubleshooting, 57–58
upgrading customizations, 56–57
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V
verifying distribution media, 109

validating certificate and utility, 110–
112

validating media, 109
virtual web servers, 64

W
Web Server

virtual servers, 64
Windows

Input Method Editors, 15
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